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Preface

The Oracle Business Intelligence Foundation Suite is a complete, open, and integrated
solution for all enterprise business intelligence needs, including reporting, ad hoc
queries, OLAP, dashboards, scorecards, and what-if analysis. The Oracle Business
Intelligence Foundation Suite includes Oracle Business Intelligence Enterprise Edition.

Oracle Business Intelligence Enterprise Edition (Oracle BI EE) is a comprehensive set
of enterprise business intelligence tools and infrastructure, including a scalable and
efficient query and analysis server, an ad-hoc query and analysis tool, interactive
dashboards, proactive intelligence and alerts, and an enterprise reporting engine.

The components of Oracle BI EE share a common service-oriented architecture, data
access services, analytic and calculation infrastructure, metadata management
services, semantic business model, security model and user preferences, and
administration tools. Oracle BI EE provides scalability and performance with
data-source specific optimized request generation, optimized data access, advanced
calculation, intelligent caching services, and clustering.

This guide contains information about building an Oracle Business Intelligence
metadata repository and includes topics on setting up and connecting to data sources,
building the Physical layer, Business Model and Mapping layer, and Presentation
layer, how to use the multiuser development environment, and a Logical SQL
reference.

This document is intended for anyone who intends to design and build a metadata
repository using the Oracle Business Intelligence Administration Tool, such as a
Business Intelligence strategist, metadata provider, or ETL developer.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
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http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
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information, visit
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Related Documentation and Other Resources

See the Oracle Business Intelligence documentation library for a list of related Oracle
Business Intelligence documents.

In addition, go to the Oracle Learning Library for Oracle Business Intelligence-related
online training resources.

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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New Features for Oracle Bl Metadata
Repository Builders

This preface describes changes to metadata repository features for Oracle Business
Intelligence Enterprise Edition 11¢ Release 1 (11.1.1).

If you are upgrading to Oracle BI EE from a previous release, read the following
information carefully, because there might be significant differences in features, tools,
and procedures. For more information about upgrading to Oracle BI EE 11g, see Oracle
Fusion Middleware Upgrade Guide for Oracle Business Intelligence.

This preface contains the following topics:

= New Features for Oracle BI EE 11g Release 1 (11.1.1.6)
= New Features for Oracle BI EE 11g Release 1 (11.1.1.5)
= New Features for Oracle BI EE 11g Release 1 (11.1.1.3)

New Features for Oracle Bl EE 11g Release 1 (11.1.1.6)

This section describes new features for Oracle BI EE 11¢ Release 1 (11.1.1.6). It contains
the following topics:

s New Features for 11.1.1.6.31
s New Features for 11.1.1.6.3
s New Features for 11.1.1.6.2
s New Features for 11.1.1.6.0

New Features for 11.1.1.6.31

A new biserverextender utility option enables you to resynchronize the Oracle BI
Repository by reimporting all DFF and KFF objects from the ADF source. See
"Automatically Mapping Flex Object Changes Using the biserverextender Utility" for
more information.

New Features for 11.1.1.6.3
New metadata repository features in Oracle BI EE 11¢ Release 1 (11.1.1.6.3) include:

= Ability to Map Flex Object Changes Using the biserverextender Utility
Ability to Map Flex Object Changes Using the biserverextender Utility

You can now use the biserverextender utility to import flex object changes from ADF
data sources and map them to the Business Model and Mapping layer and
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Presentation layer. See "Automatically Mapping Flex Object Changes Using the
biserverextender Utility" for more information.

New Features for 11.1.1.6.2
New metadata repository features in Oracle BI EE 11g Release 1 (11.1.1.6.2) include:

»  Improved Method to Achieve Nested Folders

= Ability to Control Presentation Layer Object Visibility

= Ability to Check for Modeling Problems that Affect Aggregate Persistence
= Improvements to the Aggregate Creation and Deletion Process

= Using XML Files to Automate Physical to Logical Mapping for ADF Data Sources

Improved Method to Achieve Nested Folders

You can now designate child presentation tables using the Child Presentation Tables
tab in the Presentation Table dialog to give the appearance of nested folders in
Answers and BI Composer. See "Nesting Folders in Answers and BI Composer" for
more information.

Ability to Control Presentation Layer Object Visibility

You can now specify an expression in the Hide object if field for individual subject
areas, presentation tables, presentation columns, and presentation hierarchies to hide
these objects in Answers and BI Composer. See "Controlling Presentation Object
Visibility" for more information.

Ability to Check for Modeling Problems that Affect Aggregate Persistence

You can now use Model Check Manager to check your repository metadata for issues
that might affect the success of Oracle Bl Summary Advisor and the aggregate
persistence engine, such as identifying level primary keys that are not unique. See
"Using Model Check Manager to Check for Modeling Problems" for more information.

Improvements to the Aggregate Creation and Deletion Process
This release provides the following improvements to aggregate persistence:

= When a series of aggregates are being created, and the creation of one aggregate
fails, the aggregate persistence engine now skips creation of the failed aggregate
(and its dependencies), and proceeds to the next aggregate in the list instead of
rolling back all changes.

= You can now use the Delete aggregates statement to delete orphan dimension
tables (that is, dimension tables that are not joined to any other fact table).

See Chapter 13, "Creating and Persisting Aggregates for Oracle BI Server Queries" for
more information.

Using XML Files to Automate Physical to Logical Mapping for ADF Data Sources

For ADF data sources, you can create a set of XML files that specify custom mapping
requirements for the mappings displayed in the Map to Logical Model screen of the
Import Metadata Wizard. See "Customizing the Mapping Behavior" for more
information.

New Features for 11.1.1.6.0
New metadata repository features in Oracle BI EE 11g Release 1 (11.1.1.6.0) include:



= Ability to Limit and Offset Rows Returned
s Identify Query Candidates with Oracle BI Summary Advisor

= Integrate the Administration Tool with a Third-Party Source Control Management
System

s Streamlined MUD Merge Process

= Automated Repository Patching Process

= Support for Aggregate Persistence in a Cluster

s FIRST_PERIOD and LAST_PERIOD Time Series Functions
= Ability to Print the Physical and Business Model Diagrams

Ability to Limit and Offset Rows Returned

You can use the FETCH and OFFSET clauses to constrain the number of rows returned by
the SELECT statement and to offset the returned rows by a given number. Both clauses
are optional and can be used together, or independently. See "Limiting and Offsetting
Rows Returned" for more information.

Identify Query Candidates with Oracle Bl Summary Advisor

If you are running Oracle Business Intelligence on the Oracle Exalytics Machine, you
can use the Oracle BI Summary Advisor feature to identify which aggregates will
increase query performance. Summary Advisor intelligently recommends an optimal
list of aggregate tables based on query patterns that will achieve maximum query
performance gain while meeting specific resource constraints. See "Using Oracle BI
Summary Advisor to Identify Query Candidates for Aggregation" for more
information.

Integrate the Administration Tool with a Third-Party Source Control Management
System

As an alternative to using a MUD environment, you can choose to save your
repository in MDS XML format and integrate the Administration Tool with a
third-party source control management system. See Chapter 4, "Using a Source
Control Management System for Repository Development” for more information.

Streamlined MUD Merge Process

Repository developers using a multiuser development (MUD) environment can now
merge and publish changes in a single step, rather than merging local changes and
then publishing changes as two separate steps. They can also perform subset refreshes
to perform incremental local merges with the master repository. See "Publishing
Changes to Multiuser Development Repository Projects" for more information.

Automated Repository Patching Process

You can now use an option in the patchrpd command-line utility to enable automated
patching without prompting for user input. In addition, new patching-specific rules
are applied during patch merges. See "Merge Rules and Behavior for Patch Merges" for
more information.

Support for Aggregate Persistence in a Cluster

You can now use the aggregate persistence feature in a clustered environment. See
"Running the Aggregate Specification Against the Oracle BI Server" for more
information.
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FIRST_PERIOD and LAST_PERIOD Time Series Functions

You can now use the FIRST_PERIOD and LAST_PERIOD functions to compute the first
and last value of an expression using the chronological key rather than the primary
level key. See "FIRST_PERIOD" and "LAST_PERIOD" for more information.

Ability to Print the Physical and Business Model Diagrams

You can now use Print Preview and Print to view and print the Physical and Business
Model Diagrams in the Administration Tool. See "Using the Physical and Business
Model Diagrams" for more information.

New Features for Oracle Bl EE 11g Release 1 (11.1.1.5)

XXViii

New metadata repository features in Oracle BI EE 11¢ Release 1 (11.1.1.5) include:
= Ability to Propagate Flex Object Changes to the RPD and Data Warehouse

= Access to Oracle OLAP Data Sources

= Access to TimesTen Data Sources

= Ability to Connect to SAP/BW Data Sources Using a Native Connection

s New Diagramming Capability

=  Validation Utility to Validate Metadata Objects in a Repository

Ability to Propagate Flex Object Changes to the RPD and Data Warehouse

You can use the Import Metadata Wizard in the Administration Tool to propagate
changes made to flexfields in your applications from the source OLTP system into the
Physical and Business Model and Mapping layers of the repository.

You can also use the Import Metadata Wizard to invoke the BI Extender feature to
propagate flex object changes to your Informatica server mappings, DAC, and the
Physical and Business Model and Mapping layer data warehouse metadata objects.
See "Importing Metadata from ADF Data Sources" and "Using the Bl Extender to
Propagate Flex Object Changes" for more information.

Access to Oracle OLAP Data Sources

Oracle BI EE now supports Oracle OLAP as a data source. See "Working with Oracle
OLAP Data Sources" for more information.

Access to TimesTen Data Sources

Oracle BI EE now supports Oracle TimesTen In-Memory Database as a data source.
See "Setting Up Oracle TimesTen In-Memory Database Data Sources" for more
information.

Ability to Connect to SAP/BW Data Sources Using a Native Connection

You can now use the SAP BW Native connection option to connect to SAP/BW data
sources over BAPIL. See "Setting Up SAP/BW Data Sources" for more information.

New Diagramming Capability

The Physical and Business Model Diagrams have enhanced capabilities in this release,
including an improved look-and-feel, the ability to display columns in table objects in
the diagram, and new diagram options like auto-layout, marquee zoom, and zoom to

fit. See "Using the Physical and Business Model Diagrams" for more information.



Validation Utility to Validate Metadata Objects in a Repository

Oracle BI EE now includes a validation utility to validate metadata objects. See "Using
the validaterpd Utility to Check Repository Consistency” for more information.

New Features for Oracle Bl EE 11g Release 1 (11.1.1.3)

New metadata repository features in Oracle BI EE 11¢ Release 1 (11.1.1.3) include:

New SampleApp.rpd Demonstration Repository

Hierarchy Objects in the Presentation Layer

Support for Unbalanced (Ragged) and Skip-Level Hierarchies

Support for Parent-Child Hierarchies

Creating Subject Areas for Logical Stars and Snowflakes
Multicurrency Support

Generating and Applying XML Patch Files

Enhancements for Multiuser Development and Repository Lifecycle Management
Metadata Repository File Encryption

Metadata Repository File Compression

Embedded Database Functions

SQL Functions for Time Series Calculations and Level-Based Measures
Support for SELECT_PHYSICAL

Support for Calculated Members

Access to Essbase Data Sources

Access to Hyperion Financial Management Data Sources

Access to ADF Business Component Data Sources

Access to Oracle RPAS Data Store Through ODBC

Ability to Connect to Oracle Database Through OCI

Support for Dragging and Dropping XMLA Objects

Support for Using a Standby Database with Oracle Business Intelligence
Aggregate Persistence Auto-Indexing

Pruning Utility to Delete Unwanted Repository Objects

Ability to Defer Execution of Session Variable Initialization Blocks

Improved Usability in the Administration Tool

New SampleApp.rpd Demonstration Repository

A new demonstration repository called SampleApp.rpd is available for this release of
Oracle BI EE. This repository provides best practice information about modeling many
different types of objects.

A basic version of SampleApp.rpd, called SampleAppLite.rpd, is automatically
installed as the default repository. The full version of SampleApp.rpd, which contains
many additional examples and features, is available on the Oracle Technology
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Network. See "About the SampleApp.rpd Demonstration Repository" for more
information.

Hierarchy Objects in the Presentation Layer

You can now define presentation hierarchies and presentation levels in the
Presentation layer. These objects provide an explicit way to expose the
multidimensional model in Oracle BI Answers and enables users to create
hierarchy-based queries. Presentation hierarchies expose analytic functionality such as
member selection, custom member groups, and asymmetric queries. See "Working
with Presentation Hierarchies and Levels" for more information.

Support for Unbalanced (Ragged) and Skip-Level Hierarchies

Oracle BI EE now supports unbalanced and skip-level hierarchies. An unbalanced (or
ragged) hierarchy is a hierarchy where the leaves (members with no children) do not
necessarily have the same depth. A skip-level hierarchy is a hierarchy where there are
members that do not have a value for a particular ancestor level. See "About
Level-Based Hierarchies" for more information.

Support for Parent-Child Hierarchies

Oracle BI EE now supports parent-child hierarchies. Parent-child hierarchies (also
called value hierarchies) contain members that all have the same type. For example, an
organizational chart has a distinct parent-child hierarchy, but all members are
employees. See "Creating and Managing Dimensions with Parent-Child Hierarchies"
for more information.

Creating Subject Areas for Logical Stars and Snowflakes

You can automatically create one subject area (formerly called presentation catalog)
for each logical star or logical snowflake in your business model. See "Automatically
Creating Subject Areas Based on Logical Stars and Snowflakes" for more information.

Multicurrency Support

You can configure logical columns so that Oracle BI EE users can select the currency in
which they prefer to view currency columns in analyses and dashboards. See
"Configuring Logical Columns for Multicurrency Support” for more information.

Generating and Applying XML Patch Files

You can now generate an XML patch file that contains only the changes made to a
repository. This patch can be then applied to the old (original) version of the
repository to create the new version. This is very useful for
development-to-production scenarios, and can also be used for Oracle BI Applications
customers to upgrade their repository. See "Performing Patch Merges" for more
information.

You can also use the Oracle BI Server XML utilities to create a generic, XML-based
representation of the Oracle BI repository metadata, on any supported Oracle Bl
Server operating system. See "About the Oracle BI Server XML API" in Oracle Fusion
Middleware XML Schema Reference for Oracle Business Intelligence Enterprise Edition for
more information.

Enhancements for Multiuser Development and Repository Lifecycle Management

The following list summarizes improvements and new features for multiuser
development and repository lifecycle management:



s MUD projects now explicitly include subject areas (formerly called presentation
catalogs). Object security permissions no longer affect which presentation objects
are included in a checked-out repository.

= You can select options in the Merge Repository Wizard or set options in the MUD
options file to automatically check consistency and equalize during merges.

= Improved Merge Repository Wizard integration enables a single step input for
repositories. You no longer have to select repositories one by one and wait for
them to load.

= You can now extract objects on all platforms using the command-line utility
extractprojects.

s The two-way merge feature (full merge without a common parent) enables easier
consolidation of separate repositories.

Metadata Repository File Encryption

Repositories now have a repository password that encrypts the repository contents
using a strong encryption algorithm. This feature ensures that repository metadata is
secure, including data source credentials in connection pool objects. See "Changing the
Repository Password" for more information.

Metadata Repository File Compression

To reduce storage needs, repositories are now stored in a compressed format. Because
of this, you may notice that the size of an RPD file opened and saved in this release is
significantly smaller than the size of RPD files from previous releases. See "About the

Multiuser Development Environment" for more information about using and storing

multiple repositories.

Embedded Database Functions

Users and administrators can create requests by directly calling database functions
from either Oracle BI Answers, or by using a Logical column (in the Logical Table
source) within the metadata repository. These functions provide the ability to access
custom written functions or procedures on the underlying database. Supported
functions include EVALUATE, EVALUATE_AGGR, and EVALUATE_PREDICATE. See "Database
Functions" for more information.

In addition, Evaluate functions can be leveraged significantly for Essbase users. See
"Examples Using EVALUATE_AGGREGATE and EVALUATE to Leverage Unique
Essbase Functions" for more information.

SQL Functions for Time Series Calculations and Level-Based Measures

The following new and revised SQL functions enable users to create time series
calculations and level-based measures:

= PERIODROLLING is a new function that computes the aggregate of a measure over
the period starting x units of time and ending y units of time from the current
time.

= AGGREGATE AT is a new function that aggregates columns based on the level or
levels specified.

= AGOis a time series aggregation function that calculates the aggregated value from
the current time back to a specified time period. In this release, the time_Ievel
argument is optional, and there are additional syntax changes. This function was
called PERIODAGO in a previous release.
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= TODATE is a time series aggregation function that aggregates a measure attribute
from the beginning of a specified time period to the currently displayed time. The
syntax for this function has changed in this release. This function was called
PERIODTODATE in a previous release.

See "Aggregate Functions" for more information about these functions. See also
"Modeling Time Series Data" for information about using the time series functions AGO,
TODATE, and PERTODROLLING.

Support for SELECT_PHYSICAL

SELECT_PHYSICAL statements provide the functionality to directly query objects in the
Physical layer of the metadata repository, and to nest such a statement within a query
against the Business Model and Mapping layer or the Presentation layer. See "Syntax

and Usage Notes for SELECT_PHYSICAL" for more information.

Support for Calculated Members

Calculated members are user-defined dimension members whose measure values are
calculated at run time. You can define a calculated member within a dimension
through a formula that references other members of the same dimension. See
"Calculated Members" for more information.

Access to Essbase Data Sources

Oracle BI EE now supports Essbase as a data source. See "Working with Essbase Data
Sources" for more information.

Access to Hyperion Financial Management Data Sources

Oracle BI EE now supports Hyperion Financial Management as a data source. See
"Working with Hyperion Financial Management Data Sources" for more information.

Access to ADF Business Component Data Sources

Oracle BI EE now supports using ADF Business Components as data sources. With
this feature, users can integrate operational reporting with any application that is built
on top of the ADF Framework. See "Working with ADF Data Sources" for more
information.

Access to Oracle RPAS Data Store Through ODBC

The Oracle BI Server can now access Oracle Retail Predictive Application Server
(RPAS) data stores using the RPAS ODBC driver. See "Setting Up Oracle RPAS Data
Sources" for more information.

Ability to Connect to Oracle Database Through OCI

Administrators can now use the native Oracle Call Interface (OCI) when importing
physical objects from an Oracle Database. Because using OCl is faster than using an
ODBC connection, administrators should always use OCI when importing from or
setting up connections to an Oracle Database. See "Setting Up Oracle Database Data
Sources" for more information.

Support for Dragging and Dropping XMLA Objects

You can now drag and drop XMLA objects (whole XMLA database or cube tables, at
the same time or one by one) into the logical layer to automatically create a consistent
business model. See "Creating the Business Model and Mapping Layer" and
"Automatically Creating Business Model Objects for Multidimensional Data Sources"
for more information.



Support for Using a Standby Database with Oracle Business Intelligence

You can now use a standby database with Oracle BI EE. A standby database is used
mainly for its high availability and failover functions as a backup for the primary
database. See "Using a Standby Database with Oracle Business Intelligence" for more
information.

Aggregate Persistence Auto-Indexing

For greater performance, Oracle BI EE now creates indexes and statistics on relational
tables when aggregates are persisted. See Chapter 13 for more information about
aggregate persistence.

Pruning Utility to Delete Unwanted Repository Objects

Oracle BI EE now includes a pruning utility to remove unwanted objects from your
repository. This utility is especially useful for Oracle BI Applications customers who
only need to use a subset of the objects included in the shipped Oracle BI Applications
repository. See Appendix E, "Deleting Unwanted Objects from the Repository" for
more information.

Ability to Defer Execution of Session Variable Initialization Blocks

To improve session logon time and save resources, administrators can defer execution
of selected session variable initialization blocks until the associated session variables
are actually used within the session. See "Creating Initialization Blocks" for more
information.

Improved Usability in the Administration Tool

Many Administration Tool screens, wizards, and other parts of the user interface were
updated and streamlined for this release of Oracle BI EE. Updated wizards include the
Create New Repository Wizard, Aggregate Persistence Wizard, and Merge Wizard.
Expression Builder and the Consistency Checker also contain usability enhancements
in this release.

Additional changes include updated and improved icons, a simpler process flow to
create joins, improvements to the Query Repository feature, and a simplified way to
add some repository objects. Also, shortcuts were added to enable keyboard access to
menu options, dialog navigation, and navigation in the Physical and Business Model
Diagrams.
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Introduction to Building Your Metadata
Repository

This chapter explains how to plan and design your Oracle Business Intelligence
metadata repository, including how to plan your business model, how to work with
the physical content for your business model, and general repository design
guidelines.

To effectively plan and build your metadata repository, you need to have experience
with SQL queries and be familiar with reporting and analysis. You should also have
experience with industry-standard data warehouse modeling practices, and be
familiar with general relational entity-relationship modeling.

This chapter contains the following topics:

= About Oracle Bl Server and Oracle Bl Repository Architecture
= Planning Your Business Model

s Identifying the Data Source Content for the Physical Layer

s Guidelines for Designing a Repository

»  Topics of Interest in Other Guides

= System Requirements and Certification

About Oracle Bl Server and Oracle Bl Repository Architecture

The architecture of the Oracle BI Server and the Oracle Bl repository provides a layer
of abstraction that lets users send simple Logical SQL queries against complex
federated data sources.

This section contains the following topics:
= About Oracle Bl Server Architecture

= About Layers in the Oracle Bl Repository

About Oracle Bl Server Architecture

The Oracle BI Server is an Oracle Business Intelligence component that processes user
requests and queries underlying data sources. The Oracle Bl Server maintains the
logical data model and provides client access to this model through ODBC.

The Oracle BI Server uses the metadata in the Oracle Bl repository to perform the
following two tasks:
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About Oracle Bl Server and Oracle Bl Repository Architecture

s Interpret Logical SQL queries and write corresponding physical queries against
the appropriate data sources

s  Transform and combine the physical result sets and perform final calculations

The Oracle BI Server connects to the underlying data sources through either ODBC or
through native APIs, such as OCI for Oracle Database.

The Administration Tool client is a Windows application that you can use to create
and edit your Oracle BI repository. The Administration Tool can connect directly to
the repository in offline mode, or it can connect to the repository through the Oracle BI
Server. Some options are only available in online mode. See "Using Online and Offline
Repository Modes" for more information.

Figure 1-1 shows how the Oracle BI Server interacts with query clients, data sources,
the Oracle BI repository, and the Administration Tool.

Figure 1-1 Oracle Bl Server Architecture
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Shows the query client layer, the Oracle BI Server layer, and the data source layer.
Communication between the client layer and server layer is through ODBC.
Communication between the server layer and data source layer is through ODBC or
native gateway.

The Oracle BI Server accesses the repository file. The Administration Tool client can
access the repository through the Oracle BI Server in online mode, or directly in offline
mode.
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Example 1-1 shows how the Oracle BI Server interprets and converts Logical SQL
queries.

Example 1-1 Logical Requests Are Transformed Into Complex Physical Queries
Assume the Oracle BI Server receives the following simple client request:

SELECT

"DO Time"."T02 Per Name Month" saw_0,

"D4 Product"."P0l Product" saw_1,

"F2 Units"."2-01 Billed Qty (Sum All)" saw_2
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FROM "Sample Sales"
ORDER BY saw_0, saw_1

The Oracle BI Server can then convert the Logical SQL query into a sophisticated
physical query, as follows:

WITH SAWITHO AS (
select T986.Per_Name_Month as cl, T879.Prod_Dsc as c2,
sum(T835.Units) as c3, T879.Prod_Key as c4
from
Product T879 /* AO05 Product */ ,
Time_Mth T986 /* A08 Time Mth */ ,
FactsRev T835 /* All Revenue (Billed Time Join) */
where ( T835.Prod_Key = T879.Prod_Key and T835.Bill_Mth = T986.Row_Wid)
group by T879.Prod_Dsc, T879.Prod _Key, T986.Per_Name_Month
)
select SAWITHO.cl as cl, SAWITHO.c2 as c2, SAWITHO.c3 as c3
from SAWITHO
order by cl, c2

About Layers in the Oracle Bl Repository
An Oracle Bl repository has the following layers:

= Physical layer. This layer defines the objects and relationships that the Oracle BI
Server needs to write native queries against each physical data source. You create
this layer by importing tables, cubes, and flat files from your data sources.

Separating the logical behavior of the application from the physical model
provides the ability to federate multiple physical sources to the same logical
object, enabling aggregate navigation and partitioning, as well as dimension
conformance and isolation from changes in the physical sources. This separation
also enables the creation of portable Bl Applications.

= Business Model and Mapping layer. This layer defines the business or logical
model of the data and specifies the mapping between the business model and the
physical schemas. This layer determines the analytic behavior seen by users, and
defines the superset of objects and relationships available to users. It also hides the
complexity of the source data models.

Each column in the business model maps to one or more columns in the Physical
layer. At run time, the Oracle BI Server evaluates Logical SQL requests against the
business model, and then uses the mappings to determine the best set of physical
tables, files, and cubes for generating the necessary physical queries. The
mappings often contain calculations and transformations, and might combine
multiple physical tables.

»  Presentation layer. This layer provides a way to present customized, secure,
role-based views of a business model to users. It adds a level of abstraction over
the Business Model and Mapping layer and provides the view of the data seen by
users building requests in Presentation Services and other clients.

You can create multiple subject areas in the Presentation layer that map to a single
business model, effectively breaking up the business model into manageable
pieces.

Before you build any repository layers in the Administration Tool, it is important to
create a high-level design of the Business Model and Mapping layer based on the
analytic requirements of your users. After you have a conceptual design to work
toward, you can then build your metadata objects.
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The typical order is to create the Physical layer objects first, the Business Model and
Mapping layer objects next, and the Presentation layer objects last. However, you can
work on each layer at any stage. After you complete all three layers, you can set up
security when you are ready to begin testing the repository.

Figure 1-2 shows how a Logical SQL query traverses the layers of an Oracle BI
repository.

Figure 1-2 Logical SQL Query Traversing the Layers in an Oracle Bl Repository
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Business Model and Mapping layer, and Physical layer). Also shows the client layer
(from which the request is generated) and the data source layer.

B R R R R R R R R R R R R R R R R R R R X R R R R R R R R R

Note that a single Oracle BI repository can contain two or more independent semantic
models, rather than a single, integrated, enterprise-wide model. A semantic model
consists of one business model, its related objects in the Presentation and Physical
layers, and additional related objects like variables, initialization blocks, and
application roles. A semantic model is also known as a Common Enterprise
Information Model.

See also Figure A—4 for a visual representation of multiple semantic models.

Planning Your Business Model

Planning your business model is the first step in developing a usable data model for
decision support. After you have followed the planning guidelines in this section, you
can begin to create your repository.
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Analyzing Your Business Model Requirements

Your first task is to thoroughly understand your business model requirements. You
must first understand what business model you want to build before you can
determine what the Physical layer needs to have in it.

In a decision support environment, the objective of data modeling is to design a model
that presents business information in a manner that parallels business analysts'
understanding of the business structure. A successful model allows the query process
to become a natural process by enabling analysts to structure queries in the same
intuitive fashion as they would ask business questions. This model must be one that
business analysts inherently understand and that answers meaningful questions
correctly.

Unlike visual SQL tools such as Oracle BI Publisher, the business model defines the
analytic behavior of your BI application. In contrast, the Physical layer only provides
the components used to assemble a physical query mapped from business model logic.

This requires breaking down your business into several components to answer the
following questions:

= What kinds of business questions are analysts trying to answer?
= What are the measures required to understand business performance?

= What are all the dimensions under which the business operates? Or, in other
words, what are the dimensions used to break down the measurements and
provide headers for the reports?

»  Are there hierarchical elements in each dimension, and what types of relationships
define each hierarchy?

After you have answered these questions, you can identify and define the elements of
your business model.

Identifying the Content of the Business Model

To determine what content to include in your business model, you must first identify
the logical columns on which users need to query. Then, to establish the role played by
each column, identify whether it is a measure column or a dimensional attribute.
Finally, arrange the logical columns in a dimensional model based on the relevant
roles, relationships between columns, and logic.

Businesses are analyzed by relevant dimensional criteria, and the business model is
developed from these relevant dimensions. These dimensional models form the basis
of the valid business models to use with the Oracle BI Server.

Although not all dimensional models are built around a star schema, it is a best
practice to use a simple star schema in the business model layer. In other words, the
dimensional model should represent some measurable facts that are viewed in terms
of various dimensional attributes.

After you analyze your business model requirements, you need to identify the specific
logical tables and hierarchies that you need to include in your business model.

This section contains the following topics:
= Identifying Logical Fact Tables

s Identifying Logical Dimension Tables
= Identifying Dimensions

s Identifying Lookup Tables
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Identifying Logical Fact Tables

Logical fact tables in the Business Model and Mapping layer contain measures that
have aggregations built into their definitions. Logical fact tables are different from
physical fact tables in relational models, which instead define facts at the lowest grain
of the table.

Measures aggregated from facts must be defined in a logical fact table. Measures are
typically calculated data such as dollar value or quantity sold, and they can be
specified in terms of dimensions. For example, you might want to determine the sum
of dollars for a given product in a given market over a given time period.

Each measure has its own aggregation rule such as SUlM, AVG, MIN, or MAX. A business
might want to compare values of a measure and need a calculation to express the
comparison. Also, aggregation rules can be specific to particular dimensions. The
Oracle BI Server lets you define complex, dimension-specific aggregation rules.

You do not explicitly label tables in the Business Model and Mapping layer as fact
tables or dimension tables. Rather, the Oracle BI Server treats tables at the "one" end of
a join as dimension tables, and tables at the "many" end of a join as fact tables.

Figure 1-3 illustrates the many-to-one joins to a fact table in a Business Model
Diagram. In the diagram, all joins have an arrow (indicating the one side) pointing
away from the Fact-Pipeline table; no joins are pointing to it. For an example of this in
a business model, open a repository in the Administration Tool, right-click a fact table,
and select Business Model Diagram > Whole Diagram.

Figure 1-3 Diagram of Fact Table Joins
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Shows many-to-one fact table joins in the Business Model Diagram in the
Administration Tool.
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Identifying Logical Dimension Tables

A business uses facts to measure performance by well-established dimensions, for
example, by time, product, and market. Every dimension has a set of descriptive
attributes. Dimension tables contain attributes that describe business entities (such as
Customer Name, Region, Address, Country and so on). Dimension tables also contain
primary keys that identify each member. Unlike logical fact tables, which are different

1-6 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



Planning Your Business Model

from physical fact tables in relational models, logical dimension tables behave very
much like relational dimension tables.

Dimension table attributes provide context to numeric data, such as being able to
categorize Service Requests. Attributes stored in this dimension might include Service
Request Owner, Area, Account, Priority, and so on.

Dimensions in the business model are conformed dimensions. In other words, even if
a particular data source has five different instances of a particular Customer table, the
business model should only have one table. To achieve this, all five physical source
instances of Customer are mapped to a single Customer logical table, with
transformations in the logical table source as necessary. Conformed dimensions hide
the complexity of the Physical layer from users and enable you to combine data from
multiple fact sources at different grains. They also enable you to federate multiple data
sources.

Also note that dimension and level keys in the business model should be business
keys rather than generated surrogate keys. In other words, use "Customer Name" with
values like "Oracle" instead of "Customer Key" with values like "1076823." Using
business keys in the business model ensures that all sources for that dimension can be
conformed to the same logical dimension table with the same logical key and level
key.

Although generated surrogate keys can still exist in the Physical layer, where they are
useful for their query performance advantages on joins, you typically do not have
surrogate key columns in the Business Model and Mapping layer at all.

Identifying Dimensions

Dimensions are categories of attributes by which the business is defined. Common
dimensions are time periods, products, markets, customers, suppliers, promotion
conditions, raw materials, manufacturing plants, transportation methods, media types,
and time of day. Within a given dimension, there may be many attributes. For
example, the time period dimension can contain the attributes day, week, month,
quarter, and year. Exactly what attributes a dimension contains depends on the way
the business is analyzed.

Dimensions typically contain hierarchies, which are sets top-down relationships
between members within a dimension. There are two types of hierarchies: level-based
hierarchies (structure hierarchies), and parent-child hierarchies (value hierarchies).
Level-based hierarchies are those in which members of the same type occur only at a
single level, while members in parent-child hierarchies all have the same type. Oracle
Business Intelligence also supports a special type of level-based dimension, called a
time dimension, that provides special functionality for modeling time series data.

In level-based hierarchies, levels roll up from lower level to higher level; for example,
months can roll up into a year. These rollups occur over the hierarchy elements and
span natural business relationships.

In parent-child hierarchies, the business relationships occur between different
members of the same real-world type, such as the manager-employee relationship in
an organizational hierarchy tree. Parent-child hierarchies do not have explicitly named
levels. There is no limit to the number of implicit levels in a parent-child hierarchy.

To define your hierarchies, you define the "contains" relationships in your business
(geographical, product, time, and so on) to drive rollup aggregations in all
calculations, as well as drill-down navigation in reports and dashboards. For example,
if month rolls up into year and an aggregate table exists at the month level, that table
can be used to answer questions at the year level by adding up all of the month-level
data for a year.
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It is important to use the right type of hierarchy for your needs. To determine which
type to use, consider the following:

Are all the members of the same type (such as employee, assembly, or account), or
are they of different types that naturally fall into levels (such as
year-quarter-month, continent-country-state/province, or brand-line-product)?

Do members have the same set of attributes? For example, in a parent-child
hierarchy like Employees, all members might have a Hire Date attribute. In a
level-based hierarchy like Time, however, the Day type might have a Holiday
attribute, while Month does not.

Are the levels fixed at design time (year-quarter-month), or can run-time business
transactions add or subtract levels? For example, a level could be added when the
current lowest-level employee hires a subordinate, who then becomes the new
lowest level.

Are there constraints in your primary data source that require a certain hierarchy
type? If your primary data source is modeled in one way or the other, you might
need to use the same hierarchy type in your business model, regardless of other
factors.

See Chapter 10, "Working with Logical Dimensions" for more information.

About Dimensions with Multiple Hierarchies Sometimes, dimensions can contain multiple
hierarchies. For example, time dimensions often have one hierarchy for the calendar
year, and another hierarchy for the fiscal year. Note that dimensions with multiple
hierarchies must always end with the same leaf table.

Figure 1-4 shows a dimension with multiple hierarchies in the Business Model and
Mapping layer of the Administration Tool.

Figure 1-4 Dimension with Multiple Hierarchies

[
[
£
&

Business Model and Mapping

@ 1 -Sample fpp
=18 HOTime

B~ Total Time
B0 Fiscal Year
. fF T45FsclYear
i B3 Fisoal Half
H @@ T44 FsclHalf
=10 Fiseal Qu
@ T43 Faol Ot
=13 Fiscal Month
@ T42FsclMonth
B0 Fissal Week
@ T4 Faclwesk
=L Day Detail
= T00 Calendar Date
ER=
@@ T05 Per Name Year
-l Half
@@ T04 Per Name Half
=0 Huatter
(@ T03 Par Name O
=+l Manth
{ @@ T02Per Name Maonth
B0 Wesk
@@ TOT Per Name Week
=4 Day Detail
= 100 Calendar Date
H1 Products
H2 Products Ragged SkipLevels
H3 Offices
H4 Dffices and Channels [M:M)

Shows the Business Model and Mapping layer in the Administration Tool. A time
dimension, HO Time, is shown with two hierarchies: Fiscal Year and Year.

S 3434 36 38 36 36 36 36 3 3 3 3 3 3 o S 8 e 438 8 36 36 36 36 363 3 3 3 3 o e e e 86636 36 36 3 3 3 3 3 3 3 o o o 6 6 6 6 6 36 36 36 36 3 3 3 3 3 3 o e e e 838636 3 36 3 3 3 3 3 3 o oo % 4 KKK

1-8 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



Identifying the Data Source Content for the Physical Layer

Identifying Lookup Tables

When you need to display translated field information from multilingual schemas,
you create a logical lookup table that corresponds to a lookup table in the Physical
layer. A lookup table stores multilingual data corresponding to rows in the base tables.
Before you can use a particular logical lookup table, you must designate it as a lookup
table in the General tab of the Logical Table dialog. See "Localizing Oracle Business
Intelligence" in Oracle Fusion Middleware System Administrator’s Guide for Oracle
Business Intelligence Enterprise Edition for more information about localization and
lookup tables.

In addition to localization, lookup tables can be used any time you need to display one
set of values to users, while using a different, corresponding set of values in the
physical query. If necessary, the human-readable value can be looked up in a
completely different data source.

Identifying the Data Source Content for the Physical Layer

After you have determined the requirements for your business model, you can look at
what data source content you need in the Physical layer. Unlike the Business Model
and Mapping layer, which is always dimensional, each physical model mirrors the
shape of the source (for example, normalized, cube, and so on).

This section contains the following topics:
= About Types of Physical Schemas in Relational Data Sources
= About Cubes in Multidimensional Data Sources

= Identifying the Data Source Table Structure

About Types of Physical Schemas in Relational Data Sources

You can successfully model any physical schema in the Oracle BI repository,
regardless of its type, because the model of any physical source can be broken down
into overlapping subsets that are dimensional.

There are four types of physical schemas (models):

»  Star Schemas. A star schema is a set of dimensional schemas (stars) that each have
a single fact table with foreign key join relationships to several dimension tables.
When you map a star to the business model, you first map the physical fact
columns to one or more logical fact tables. Then, for each physical dimension table
that joins to the physical fact table for that star, you map the physical dimension
columns to the appropriate conformed logical dimension tables.

" Snowflake Schemas. A snowflake schema is similar to a star schema, except that
each dimension is made up of multiple tables joined together. Like star schemas,
you first map the physical fact columns to one or more logical tables. Then, for
each dimension, you map the snowflaked physical dimension tables to a single
logical table. You can achieve this by either having multiple logical table sources,
or by using a single logical table source with joins.

=  Normalized Schemas. Normalized schemas distribute data entities into multiple
tables to minimize data storage redundancy and optimize data updates. Before
mapping a normalized schema to the business model, you need to understand
how the distributed structure can be understood in terms of facts and dimensions.

After analyzing the structure, you pick a table that has fact columns and then map
the physical fact columns to one or more logical fact tables. Then, for each
dimension associated with that set of physical fact columns, you map the
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distributed physical tables containing dimensional columns to a single logical
table. Like with snowflake schemas, you can achieve this by having multiple
logical table sources, or by using a single logical table source with joins. Mapping
normalized schemas is an iterative process because you first map a certain set of
facts, then the associated dimensions, and then you move on to the next set of
facts.

Note that when a single physical table has both fact and dimension columns, you
may need to create a physical alias table to handle the multiple roles played by
that table.

Fully Denormalized Schemas. This type of dimensional schema combines the
facts and dimensions as columns in one table (or flat file), and is mapped
differently than other types of schemas. When you map a fully denormalized
schema to the star-shaped business model, you map the physical fact columns
from the single physical fact table to multiple logical fact tables in the business
model. Then, you map the physical dimension columns to the appropriate
conformed logical dimension tables.

About Cubes in Multidimensional Data Sources

Cubes are made up of measures and organized by dimensions. Because they are
already dimensional, each cube maps easily to the logical fact and dimension tables in
the business model.

Note the following about measures and dimensions:

Measures in multidimensional cubes and relational fact columns both map to
logical measures in the Business Model and Mapping layer. However, measures in
multidimensional cubes already include calculations and aggregations, unlike
relational fact columns, which require the calculations and aggregations to be
applied in the business model. Rather than treating cubes like relational sources,
the Oracle BI Server can take advantage of the pre-aggregated data and powerful
calculations in the cube.

Multidimensional physical objects and relational physical objects both map to
logical dimensions in the Business Model and Mapping layer. However,
dimensional and hierarchical semantics are already built into multidimensional
data sources, unlike relational sources. The Oracle BI Server can take advantage of
the more complete hierarchy and dimensional support in the cube, both during
import and at query time.

Identifying the Data Source Table Structure

The Administration Tool provides an interface to map logical tables to the underlying
physical tables in your data sources. Before you can map the tables, you need to
identify the contents of the physical data sources as it relates to your business model.
To do this correctly, you need to identify the following contents of the physical data
source:

Identify the contents of each table
Identify the detail level for each table

Identify the table definition for each aggregate table. This lets you set up aggregate
navigation. The following detail is required by the Oracle BI Server:

— The columns by which the table is grouped (the aggregation level)

— The type of aggregation (SUM, AVG, MIN, MAX, or COUNT)
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For information on how to set up aggregate navigation in a repository, see
Chapter 11.

= Identify the contents of each column
s Identify how each measure is calculated
s Identify the joins defined in the database

To acquire this information about the data, you could refer to any available
documentation that describes the data elements created when the data source was
implemented, or you might need to spend some time with the DBA for each data
source to get this information. To fully understand all the data elements, you might
also need to ask people in the organization who are users of the data, owners of the
data, or the application developers of applications that create the data.

Guidelines for Designing a Repository

After analyzing your business model needs and identifying the database content your
business needs, you can complete your repository design. This section contains some
design best practices that can help you implement a more efficient repository.

Typically, you should not make performance tuning changes until you have imported
and tested your databases. These tasks are performed during the final steps in
completing the setup of your repository. For more information about these final steps,
see Chapter 15.

This section contains the following topics:

= General Tips for Working on the Repository

s Design Tips for the Physical Layer

s Design Tips for the Business Model and Mapping Layer

s Design Tips for the Presentation Layer

General Tips for Working on the Repository

Follow these recommended design strategies for structuring your Oracle BI repository:

s If you work in online mode, save backups of the online repository before and after
every completed unit of work. If needed, use Copy As on the File menu to make
an offline copy containing the changes.

s Use the Physical Diagrams in the Administration Tool to verify sources and joins.

s Decide whether you want to set up row-level security controls in the database, or
in the repository. This decision determines whether you share connection pools
and cache, and may limit the number of separate source databases you want to
include in your deployment. See Chapter 14, "Applying Data Access Security to
Repository Objects” for more information.

Most dialogs in the Administration Tool have Help that provides information about
how to complete a task. To access a help topic, click the Help button in a dialog, or
select Help from some menus.

Design Tips for the Physical Layer

The Physical layer contains information about the physical data sources. The most
common way to create the schema in the Physical layer is by importing metadata from
databases and other data sources. If you import metadata, many of the properties are
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configured automatically based on the information gathered during the import
process. You can also define other attributes of the physical data source, such as join
relationships, that might not exist in the data source metadata.

The Physical layer can contain data sources of many different types, including
multidimensional, relational, and XML sources. See "System Requirements and
Certification" for information about supported databases.

For each data source, there is at least one corresponding connection pool. The
connection pool contains data source name (DSN) information used to connect to a
data source, the number of connections allowed, timeout information, and other
connectivity-related administrative details. See "About Connection Pools" for more
information.

The following is a list of tips to use when designing the Physical layer:

s Itis recommended that you use table aliases frequently in the Physical layer to
eliminate extraneous joins, including the following:

- Eliminate all physical joins that cross dimensions (inter-dimensional circular
joins) by using aliases.

- Eliminate all circular joins (intra-dimensional circular joins) in a logical table
source in the Physical Model by creating physical table aliases.

For example, say you have a Customer table that can be used to look up
ship-to addresses, and using a different join, to look up bill-to addresses.
Avoid the circular joins by aliasing the table in the Physical layer so that there
is one instance for each purpose, with separate joins.

If you do not eliminate circular joins, you might get erroneous report results. In
addition, query performance might be negatively impacted.

= You might import some tables into the Physical layer that you might not use right
away, but that you do not want to delete. To identify tables that you do want to
use right away in the Business Model and Mapping layer, you can assign aliases to
physical tables before mapping them to the business model layer.

Note: To have the name of a table to which you assigned an alias
appear, select Display original name for alias in diagrams in Tools >
Options > General.

= Anopaque view (a Physical layer table that consists of a SELECT statement) should
be used only if there is no other solution to your modeling problem. Ideally, a
physical table should be created, or alternatively a materialized view. Opaque
views prevent the Oracle BI Server from generating its own optimized SQL,
because they contain fixed SQL statements that are sent to the underlying data
source.

Design Tips for the Business Model and Mapping Layer

The Business Model and Mapping layer organizes information by business model. In
this layer, each business model is effectively a separate application.

The logical schema defined in each business model must contain at least two logical
tables. Relationships need to be defined between all the logical tables. See "About
Layers in the Oracle BI Repository” for more information about business model
schemas. See Chapter 9 for more information about setting up the Business Model and
Mapping layer.

1-12 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



Guidelines for Designing a Repository

The following is a list of tips to use when designing the Business Model and Mapping
layer:

Create the business model with one-to-many logical joins between logical
dimension tables and the fact tables wherever possible. The business model
should ideally resemble a simple star schema in which each fact table is joined
directly to its dimensions.

Every logical fact table must join to at least one logical dimension table. Note that
when the source is a fully denormalized table or flat file, you must map its
physical fact columns to one or more logical fact tables, and its physical dimension
columns to logical dimension tables.

Every logical dimension table should have a dimensional hierarchy associated
with it. This rule holds true even if the hierarchy has only one level, such as a
scenario dimension {actual, forecast, plan}.

When creating level-based measures, make sure that all appropriate fact sources
map to the appropriate level in the hierarchy using aggregation content. You set
up aggregation content in the Levels tab of the Logical Column dialog for the
measure. Note that this is different from the Content tab of the Logical Table
Source dialog, which is used to specify the grain of the source tables to which it
maps.

You only need to set up aggregation content in the Levels tab of the Logical
Column dialog for level-based measures. For measures that are not level based,
leave the Logical Level field blank.

Typically, logical fact tables should not contain any keys. The only exception is

when you need to send Logical SQL queries against the Oracle BI Server from a
client that requires keys. In this case, you need to expose those keys in both the
logical fact tables, and in the Presentation layer.

Normally, all columns in logical fact tables are aggregated measures, except for
keys required by external clients, or dummy columns used as a divider. Other
non-aggregated columns should instead exist in a logical dimension table.

In some situations, you might want to have multiple logical fact tables in a single
business model. For Logical SQL queries, the multiple logical fact tables behave as
if they are one table.

Reasons to have multiple logical fact tables include:
- To assign projects. See "Setting Up Projects” for more information.

- To automatically create small subject areas in the Presentation layer. See
"Automatically Creating Subject Areas Based on Logical Stars and Snowflakes"
for more information.

- For organization and simplicity of understanding.

Unlike relational fact tables, logical fact tables can contain measures of different
grains. Because of this, grain is not a reason to split up logical fact tables.

You can define calculations in either of the following ways:

— Before the aggregation, in the logical table source. For example:
sum(col_A *( col_B))

-  After the aggregation, in a logical column derived from two other logical
columns. For example:

sum(col A) * sum(col B)
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You can also define post-aggregation calculations in Answers or in Logical SQL
queries.

If you plan to use Oracle Scorecard and Strategy Management, it is a best practice
to implement at least one time dimension in the Oracle BI repository you are using
for your KPIs. This action is necessary because you use KPIs in scorecards to
measure progress and performance over time. Note that an individual scorecard
automatically picks up any dimension used by KPIs in that scorecard.

Aggregate sources should be created as separate logical table sources. For fact
aggregates, use the Content tab of the Logical Table Source dialog to assign the
correct logical level to each dimension.

Each dimension level in a hierarchy must have a unique level key. Also, each
logical dimension table must have a unique primary key. Normally, this key is
also used as the level key for the lowest hierarchy level.

Renaming columns in the Business Model and Mapping layer automatically
creates aliases (synonyms) for Presentation layer columns that have the property
Use Logical Column Name selected.

To prevent problems with aggregate navigation, ensure that each logical level of a
dimension hierarchy contains the correct value in the field named Number of
elements at this level. Fact sources are selected on a combination of the fields
selected as well as the levels in the dimensions to which they map. By adjusting
these values, you can alter the fact source selected by the Oracle BI Server. See
"Creating Logical Levels in a Dimension" for more information about setting this
value.

Modeling Outer Joins
The following guidelines provide tips on how to model outer joins:

Due to the nature of outer joins, queries that use them are usually slower. Because
of this, define outer joins only when necessary. Where possible, use ETL
techniques to eliminate the need for outer joins in the reporting SQL.

Outer joins are always defined in the Business Model and Mapping layer. Physical
layer joins do not specify inner or outer.

You can define outer joins by using logical table joins, or in logical table sources.
Which type of outer join you use is determined by whether the physical join maps
to a business model join, or to a logical table source join.

Be aware that outer joins in logical table sources are always included in a query,
even if the none of the columns in one of the mapped physical tables are used.

For example, assume that a logical table source is mapped to physical tables A and
B. When no outer joins are defined, if physical table A is not required to satisfy a
request, it is not included in the physical query. However, if the logical table
source has an outer join defined to table A, table A is still included in the physical
query, even if only physical table B is required to satisfy the request.

If you must define an outer join, try to create two separate dimensions, one that
uses the outer join and one that does not. Make sure to name the dimension with
the outer join in a way that clearly identifies it, so that client users can use it as
little as possible.
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Design Tips for the Presentation Layer

You set up the user view of a business model in the Presentation layer. The names of
folders and columns in the Presentation layer can appear in localized language
translations. The Presentation layer is the appropriate layer in which to set user
permissions. For complete information about working in the Presentation layer, see
Chapter 12.

In this layer, you can do the following:

You can show fewer columns than exist in the Business Model and Mapping layer.
For example, you can exclude the key columns because they have no business
meaning.

You can organize columns using a different structure from the table structure in
the Business Model and Mapping layer.

You can display column names that are different from the column names in the
Business Model and Mapping layer.

You can set permissions to grant or deny users access to individual subject areas,
tables, and columns.

You can export logical keys to ODBC-based query and reporting tools.
You can create multiple subject areas for a single business model.

You can create a list of aliases (synonyms) for presentation objects that can be used
in Logical SQL queries. This feature lets you change presentation column names
without breaking existing reports.

The following is a list of tips to use when designing the Presentation layer:

Because there is no automatic way to synchronize all changes between the
Business Model and Mapping layer and the Presentation layer, it is best to wait
until the Business Model and Mapping layer is relatively stable before adding
customizations in the Presentation layer.

There are many ways to create subject areas, such as dragging and dropping the
entire business model, dragging and dropping incremental pieces of the model, or
automatically creating subject areas based on logical stars or snowflakes. See
"Creating Subject Areas" for information about each of these methods. Dragging
and dropping incrementally works well if certain parts of your business model are
still changing.

It is a best practice to rename objects in the Business Model and Mapping layer
rather than the Presentation layer, for better maintainability. Giving user-friendly
names to logical objects rather than presentation objects ensures that the names
can be reused in multiple subject areas. Also, it ensures that the names persist
even when you need to delete and re-create subject areas to incorporate changes to
your business model.

Be aware that members in a presentation hierarchy are not visible in the
Presentation layer. Instead, you can see hierarchy members in Answers.

You can use the Administration Tool to update Presentation layer metadata to
give the appearance of nested folders in Answers. See "Nesting Folders in
Answers and BI Composer” for more information.

When setting up data access security for a large number of objects, consider
setting object permissions by role rather than setting permissions for individual
columns. See Chapter 14, "Applying Data Access Security to Repository Objects"
for details.
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= When setting permissions on presentation objects, you can change the default
permission by setting the DEFAULT_PRIVILEGES configuration setting in the
NQSConfig.INI file. See Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition for more information.

Topics of Interest in Other Guides

Some topics that may be of interest to metadata repository builders are covered in
other guides. Table 1-1 lists these topics, and indicates where to go for more

information.

Table 1-1

Topics Covered in Other Guides

Topic

Where to Go for More Information

Starting and stopping Oracle
Business Intelligence processes

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Using the Oracle BI Server XML
API to work with your
repository

Oracle Fusion Middleware XML Schema Reference for Oracle
Business Intelligence Enterprise Edition

Using the Oracle BI Server Web
services

Oracle Fusion Middleware Integrator’s Guide for Oracle
Business Intelligence Enterprise Edition

Setting up and managing query
caching

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Managing configuration settings
that affect repository
development in Fusion
Middleware Control and
NQSConfig.INI

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Managing users, groups, and
application roles

Oracle Fusion Middleware Security Guide for Oracle Business
Intelligence Enterprise Edition

Moving from test to production
environments

Oracle Fusion Middleware Administrator’s Guide

Setting up DSNs for the Oracle
BI Server

Oracle Fusion Middleware Integrator’s Guide for Oracle
Business Intelligence Enterprise Edition

Localizing Oracle Business
Intelligence deployments

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Information about the SA System
subject area

Oracle Fusion Middleware Scheduling Jobs Guide for Oracle
Business Intelligence Enterprise Edition

Managing logging

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Managing usage tracking

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

General information about
managing Oracle WebLogic
Server

Oracle Fusion Middleware Administrator’s Guide

System Requirements and Certification

Refer to the system requirements and certification documentation for information
about hardware and software requirements, platforms, databases, and other
information. Both of these documents are available on Oracle Technology Network

(OTN).
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The system requirements document covers information such as hardware and
software requirements, minimum disk space and memory requirements, and required
system libraries, packages, or patches:

http://www.oracle.com/technetwork/middleware/ias/downloads/fusio
n-requirements-100147.html

The certification document covers supported installation types, platforms, operating
systems, databases, JDKs, and third-party products:

http://www.oracle.com/technetwork/middleware/ias/downloads/fusio
n-certification-100350.html
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Before You Begin

This chapter provides an overview of the Oracle BI Administration Tool, and explains
other concepts that you need to know before beginning to build your metadata
repository.

This chapter contains the following topics:

About the Oracle BI Administration Tool

About the Oracle BI Server Command-Line Utilities

About Options in Fusion Middleware Control and NQSConfig.INI
About the SampleApp.rpd Demonstration Repository

Using Online and Offline Repository Modes

Checking the Consistency of a Repository or a Business Model

About the Oracle Bl Administration Tool

The Oracle BI Administration Tool is a Windows application that you can use to create
and edit repositories.

This section describes the Administration Tool main window, how to set preferences,
Administration Tool menus, and other related information.

This section contains the following topics:

Opening the Administration Tool

About the Administration Tool Main Window

Setting Administration Tool Options

About Administration Tool Menus

Using the Physical and Business Model Diagrams

Editing, Deleting, and Reordering Objects in the Repository
About Naming Requirements for Repository Objects

Using the Browse Dialog to Browse for Objects

Changing Icons for Repository Objects

Sorting Objects in the Administration Tool

About Features and Options for Oracle Marketing Segmentation
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Opening the Administration Tool

To open the Administration Tool, choose Start > Programs > Oracle Business
Intelligence > BI Administration.

Note: Do not open the Administration Tool by double-clicking a
repository file. The resulting Administration Tool window is not
initialized to your Oracle instance, and errors will result.

You can also launch the Administration Tool from the command line, as follows:
1. In Windows Explorer, go to the location appropriate for your install type:
»  Client installations:

ORACLE_HOME/bifoundation/server/bin

= All other installations:
ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup
2. Double-click bi-init.cmd (or bi-init.bat for client installations) to display a
command prompt that is initialized to your Oracle instance.

3. At the command prompt, type admintool and press Enter.

About the Administration Tool Main Window

The main window of the Administration Tool shows a graphical representation of the
three layers of a repository (the Physical layer, Business Model and Mapping layer,
and Presentation layer). See "About Layers in the Oracle BI Repository" for more
information.

The Administration Tool main window also contains the following:
s Menus. See "About Administration Tool Menus" for more information.

s Toolbar. Provides access to global functionality such as Open and Save, and also
includes functions for the Physical Diagram and Business Model Diagram.

= Status bar. Provides contextual information about the current dialog or selected
object, as well as other useful information.

s Title bar. In online mode, displays the DSN for the Oracle BI Server to which you
are connected. In offline mode, displays one of the following:

- RPD files: The name of the open repository (for example, SampleAppLite).

- MDS XML files: The format and root folder location (for example, MDS XML
C:\Root_Folder).

Figure 2-1 shows the Administration Tool main window.
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Figure 2-1 Example Administration Tool Main Window
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Setting Administration Tool Options

You can use the Options dialog to set preferences and options for the Administration
Tool.

To set Administration Tool options:

1. In the Administration Tool, select Tools, then select Options to display the
Options dialog.

2. On the General tab, select the options you want to choose.

Table 2-1 describes the options on the General tab.

Table 2-1 Options on the General Tab

Option Action When Selected

Tile when resizing Automatically tiles the layer panes of the repository when you
resize the Administration Tool. When this option is selected, the
Cascade and Tile options are not available in the Windows
menu of the Administration Tool.

Display qualified names in | Displays fully qualified names in the Physical Diagram and
diagrams Business Model Diagram. For example, selecting this option
displays "B - Sample Fcst Data"..."B02 Market" rather than B02
Market in the Physical Diagram.

Selecting this option can help identify objects by including the
name of the parent database or business model, but it can also
make the diagram harder to read because the fully qualified
names are longer.

Note: If you choose not to select this option, you can still see
fully qualified names by moving the cursor over an object in the
diagram, or by selecting an object in the diagram and then
viewing the text in the status bar.
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Table 2-1 (Cont.) Options on the General Tab

Option

Action When Selected

Display original names for
alias in diagrams

Displays the names of original physical tables rather than the
names of alias tables in the Physical diagram. Select this option
when you want to identify the original table rather than the
alias table name.

Show Calculation Wizard
introduction page

Displays the Calculation Wizard introduction page. The
introduction page also contains an option to suppress its
display in the future.

Use the Calculation Wizard to create new calculation columns
that compare two existing columns and to create metrics in bulk
(aggregated), including existing error trapping for NULL and
divide by zero logic. See "Using the Calculation Wizard" for
more information.

Check out objects
automatically

Automatically checks out an object when you double-click it. If
you do not select this option, you are prompted to check out
objects before you can edit them.

This option only applies when the Administration Tool is open
in online mode. See "Editing Repositories in Online Mode" for
more information.

Show row count in physical
view

Displays row counts for physical tables and columns in the
Physical layer. Row counts are not initially displayed until they
are updated. To update the counts, select Tools > Update All
Row Counts. You can also right-click a table or column in the
Physical layer and select the option Update Row Count.

Note: Row counts are not shown for items that are stored
procedure calls (from the Table Type list in the General tab of
the Physical Table dialog). Row counts are not available for
XML, XML Server, or multidimensional data sources. When you
are working in online mode, you cannot update row counts on
any new objects until you check them in.

Show toolbar

When selected, displays the Administration Tool toolbar.

Show statusbar

When selected, displays the Administration Tool status bar.

Prompt when moving
logical columns

Lets you ignore, specify an existing, or create a new logical table
source for a moved column.

Remove unused physical
tables after Merge

Executes a utility to clean the repository of unused physical
objects. It might make the resulting repository smaller.

Allow import from
repository

When selected, the Import from Repository option on the File
menu becomes available.

Note: By default, the Import from Repository option on the File
menu is disabled and this option will not be supported in the
future. It is recommended that you create projects in the
repository that contain the objects that you want to import, and
then use repository merge to bring the projects into your current
repository. See "Merging Repositories" for more information.

Allow logical foreign key
join creation

When selected, provides the capability to create logical foreign
key joins with the Joins Manager. This option is provided for
compatibility with previous releases and is generally not
recommended.

Skip Gen 1 levels in Essbase
drag and drop actions

When selected, excludes Gen 1 levels when you drag and drop
Essbase cubes or dimensions from the Physical layer to the
Business Model and Mapping layer. Often, Gen 1 levels are not
needed for analysis, so they can be excluded from the business
model.

See "Working with Essbase Data Sources" for more information.
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Table 2-1 (Cont.) Options on the General Tab

Option

Action When Selected

Hide unusable logical table | By default, the Replace Wizard shows all logical table sources,
sources in Replace wizard | even ones that are not valid for replacement. When this option

is selected, unusable logical table sources are hidden in the
Replace Wizard screens. Click Info for details on why a logical
table source that maps to that column does not appear in the
list.

Selecting this option might result in the Wizard page loading
more quickly, especially for large repositories.

Allow first Connection Pool | By default, when you select a connection pool for an
for Init Blocks initialization block, the first connection pool under the database

object in the Physical layer does not show up as available for
selection. This behavior ensures that you cannot use the same
connection pool for initialization blocks that you use for queries.
If the same connection pool is used for initialization blocks and
for queries, then queries might be blocked whenever
initialization blocks run. Alternatively, initialization blocks used
for authentication might be blocked by long-running queries,
causing delayed or hanging logins.

Select this option to change the default behavior and allow the
first connection pool to be selected for initialization blocks. Note
that selecting this option is not a best practice and might cause
performance issues.

See "About Connection Pools for Initialization Blocks" for more
information.

Show Upgrade ID in Query | Upgrade IDs are not displayed by default in the Query
Repository Repository dialog. When this option is selected, Upgrade IDs

are displayed as a column in the Query Repository results. In
addition, you can set a filter on Upgrade ID to search for a
particular value.

This option is useful for MDS XML format repositories in which
the Upgrade ID is included in the file name.

Extender For BIAPPS Enable this option when running the BI Extender for Oracle BI

Applications. See "Using the BI Extender to Propagate Flex
Object Changes" for more information.

3.

On the Repository tab, you can set the following options:

Show tables and dimensions only under display folders. You can create
display folders to organize objects in the Physical and Business Model and
Mapping layers. They have no metadata meaning. After you create a display
folder, the selected objects appear in the folder as a shortcut and in the
database or business model tree as an object. You can hide the objects so that
only the shortcuts appear in the display folder.

See "Setting Up Display Folders in the Physical Layer" and "Setting Up
Display Folders in the Business Model and Mapping Layer" for more
information about creating display folders.

Hide level based measure. By default, each level of a dimension hierarchy in
the Business Model and Mapping layer shows both dimension columns that
are assigned to that level, and level-based measures that have been fixed at
that level. Level-based measures are objects that are not part of the dimension
table, but that have been explicitly defined as being at a particular level.

Hiding level-based measures in dimension hierarchies can reduce clutter.
Note that the measures are still visible in the logical fact tables.
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See Example 10-1, "Level-Based Measure Calculations" for more information
about level-based measures.

= System logging level. This option determines the default query logging level
for the internal BISystem user. The BISystem user owns the Oracle BI Server
system processes and is not exposed in any user interface.

A query logging level of 0 (the default) means no logging. Set this logging
level to 2 to enable query logging for internal system processes like event
polling and initialization blocks.

See "Managing the Query Log" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for more
information about the query log and query logging levels.

s LDAP. If you are using any alternative LDAP servers, the Oracle BI Server
maintains an authentication cache in memory for user identifiers and
properties, which improves performance when using LDAP to authenticate
large numbers of users. Disabling the authentication cache can slow
performance when hundreds of sessions are being authenticated. Note that the
authentication cache is not used for Oracle WebLogic Server's embedded
directory server.

Properties for the authentication cache include:

— Cache refresh interval. The interval at which the authentication cache
entry for a logged on user is refreshed.

— Number of Cache Entries. The maximum number of entries in the
authentication cache, preallocated when the Oracle BI Server starts. If the
number of users exceeds this limit, cache entries are replaced using the
LRU algorithm. If this value is 0, then the authentication cache is disabled.

You need to specify some additional LDAP properties when you are using a
secure connection to your LDAP server. In other words, provide the following
information when you have selected SSL on the Advanced tab of the LDAP
Server dialog:

- Key file name. The name of the key file that holds the client certificate and
Certificate Authority (CA) certificate.

- Password and Confirm password. The password for the key file.

Note that the authentication cache properties and key file properties are
shared for all defined LDAP server objects.

4. On the Sort Objects tab, specify which repository objects appear in the
Administration Tool in alphabetical order. For example, if you want the database
objects that appear in the Physical layer to appear in alphabetical order, select the
Database option.

5. On the Source Control tab, you can create or edit a configuration file to integrate
with a source control management system, as well as view and change the status
of an MDS XML repository (either Standalone or Use Source Control). See
"Creating an SCM Configuration File" for more information.

6. On the Cache Manager tab, select the columns you want to display in the Cache
Manager. To change the order of columns in the Cache Manager, select an item,
then use the Up and Down buttons to change its position.

7. On the Multiuser tab, specify the path to the multiuser development directory and
the name of the local developer for this Administration Tool. See "Setting Up a
Pointer to the Multiuser Development Directory” for more information.
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8. On the More tab, you can set the scrolling speed for Administration Tool dialogs.
To set the scrolling speed, position the cursor on the slider.

9. Click OK when you are finished setting preferences.

About Administration Tool Menus

The Administration Tool includes menus for File, Edit, View, Manage, Tools, Diagram,
Window, and Help. These menus are described in the following sections.

File Menu

The File menu provides options to work with repositories, like Open and Save, as well
as several server-related options like Check Out All that are only active when a
repository is open in online mode. The File menu also provides a list of recently

opened repositories.

Table 2-2 lists the options in the File menu.

Table 2-2  File Menu Options

Menu Option

Description

New Repository

Opens the Create New Repository Wizard and closes the
currently open repository, if any. If a repository is currently
open with unsaved changes, you are prompted to save them
before proceeding.

See "Creating a New Oracle BI Repository" for more
information.

Open

Provides the following options:

= Offline: Select this option to open an RPD file in offline
mode.

s MDS XML: Select this option to open a repository in MDS
XML format in offline mode.

= Online: Select this option to open an RPD file in online
mode.

See "Using Online and Offline Repository Modes" and "About
MDS XML" for more information.

Multiuser

Provides options to check out projects in a multiuser
development environment and view multiuser development
history.

See Chapter 3, "Setting Up and Using the Multiuser
Development Environment" for more information.

Source Control

Provides options for MDS XML format repositories that are
integrated with your source control management system.

See Chapter 4, "Using a Source Control Management System for
Repository Development” for more information.

Close

Closes the currently open repository. If you have unsaved
changes, you are prompted to save them.

Save

Saves your latest changes.
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Table 2-2 (Cont.) File Menu Options

Menu Option Description
Save As Provides the following options:
= Repository: Opens the Save As dialog so that you can save
the repository in RPD format.
= MDS XML Documents: Opens the Browse For Folder
dialog so that you can specify the root folder location for
MDS XML output.
The new repository remains open in the Administration Tool.
Copy As Provides the following options:
= Repository: Opens the Save Copy As dialog so that you can
copy the repository to a different file in RPD format.
= MDS XML Documents: Opens the Browse For Folder
dialog so that you can specify the root folder location for
MDS XML output.
The current repository, not the new repository, remains open in
the Administration Tool.
Change Password Lets you change the repository password for the currently open

repository.

See "Changing the Repository Password" for more information.

Print Preview

Used with the Physical and Business Model Diagrams. Provides
a preview of how the diagram will look when printed.

Print

Prints the Physical or Business Model Diagram.

Import Metadata

Opens the Import Metadata Wizard.

See the following sections for more information:

= 'Importing Metadata from Relational Data Sources"

= "Importing Metadata from Multidimensional Data Sources"
= "Working with ADF Data Sources"

= "Importing Metadata from XML Data Sources"

Compare

Prompts you to select the repository with which you want to
compare the currently open repository and opens the Compare
repositories dialog.

See "Comparing Repositories" for more information.

Turn off Compare Mode

Turns off any highlighted changed objects. This option is only
available if you have turned on compare mode by choosing
Mark in the Compare repositories dialog.

Merge

Opens the Merge Repository Wizard.

See "Merging Repositories" for more information.

Check Global Consistency

Checks the repository for consistency and opens the
Consistency Check Manager.

See "Checking the Consistency of a Repository or a Business
Model" for more information.

Check Out All Checks out all repository objects. This option is only available in
online mode.

Check In Changes Checks in all repository objects. This option is only available in
online mode.

Undo All Changes Rolls back all changes made since the last check-in. This option

is only available in online mode.
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Table 2-2 (Cont.) File Menu Options

Menu Option Description

Exit Closes the currently open repository and then closes the
Administration Tool. If you have unsaved changes, you are
prompted to save them.

Edit Menu

The Edit menu provides access to the following basic editing functions for repository
objects: Cut, Copy, Paste, Duplicate, and Delete. You can also choose Properties to
view and edit properties for a selected object.

View Menu

The View menu options let you hide or display the panes that show the three layers of
the repository (Presentation, Business Model and Mapping, and Physical). You can
also display the Business Model Diagram and Physical Diagram.

Choose Refresh to refresh the repository view. This feature can be useful in online
mode to reveal changes made by other clients. It can also be used in either online or
offline mode when the repository view has become out of sync and does not display a
recent change or addition. Refreshing the repository view collapses any expanded
objects in the tree panes and helps reduce clutter.

Manage Menu

The Manage menu enables you to access the management functions described in
Table 2-3.

Table 2-3 Manage Menu Options

Menu Option Description

Jobs Opens the Job Manager. The Job Manager is the management interface to
Oracle BI Scheduler. This option is available when a repository is open in
online mode.

See "Using Oracle BI Scheduler Job Manager" in Oracle Fusion Middleware
Scheduling Jobs Guide for Oracle Business Intelligence Enterprise Edition for
more information.

Sessions Opens the Session Manager. In the Session Manager, you can monitor
activity on the system, including the current values of repository and
session variables. This option is available when a repository is open in
online mode.

See "Managing Server Sessions" in Oracle Fusion Middleware Security Guide
for Oracle Business Intelligence Enterprise Edition for more information.

Cache Opens the Cache Manager. The Cache Manager enables you to monitor
and manage the cache. This option is available when a repository is open
in online mode and caching is enabled.

See "Using the Cache Manager" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for
more information about enabling the cache and using the Cache Manager.

Clusters Opens the Cluster Manager. The Cluster Manager monitors and manages
the operations and activities of the cluster. This option is available when
the Oracle BI Cluster Server is installed.

See "Using the Cluster Manager" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for
more information.
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Table 2-3 (Cont.) Manage Menu Options

Menu Option

Description

Identity

Opens the Identity Manager. The Identity Manager provides access to
data access security functions and other identity-related options.

See Chapter 14, "Applying Data Access Security to Repository Objects"
for more information.

Joins

Opens the Joins Manager. The Joins Manager enables you to work with
both physical and logical joins in a list format. The Joins Manager
provides an alternative to working with joins in the Physical and Business
Model Diagrams and shows all join types in one place.

See "Defining Physical Joins with the Joins Manager" and "Defining
Logical Joins with the Joins Manager" for more information.

Variables

Opens the Variable Manager. The Variable Manager enables you to
create, edit, or delete variables and initialization blocks.

See Chapter 19, "Using Variables in the Oracle BI Repository" for more
information.

Projects

Opens the Project Manager. The Project Manager enables you to create,
edit, or remove projects or project elements. Project elements include
subject areas (formerly called presentation catalogs), logical fact tables,
groups, users, variables, and initialization blocks. You use projects during
multiuser development.

See "Setting Up Projects" for more information.

Marketing

Applies to the Oracle Marketing Segmentation product. For information
about using the Marketing options in Oracle Business Intelligence, see
Oracle Marketing Segmentation Guide.

Tools Menu

The Tools menu options enable you to access the functions described in Table 2—4.

Table 2-4 Tools Menu Options

Menu Option

Description

Update All Row Counts Updates row counts in the Physical layer.

See "Displaying and Updating Row Counts for Physical Tables
and Columns" for more information.

Show Consistency Checker | Opens the Consistency Check Manager.

See "Checking the Consistency of a Repository or a Business
Model" for more information.

Query Repository

Opens the Query Repository dialog.

See "Querying and Managing Repository Metadata" for more
information.

Utilities

Opens the Utilities dialog, which lets you select from a list of
Administration Tool utilities.

See "Using Administration Tool Utilities" for more information.

Options

Opens the Options dialog, which lets you customize
Administration Tool display preferences and other options.

See "Setting Administration Tool Options" for more information.

Diagram Menu

The Diagram menu options are available when working with the Physical Diagram or
Business Model Diagram. The options enable you to select elements, create new joins,
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create new tables, and perform other diagram operations. Every toolbar option for the
diagrams has an Diagram menu equivalent.

Window Menu

The Window menu options enable you to cascade or tile open layer windows and
toggle among them.

Help Menu

The Help menu provides the following options:
= Help Topics. Access the Help system for the Administration Tool.

»  Oracle BI on the Web. Access the Oracle Business Intelligence home page on the
Oracle Technology Network (OTN).

s About Oracle BI Administration Tool. Obtain version information about the
Administration Tool.

Using the Physical and Business Model Diagrams

You can use the Physical and Business Model Diagrams in the Administration Tool to
see a graphical view of physical and logical tables and joins. You can choose to view
tables in expanded mode, with columns visible, or in collapsed mode, where only the
name of the table is displayed. This section describes the layout and navigation
capabilities for both diagrams.

After launching the Physical or Business Model Diagram, you can use toolbar options
to zoom, pan, and control the layout of the tables. Table 2-5 describes the available
toolbar options.

Table 2-5 Toolbar Options for the Physical and Business Model Diagrams

Option Name Description
Auto Layout Select this option to revert to an automatically assigned
symmetric table layout. Any customizations you have made to
= the layout (by manually moving individual tables) will be lost.
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Table 2-5 (Cont.) Toolbar Options for the Physical and Business Model Diagrams

Option Name

Description

Expand All

Select this option to show all tables in expanded view, with
columns showing. Tables in expanded view appear like the
following:

= D10 Product

Calurins | Types Lenath | Mulla.., [ &

Brand WARCHAR 25 Falze

Attribute_2 WARCHAR | 30 False

LOB YARCHAR 25 False

Prod_Dsc VARCHAR | 25 False j
— =

Note the following additional features for expanded tables:
s Use the scrollbar to scroll down the full list of columns.
= Click a column heading to sort based on that column.

= Double-click a table in expanded view to launch the
Properties dialog for that object.

»  Click the Collapse icon in the upper right corner to collapse
an individual table object.

= Toresize expanded tables, select a table, mouse over a
handle, and then click and drag the handle.

Collapse All

Select this option to show all tables in collapsed view, with only
the table name showing. Tables in collapsed view appear like
the following:

D10 Product

You can double-click an individual table in collapsed view to
expand only that object.

Marquee Zoom

Select this option to use the Marquee Zoom tool, which lets you
select a particular region to which you want to zoom. To use
Marquee Zoom, left-click, hold, and drag to define a rectangular
region where you want to zoom.

Zoom Out Select this option to cause the diagram view to zoom out one

level.

Zoom In Select this option to cause the diagram view to zoom in one
level.

Fit Select this option to cause the layout to dynamically adjust to
the current diagram window size so that all objects fit in the

window.

Pan Select this option to use the Pan tool, which lets you pan around

the current layout. Left-click, hold, and drag to move the view.

This option is especially useful when the diagram layout
exceeds the available space.
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Table 2-5 (Cont.) Toolbar Options for the Physical and Business Model Diagrams

Option Name Description

Select Select this option to enable the ability to select objects in the
diagram. You can double-click a join or expanded table object to

access the Properties dialog, or you can select a particular table

and drag it to a new location. Note that location information is
not saved after you close the diagram or choose Auto Layout.

You can select multiple objects using the SHIFT or CTRL keys.
Press SHIFT and select multiple objects, or click and drag to
define an area where you want all objects selected. Press CTRL
to individually add or remove particular objects to the selection
set.

New Table Select this option to create a new physical or logical table while
in the diagram view. Left-click the background to launch the
Properties dialog for the new object, and then provide details as
necessary. For physical tables, you first need to select the parent
object under which the new table will be created (such as a
schema, catalog, or database object).

See also the following sections:

= "Creating and Managing Physical Tables and Physical Cube
Tables"

= "Creating Logical Tables"

New Join Select this option to create a new join while in the diagram
view. First, left-click the first table in the join (the table
representing many in the one-to-many join). Then, move the

cursor to the table to which you want to join (the table
representing one in the one-to-many join), and then left-click the
second table to select it. Provide details in the Properties dialog
for the new object as necessary.

Joins in the Physical and Business Model Diagrams are
represented by a line with an arrow at the "one" end of the join.
Note that this display is different from the line with crow's feet
at the "many" end of the join that was used in previous releases.

See also the following sections:

= "Defining Physical Joins with the Physical Diagram"

= "Defining Logical Joins with the Business Model Diagram"

Note the following additional features of the Physical and Business Model Diagrams:

= All toolbar options for the diagram, such as Select, New Table, and New Join, are
also available from the Diagram menu.

= Moving the mouse over a table causes the fully-qualified name for that table to
appear in the status bar.

= You can have both the Physical Diagram and Business Model Diagram windows
open at the same time.

= Any customizations you have made to the layout (by manually moving individual
tables) are lost after you close the diagram or choose Auto Layout.

= You can cause fully-qualified table names to appear in diagrams by setting a
preference in the Options dialog. See "Setting Administration Tool Options" for
more information.

= You can use the Print and Print Preview options on the File menu to manage
printing options for the diagrams. You can also use the Print option on the toolbar.
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See also the following sections for more information about using the Physical and
Business Model Diagrams:

"Physical Diagram and Business Model Diagram Keyboard Shortcuts"
"Working with the Physical Diagram"
"Working with the Business Model Diagram"

Editing, Deleting, and Reordering Objects in the Repository

This section provides information about editing, deleting, and reordering objects.

To edit objects, double-click an object, or right-click an object and select
Properties. Then, complete the fields in the dialog that is displayed. In some
dialogs, you can click Edit to open the appropriate dialog.

To delete objects, select one or more objects and click Delete, or press the delete
key. You can also right-click an object and select Delete.

To reorder objects, drag and drop an object to a new location. Note the following;:
— Reordering is only possible for certain objects and in certain dialogs.

- Insome dialogs, you can use an up or down arrow to move objects to a new
location.

- Inthe Administration Tool main window, you can drag and drop an object
onto its parent to duplicate the object. For top-level objects like business
models and subject areas, drag and drop the object onto white space to
duplicate it.

About Naming Requirements for Repository Objects

All repository object names must follow these requirements:

Names cannot be longer than 128 characters
Names cannot contain leading or trailing spaces

Names cannot contain single quotes, question marks, or asterisks

Note that repository object names can include multibyte characters.

Using the Browse Dialog to Browse for Objects

The Browse dialog appears in many situations in the Administration Tool. You use it to
find and select an object.

The Browse dialog is accessible from several dialogs that let you make a selection from
among existing objects.

The left pane of the Browse dialog lets you browse the tree view for a particular object.
It contains the following parts:

A tree listing all of the objects in the Presentation layer, Business Model and
Mapping layer, or the Physical layer of a repository.

Tabs at the bottom of the left pane let you select a layer. Some tabs might not
appear if objects from those layers are not appropriate for the task you are
performing.

The right pane of the Browse dialog lets you search for the object you want. It contains
the following parts:
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= Query enables you to query objects in the repository by name and type. The Name
field accepts an asterisk (*) as the wildcard character, so you can query for partial
matches.

s The Show Qualified Names option lets you identify to which parents an object
belongs.

= View lets you view properties of a selected object in read-only mode.

Note that in general, the left pane and the right pane of the Browse dialog are not
connected. Rather, the panes provide alternate methods to locate the object you want.

The exception to this is the Synchronize Contents feature, which lets you synchronize
an object from the query results list with the tree view. This feature is a helpful
contextual tool that locates a particular object in the tree view.

Table 2-6 lists and describes the tasks you can perform in the Browse dialog.

Table 2-6 Tasks You Can Perform in the Browse Dialog

Task Description

Querying for an object Follow these steps to query for an object:
1. Select the object type from the Type list.

2. Type the name of the object, or a part of the name and the
wildcard character (*), in the Name field. For example:

- To search for logical tables that have names beginning
with the letter Q, select Logical Tables from the Type list,
and then type Q* in the Name field.

- To search for logical tables that have names ending with
the letters dim, type *dim in the name field.

3. Click Query.

Relevant objects appear in the query results list.

Selecting an object Use the tree view in the left pane or the filtered view in the right
pane to locate the object you want, then double-click the object.

The Browse dialog closes, and the object is displayed in the
previous dialog.

Synchronizing an object in | Select an object in the Query list and then click the Synchronize
the query results list with Contents button.

the tree view The object you selected is highlighted in the tree view in the left

pane.

Finding multiple Select an object in the tree view, such as a logical column, then
occurrences of an objectin | click the down arrow button.

the tree view The next occurrence of that object is highlighted in the tree

view.

Changing Icons for Repository Objects

In the Administration Tool, you can change the icon that represents a particular object
in the repository. Changing the icon for a particular object does not have any
functional effect, and is not visible in Answers or other clients. This feature is intended
as a useful way to visually distinguish objects for the convenience of repository
developers.

For example:

= You can use a special icon for objects that are in the Business Model and Mapping
layer, but not the Presentation layer, for easier maintenance of the repository.
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= You can mark objects that are logical calculations with a separate icon.

= You can choose an icon to visually distinguish tables in the Presentation layer that
appear as nested folders in Answers.

= You can use an icon to denote objects in a logical table that pertain to a specific
functional area, or that are sourced from a particular logical table source.

You can only change the icon for individual objects. You cannot globally change the
icon for all objects of a particular type.

To change the icon for a particular repository object:

1. In the Administration Tool, right-click an object in the Physical, Business Model
and Mapping, or Presentation layer (for example, a particular logical table).

2. Select Set Icon.

3. In the Select Icon dialog, select the icon you want to use for that object and click
OK.

Sorting Objects in the Administration Tool

Many dialogs in the Administration Tool show lists of objects, such as a list of physical
columns in the Physical Table dialog, a list of logical levels for Preferred Drill Path in
the Logical Level dialog, and a list of presentation hierarchies in the Presentation Table
dialog.

You can click the header to sort the objects in ascending or descending order. An up
arrow or down arrow icon is displayed next to the header name, indicating how the
list has been sorted.

Each list also has a default order that is persisted from session to session. The default
order appears when you view a list in a dialog for the first time each session. The
default order is displayed when there is no ascending or descending arrow icon in the
header. Click the header three times to toggle between ascending, descending, and
default order. In some cases, the default order is the ascending or descending order.

Some dialogs provide the capability to move items up or down in a list. In these
dialogs, if you click Up or Down while the list is sorted in ascending or descending
order, the selected item moves, and the resulting order becomes the new default order.
Note that clicking the header eliminates any manually determined order.

About Features and Options for Oracle Marketing Segmentation

Some features and options in the Administration Tool are for use by organizations that
have the Oracle Marketing Segmentation product. For information about these
features and options, see Oracle Marketing Segmentation Guide.

Note that additional information about Oracle Marketing Segmentation features is
provided in the Presentation Services Help.

About the Oracle Bl Server Command-Line Utilities

You can use a variety of command-line utilities with the Oracle BI Server to make
programmatic changes to your repository file, run sample queries, delete unwanted
repository objects, and perform other tasks.

Table 2—-7 describes the Oracle BI Server command-line utilities.
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Table 2-7 Oracle Bl Server Command-Line Utilities

Utility Name Description Where to Go for More Information
biserverextender Used to import flex object changes from "Automatically Mapping Flex Object
ADF data sources and map them to the Changes Using the biserverextender
Business Model and Mapping layer and Utility"
Presentation layer.
XML utilities Primarily used to leverage the Oracle BI Oracle Fusion Middleware XML Schema
(biserverxmlgen, Server XML API for metadata migration, | Reference for Oracle Business Intelligence
biserverxmlexec, programmatic metadata generation and Enterprise Edition
biserverxmlcli) manipulation, metadata patching, and
other functions.
The XML utilities include:
= biserverxmlgen: generates XML from
an existing RPD file. Also includes an
option to generate repositories in
MDS XML format.
s biserverxmlexec: executes the XML in
offline mode to create or modify a
repository file. Also includes an
option to execute XML in MDS XML
format.
s biserverxmlcli: executes the XML
against the Oracle BI Server.
comparerpd Used to compare two repositories and "Comparing Repositories Using
generate a CSV diff file, an XML patch comparerpd”
file, or an MDS XML diff.
equalizerpds Used to equalize objects in two "Equalizing Objects"
repositories that have the same name, but
different upgrade IDs. Running this utility
before merging repositories prevents
unintended renaming during the merge.
extractprojects Used to extract projects from a given "Using the extractprojects Utility to
repository. Extract Projects"
nqlogviewer Used to view the query log. Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business
Intelligence Enterprise Edition
mhlconverter Used to convert MUD history files from "Checking In New Versions of the
.mhl format to .xml format so that they MUD Master and MUD Log File to
can be checked in under source control. Source Control"
ngemd Used to run test queries against the "Using nqemd to Test and Refine the
repository. Connects using an Oracle BI Repository”
Server ODBC DSN.
patchrpd Used to apply an XML patch file. This "Using patchrpd to Apply a Patch”

utility is especially useful for patching
repository files on Linux or UNIX
systems.

Before You Begin 2-17




About Options in Fusion Middleware Control and NQSConfig.INI

Table 2-7 (Cont.) Oracle Bl Server Command-Line Utilities

Utility Name Description Where to Go for More Information

prunerpd Used to delete unwanted repository "Deleting Unwanted Objects from the
objects from your repository file, such as | Repository”

databases, tables, columns, initialization
blocks, and variables.

sametaexport Used to generate the information "Exchanging Metadata with Databases
necessary for the Oracle Database SQL to Enhance Query Performance"
Access Advisor or IBM DB2 Cube Views
tool to preaggregate relational data and
improve query performance.

validaterpd Used to check the consistency of a "Using the validaterpd Utility to Check
repository. Repository Consistency”

Running bi-init to Launch a Shell Window Initialized to Your Oracle Instance

Before running any of the Oracle BI Server command-line utilities, you must first run
bi-init to launch a command prompt or shell window that is initialized to your Oracle
instance. Then, run the appropriate command-line tool from the resulting shell
window with the desired options.

This utility is called bi-init.sh on Linux and UNIX systems, bi-init.bat on client
installations of the Administration Tool, and bi-init.cond for all other Windows
installation types.

For example, on Windows:
1. In Windows Explorer, go to the location appropriate for your install type:
s Client installations:

ORACLE_HOME/bifoundation/server/bin

s All other installations:
ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup
2. Double-click bi-init.cmd (or bi-init.bat for client installations) to display a
command prompt that is initialized to your Oracle instance.

3. At the command prompt, type the name of the command-line utility you want to
run with the desired options. For example, to run extractprojects, enter the
following:

extractprojects -B base_repository name -0 output_repository_name {-I input_
project_name} [-P repository password] [-L]

Note: For client installations, you can also launch bi-init by choosing
the appropriate option under Start > Programs > Oracle Business
Intelligence Enterprise Edition Plus Client.

About Options in Fusion Middleware Control and NQSConfig.INI

Many configuration settings that affect the Administration Tool and repository
development are managed in either Fusion Middleware Control, or the
NQSConfig.INI configuration file. Repository developers must be familiar with Fusion
Middleware Control and NQSConfig.INI configuration settings to effectively work
with the Administration Tool and with their repositories.
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Some of the most common configuration settings that affect repository development
include:

= Repository File: This option is set in Fusion Middleware Control. It controls the
current published repository.

= Disallow RPD Updates: This option is set in Fusion Middleware Control. It
controls whether the Administration Tool opens in read-only mode, in both offline
and online mode.

= LOCALE: This option is set in NQSConfig.INL It specifies the locale in which data
is returned from the server and determines the localized names of days and
months.

= DATE_TIME_DISPLAY FORMAT, DATE _DISPLAY FORMAT, TIME_
DISPLAY_FORMAT: These options are set in NQSConfig.INI. They control the
display of date/time formats.

s  DEFAULT_PRIVILEGES: This option is set in NQSConfig.INI. It determines the
default privilege (NONE or READ) granted to users and application roles for
repository objects without explicit permissions set.

See Oracle Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition for full information about Fusion Middleware Control and
NQSConfig.INI configuration settings.

About the SampleApp.rpd Demonstration Repository

Oracle Business Intelligence provides a sample repository called SampleApp.rpd that
provides best practices for modeling many different types of objects described in this
guide.

A basic version of SampleApp.rpd, called SampleAppLite.rpd, is automatically
installed as the default repository when you install Oracle BI Enterprise Edition.
SampleAppLite.rpd is located in the following directory:

ORACLE_INSTANCE\bifoundation\OracleBIServerComponent\coreapplication_
obisn\repository

The full version of SampleApp.rpd contains many additional examples and features.
This version can be found on the Oracle Technology Network at:

http://oracle.com/technetwork/middleware/bi-foundation/obiee-sam
ples-167534.html

The default password for SampleAppLite.rpd is Admin123. For security reasons, you
must immediately change this default password the first time you open
SampleAppLite.rpd in the Administration Tool. See "Changing the Repository
Password" for more information.

Using Online and Offline Repository Modes

You can open a repository for editing in either online or offline mode. The tasks you
can perform depend on the mode in which you opened the repository.

To open a repository, you must enter the repository password. This password is
specific to each repository and is used to encrypt the repository.

This section contains the following topics:

= Editing Repositories in Offline Mode
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Using Online and Offline Repository Modes

= Editing Repositories in Online Mode
s Checking Out Objects

s Checking In Changes

= About Read-Only Mode

Editing Repositories in Offline Mode

Use offline mode to view and modify a repository while it is not loaded into the Oracle
BI Server. If you attempt to open a repository in offline mode while it is loaded into
the Oracle BI Server, the repository opens in read-only mode. Only one
Administration Tool session at a time can edit a repository in offline mode. See "About
Read-Only Mode" for more information.

You do not need to enter a user name and password to open a repository in offline
mode. You only need to enter the repository password.

This section contains the following topics:
= Opening Repositories in Offline Mode
= Publishing Offline Changes

Opening Repositories in Offline Mode

Follow these steps to open an RPD-format repository in offline mode:

1. In the Administration Tool, select File > Open > Offline.

2. Go to the repository you want to open, and then select Open.

3. In the Open Offline dialog, enter the repository password, and then click OK.

If the server is running and the repository you are trying to open is loaded, the
repository opens in read-only mode. If you want to edit the repository while it is
loaded, you must open it in online mode. Also, if you open a repository in offline
mode and then start the server, the repository becomes available to users. Any
changes you make become available only when the server is restarted.

When you open an RPD-format repository in the Administration Tool in offline mode,
the title bar displays the name of the open repository (for example, SampleAppLite).

You can also open MDS XML format repositories in offline mode, as follows:
1. In the Administration Tool, select File > Open > MDS XML.
2. Select the root folder location for your MDS XML files and click OK.

3. If this is the first time you have opened this MDS XML repository in the
Administration Tool, you are prompted to specify whether this repository is a
standalone MDS XML repository, or whether it is under source control. Select the
appropriate option and click OK.

When you open an MDS XML format repository in the Administration Tool, the title
bar displays the format and root folder location (for example, MDS XML C:\Root_
Folder).

Publishing Offline Changes

Follow these steps to publish changes made to your repository in offline mode:

1. Upload the repository using Fusion Middleware Control. See "Configuring
Repositories" in Oracle Fusion Middleware System Administrator’s Guide for Oracle
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Business Intelligence Enterprise Edition for more information about how to perform
this task.

You cannot upload MDS XML format repositories. To publish changes made to
MDS XML repositories, you must first convert the repository to RPD format.

2. Restart all Oracle BI Server instances. You do not need to restart other Bl system
components.

3. In Presentation Services, click the Reload Files and Metadata link from the
Administration page.

Editing Repositories in Online Mode

Use online mode to view and modify a repository while it is loaded into the Oracle BI
Server. The Oracle BI Server must be running to open a repository in online mode.
There are certain things you can do in online mode that you cannot do in offline mode.
In online mode, you can perform the following tasks:

= Manage scheduled jobs

= Manage user sessions

= Manage the query cache

= Manage clustered servers

= Use the Oracle BI Summary Advisor (Oracle Exalytics Machine deployments only)
This section contains the following topics:

= Opening Repositories in Online Mode

s Publishing Online Changes

s Guidelines for Using Online Mode

Opening Repositories in Online Mode
Follow these steps to open a repository in online mode:

1. In the Administration Tool, select File > Open > Online to display the Open
Online Repository dialog.

The Oracle BI Server DSNs that have been configured on your computer are
displayed in the dialog. If no additional DSNs have been configured for this
version of the Oracle BI Server, you might see only the default DSN that is
configured for you during installation.

See "Integrating Other Clients with Oracle Business Intelligence" in Oracle Fusion
Middleware Integrator’s Guide for Oracle Business Intelligence Enterprise Edition for
information about how to create an ODBC DSN for the Oracle BI Server.

2. Enter the repository password for the repository currently loaded in the Oracle BI
Server.

You can use Repository tab of the Deployment page in Fusion Middleware
Control to view the name of the current repository.

3. Provide a valid user name and password.

The user you provide must have the ManageRepositories permission. See Oracle
Fusion Middleware Security Guide for Oracle Business Intelligence Enterprise Edition for
more information.
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4. If you expect to work extensively with the repository (for example, you plan to
check out many objects), select the Load all objects on startup option. This loads
all objects immediately, rather than as selected. The initial connect time might
increase slightly, but opening items in the tree and checking out items is faster.

5. Select the appropriate DSN and click OK.

When you open a repository in the Administration Tool in online mode, the title bar
displays the DSN for the Oracle BI Server to which you are connected, not the name of
the current repository.

Publishing Online Changes

Changes made using the Administration Tool in online mode are available
immediately for a single-node deployment.

In a clustered deployment, changes are published to the repository publishing
directory, specified on the Repository tab of the Deployment page in Fusion
Middleware Control. The master Oracle BI Server consumes these changes
automatically, but you must restart all slave Oracle Bl Servers for them to get the latest
changes, and then reload metadata in Presentation Services by clicking the Reload
Files and Metadata link from the Administration page.

You can restart the slave Oracle BI Servers using the RollingRestart ODBC procedure,
or you can restart the slave servers using Fusion Middleware Control:

= To use the RollingRestart ODBC procedure, enter the following in nqcmd:
call RollingRestart (timeout) ;
where timeout is the number of seconds to wait for each slave Oracle BI Server to
restart before moving on to the next one.
For example:

call RollingRestart(300);

In this example, the system waits five minutes for each Oracle BI Server to restart.
If the given Oracle BI Server restarts sooner, the system moves on to the next one
immediately.

See "Using nqcmd to Test and Refine the Repository” for more information about
using nqcmd.

Note: you must run the RollingRestart procedure directly against the
master Oracle Bl Server. Because the DSN created upon install for
each Oracle BI Server is clustered by default, you must manually
create a non-clustered DSN for the master Oracle BI Server to run the
procedure against.

See "Integrating Other Clients with Oracle Business Intelligence" in
Oracle Fusion Middleware Integrator’s Guide for Oracle Business
Intelligence Enterprise Edition for information about how to create an
ODBC DSN for the Oracle BI Server.

In addition, RollingRestart will not work if automatic restart of
components has been disabled in OPMN. See Oracle Fusion Middleware
Oracle Process Manager and Notification Server Administrator’s Guide for
more information.
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= To restart the slave servers using Fusion Middleware Control, first use the Cluster
Manager in the Administration Tool in online mode to determine which Oracle BI
Server is the master, and which are the slaves. Then, use the Process tab of the
Availability page Fusion Middleware Control to restart the slave Oracle BI
Servers. See "Using Fusion Middleware Control to Start and Stop Oracle Business
Intelligence System Components and Java Components" in Oracle Fusion
Middleware System Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition for more information.

It is a best practice to avoid making other configuration changes in Fusion Middleware
Control or the configuration files when using the RollingRestart ODBC procedure or
when restarting the slave Oracle BI Servers in Fusion Middleware Control. Because
only the slave servers are restarted, a situation might result where the master Oracle BI
Server has a different set of configuration settings loaded than the slave Oracle BI
Servers. If this occurs, restart the master Oracle BI Server.

Guidelines for Using Online Mode

Use online mode only for small changes that do not require running consistency
checks. Running consistency checks against the full online repository can take a long
time. Instead, make more complex changes that require consistency checks in offline
mode against a project extract of the repository.

Table 2-8 provides guidelines for when to perform online and offline edits.

Table 2-8 Guidelines for Online and Offline Repository Edits

Mode Use This Mode For... Example Use Cases
Online s Changes that do not require = Renaming Presentation layer
running a consistency check metadata
= Small changes that are required to |s  Reorganizing Presentation layer
fix things in a running system metadata
= Changes that need to be deployed
quickly
Offline = Full-scale development or = Customizing existing fact or
customization activities that dimension tables

require running consistency checks

multiple times and iterating = Addingnew fact or dimension

tables

In addition, you should limit the number of concurrent online users. The best practice
is to have only one user working in online mode at a time. Even when users have
different objects checked out, there might be dependencies between the objects that
can cause conflicts when the changes are checked in. In general, only one user should
make online changes in a single business model at a time.

If you must have multiple concurrent users in online mode, do not have more than
five users. For situations where you need more than five users, use the multiuser
development environment. See Chapter 3, "Setting Up and Using the Multiuser
Development Environment" for more information.

Even with a single user making changes, be aware that online mode is riskier than
offline mode because you are working against a running server. If you check in
changes that are not consistent, it might cause the Oracle BI Server to shut down.
When you work in online mode, make sure to have a backup of the latest repository so
that you can revert to it if needed. You can also use File > Undo All Changes to roll
back all changes made since the last check-in.
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Checking Out Objects

When you are working in a repository open in online mode, you are prompted to
check out objects when you attempt to perform various operations. Select the objects
you want to check out and click Yes to check out the objects.

If you are performing a task in a wizard, the Checkout screen displays a summary of
the objects that need to be checked out to complete the operation. Click Next to check
out the objects and complete the task.

Checking In Changes

When you are working in a repository open in online mode, you are prompted to
perform a consistency check before checking in the changes you make to a repository.

If you have made changes to a repository and then attempt to close the repository
without first checking in your changes, a dialog opens automatically asking you to
select an action to take. If you move an object from beneath its parent and then attempt
to delete the parent, you are prompted to check in changes before the delete is allowed
to proceed.

Use the Check in Changes dialog to make changes available immediately for use by
other applications. Applications that query the Oracle BI Server after you have
checked in the changes will recognize them immediately. Applications that are
currently querying the server will recognize the changes the next time they access any
items that have changed.

To make changes available and have them saved to disk immediately:
s In the Administration Tool, select File, then select Check In Changes.

If the Administration Tool detects an invalid change, a message is displayed to alert
you to the nature of the problem. Correct the problem and perform the check-in again.
Note that you can select a message row and click Go To, or double-click a message
row, to go directly to the affected object.

You must save changes to persist the changes to disk. You must check in changes
before you can save, but you do not need to save to check in changes.

About Read-Only Mode

Only one component (either the Oracle BI Server, or a single Administration Tool
client in offline mode) can have a repository open in read /write mode at a time. If a
second component opens a repository that is already in use, the repository is opened
in read-only mode.

For example, assume the Oracle BI Server loads a repository in read/write mode. Any
number of Administration Tool clients connecting to that repository in online mode
will also get read /write mode, because they are accessing the repository through the
Oracle BI Server. However, Administration Tool clients opening that repository in
offline mode will get read-only mode, because the repository is already open for
read/write through the Oracle BI Server.

Alternatively, assume an Administration Tool client opens a repository offline in
read/write mode. When the Oracle BI Server starts, it will get read-only mode, as will
any Administration Tool clients connecting to that repository in either offline or online
modes. To enable the server to load the repository in read /write mode in this
situation, you must first close the Administration Tool client that has the repository
locked, and then restart the Oracle BI Server.
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The Administration Tool also opens a repository in read-only mode when Oracle
Business Intelligence has been clustered, and the Administration Tool is connected in
online mode to a slave server. This occurs because the Master BI Server holds a lock on
the repository. To avoid this situation when running in a clustered environment,
ensure that the Oracle BI Server ODBC DSN used by the Administration Tool has been
configured to point to the Cluster Controllers rather than to a particular Oracle BI
Server.

In addition, the Administration Tool opens repositories in read-only mode when the
configuration setting Disallow RPD Updates has been selected in Fusion Middleware
Control. See "Using Fusion Middleware Control to Disallow RPD Updates" in Oracle
Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition for more information about this configuration setting.

Checking the Consistency of a Repository or a Business Model

Repository metadata must pass a consistency check before you can make the
repository available for queries. The Consistency Check Manager lets you enable and
disable rules for consistency checks, find and fix inconsistent objects, and limit the
consistency check to specific objects. You can also use the validaterpd utility to check
the validity of all metadata objects.

Note: A separate tool, Model Check Manager, identifies modeling
problems that will affect Oracle Bl Summary Advisor and aggregate
persistence performance and results. Run Model Check Manager
before running Oracle BI Summary Advisor or the Aggregate
Persistence Wizard. See "Using Model Check Manager to Check for
Modeling Problems" for more information.

This section contains the following topics:

= About the Consistency Check Manager

»  Checking the Consistency of Repository Objects

= Using the validaterpd Utility to Check Repository Consistency

s Common Consistency Check Messages

About the Consistency Check Manager

The Consistency Check Manager checks the validity of your repository to ensure that
it can load at run time, and to identify any syntax or semantic errors that may cause
queries to fail.

In addition, running a consistency check might result in updates to your repository
metadata. For example, invalid objects are deleted during Consistency Checks. This
behavior might result in deleted expressions and filters on logical table sources and
logical columns. Invalid references can occur when objects were deleted in the
Physical layer without properly accounting for the references in the Business Model
and Mapping layer objects.

Each time you save the repository, a dialog asks if you want to check global
consistency. You have the following options:

= Yes. Checks global consistency and then saves the repository file.

= No. Does not check global consistency and then saves the repository file.
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s Cancel. Does not check global consistency and does not save the repository file.

The Consistency Check Manager does not check the validity of objects outside the
metadata using the connection. It only checks the consistency of the metadata and not
any mapping to the physical objects outside the metadata. If the connection is not
working or objects have been deleted in the database, the Consistency Check Manager
does not report these errors.

The one exception to this rule is that the Consistency Check Manager does identify
application roles that have been defined in the Administration Tool, but that have not
yet been added to the policy store. Messages about placeholder application roles only
appear when you perform a consistency check in online mode. Because of this, the set
of consistency check messages returned for your repository might be different,
depending on whether you have opened the repository in offline or online mode.

If you use lookup tables to store translated field names with multilingual schemas,
note that consistency checking rules are relaxed for the lookup tables. See "Localizing
Oracle Business Intelligence" in Oracle Fusion Middleware System Administrator’s Guide
for Oracle Business Intelligence Enterprise Edition for more information about localization
and lookup tables.

The consistency checker returns the following types of messages:

= Errors. These messages describe errors that need to be fixed. Use the information
in the message to correct the inconsistency, then run the consistency checker again.
The following is an example of an error message:

[38082] Type of Hierarchy '"ORT C41"..."ORT_C41/MDF_BW_QO02"."Product Hierarchy
for Material MARA"' in Cube Table '"ORT_C41"..."ORT_C41/MDF_BW_Q02"' needs to
be set.

If you disable an object and it is inconsistent, a message is displayed, asking if you
want to make the object unavailable for queries.

= Warnings. These messages indicate conditions that may or may not be errors. For
example, you might receive a warning message about a disabled join that was
intentionally disabled to eliminate a circular join condition. Other messages may
warn of inconsistent values, or feature table changes that do not match the
defaults. The following is an example of a warning message:

[39024] Dimension '"Paint"."MarketDim"' has defined inconsistent values in its
levels' property 'Number of elements'.

In the Consistency Check Manager, you can sort the rows of messages by clicking the
column headings. Additionally, the status bar provides a summary of all the rows
displayed.

Note: After upgrading from a previous software version and
checking the consistency of your repository, you might notice
messages that you had not received in previous consistency checks.
This typically indicates inconsistencies that had been undetected
before the upgrade, not new errors.

Checking the Consistency of Repository Objects

You can use the Administration Tool to check consistency in the following ways:

=  To check consistency for all objects in the repository, select File, then select Check
Global Consistency.
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To check the consistency of a particular repository object, such as a physical
database, business model, or subject area, right-click the object and select Check
Consistency.

If you already have the Consistency Check Manager open, you can check global
consistency by clicking Check All Objects.

To view the Consistency Check Manager without performing a global consistency
check, select Tools, then select Show Consistency Checker. If you have checked
consistency in the current session, the messages from the last check appear in the
Messages pane.

To check the consistency of a repository:

1.

6.

In the Administration Tool, select File, then select Check Global Consistency. The
Consistency Check Manager is displayed, listing any messages relating to the
current repository.

Note: If you disable an object and it is inconsistent, a dialog appears,
asking whether you want to make the object unavailable for queries.

To edit the repository to correct inconsistencies, double-click a row to open the
properties dialog for that object, or select a row and click Go To. Then, correct the
inconsistency and click OK.

To save the messages in text, CSV, or XML format, click Save As.

To copy the messages so that you can paste them in another file such as a
spreadsheet, select one or more rows and click Copy. Note that clicking Copy
without any rows selected copies all messages.

To check consistency again, click Check All Objects to perform a global check. Or
click the Refresh button in the top right corner to check only the objects that were
listed as inconsistent in the last check.

When finished, click Close.

To check the consistency of a single object in a repository:

1.

In the Administration Tool, right-click an object, then select Check Consistency.
If the object is not consistent, a list of messages appears.

To edit the repository to correct inconsistencies, double-click any cell in a row to
open the properties dialog for that object. Then, correct the inconsistency and click
OK.

To save the messages in text, CSV, or XML format, click Save As.

To copy the messages so that you can paste them in another file such as a
spreadsheet, click Copy.

To check consistency of the object again, click the refresh button at the top right
corner of the dialog.

If you click Check All Objects, all objects in the repository are checked.

Using the validaterpd Utility to Check Repository Consistency

You can use the Oracle BI Server utility validaterpd to check the validity of all
metadata objects in a repository. Running this utility performs the same validation
checks as the Consistency Check Manager in the Administration Tool.
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The validaterpd utility is available on both Windows and UNIX systems. However,
you can only use validaterpd with binary repositories in RPD format.

Before running validaterpd, you must first run bi-init to launch a command prompt
that is properly initialized. See "Running bi-init to Launch a Shell Window Initialized
to Your Oracle Instance" for more information.

Syntax

The validaterpd utility takes the following parameters:

validaterpd -R repository name -0 output_file name [-P repository_password] [-8]

Where:
repository_nameis the name and path of the repository that you want to validate.

output_file name is the name and path of a text file where the validation results will
be recorded.

repository_passwordis the password for the repository that you want to validate.

Note that the repository_password argument is optional. If you do not provide the
password argument, you are prompted to enter the password when you run the
command. To minimize the risk of security breaches, Oracle recommends that you do
not provide password arguments either on the command line or in scripts. Note that
the password argument is supported for backward compatibility only, and will be
removed in a future release.

-8 specifies UTF-8 encoding in the output file.

Example

The following example generates an output file called results.txt that contains
validation information for the repository called repository.rpd:

validaterpd -R repository.rpd -0 results.txt
Give password: my_rpd_password

Note: Be sure to provide the full pathnames to your repository files,
both the input file and the output file, if they are located in a different
directory.

Common Consistency Check Messages

Table 2-9 provides information about some commonly seen consistency check
warnings and errors. Note that Table 2-9 provides a partial list only and does not
show all possible warnings and errors.
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Table 2-9 Common Consistency Check Messages

Validation Rule Example Type Description
[14031] The content filter of a Error The given logical table has a logical table source with a
source for logical table: FACT_ WHERE clause filter that references multiple dimensions. A
TABLE_NAME references WHERE clause with multiple dimensions is invalid.
multiple dimensions.
[38126] 'Logical Table' Error Identifies an object with leading or trailing spaces in the
""Technology - WFA"."Fact WFA object name.
:/;;Ci)lin hzs :CaeI(IS with leading or Repository objects can no longer have leading or trailing
&P ’ spaces in their names. Leading and trailing spaces in object
names can cause query and reporting issues.
[38012] Logical column DIM_ Error Logical columns that are not mapped to any logical table
Start_Date.YEAR_QUARTER_ source are reported as consistency errors, because the
NBR does not have a physical data logical table source mappings are invalid and would cause
type mapping, nor is it a derived queries to fail.
column. Both of the given validation rules are related to the same
[38001] Logical column DIM_ issue.
Start_Date.YEAR_QUARTER_
NBR has no physical data source
mapping.
[39062] Initialization Block Warning Indicates that the same connection pool is being used for
'Authorization' uses Connection both queries and for initialization blocks. This configuration
Pool "My_DB". is not recommended. Instead, create a dedicated connection
"My_CP" which is used for report pqol for initialization bl(?cks. .Otherw1se{ query Rerfqrmance
- . . might suffer, or user logins might hang if authorization
queries. This may impact query TR
initialization blocks cannot run.
performance.
[39028] The features in Database Warning Some database feature defaults were changed in this release
'MyDB' do not match the defaults. of Oracle BI EE. Unless you have specific customizations to
This can cause query problems. your feature set, it is recommended that you reset your
database features to the new defaults.
[39003] Missing functional Warning This warning indicates that the given column is only
dependency association for mapped to logical table sources that are disabled. The
column: DIM_Offer_End_ warning brings this issue to the repository developer's
Date.CREATE_DT. attention in case the default behavior is not desired.
[39059] Logical dimension table Warning Even though this fact logical table source has an aggregate

MY_DIM has a source MY_DIM_
DAILY at level Daily that joins to a
higher level fact source MY_
FACT_SUM.MTHLY_SUM

grain set in this dimension, no join was found that connects
to any logical table source in this dimension (or a
potentially invalid join was found).

This means that either no join exists at all, or it does exist
but is potentially invalid because it connects a higher-level
fact source to a lower-level dimensional source. Such joins
are potentially invalid because if followed, they might lead
to double counting in query answers.

For example, consider Select year, yearlySales. Even if a join
exists between monthTable and yearlySales table on yearld,
it should not be used because such a join would overstate
the results by a factor of 12 (the number of months in each
year).

If you get a 39059 warning after upgrading, verify that the
join is as intended and does not result in incorrect double
counting. If the join is as intended, then ignore the 39059
warning.
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Table 2-9 (Cont.) Common Consistency Check Messages

Validation Rule Example Type Description

[39055] Fact table "HR"."FACT - Warning This warning indicates that there is a physical join between

HC Budget" is not joined to tables the given fact and dimension sources, but there is not a

in logical dimension "HR"."DIM - corresponding logical join between the fact table and the

HR EmployeeDim". This will cause dimension table.

problems when extracting

project(s).

[39054] Fact table "Sales - Warning This warning indicates that the aggregation content filter

STAR"."Fact - STAR Statistics" is "Group by Level" in the logical table source of a fact table

not joined to logical dimension references logical dimension tables that are not joined to

table "Sales - STAR"."Dim - Plan". that fact table. If that fact table is extracted in the

This will cause problems when extract/ MUD process, the dimensions that are not joined

extracting project(s). will not be extracted. In this case, the aggregation content of
the extracted logical table source would not be the same as
in the original logical table source.

[39057] There are physical tables Warning This warning indicates that the given logical table source

mapped in Logical Table Source
""HR"."Dim - Schedule"."SCH_
DEFN" that are not used in any
column mappings or expressions.

has irrelevant tables added that are not used in any
mapping. This situation will not cause any errors.
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Setting Up and Using the Multiuser
Development Environment

This chapter explains how to set up and use the multiuser development environment
in Oracle Business Intelligence, including defining projects, setting up the multiuser
development directory, checking out and publishing changes to projects, and merging
metadata.

Multiuser development (MUD) provides a mechanism for concurrent development on
overlapping code bases. Oracle Business Intelligence provides a MUD environment
that manages subsets of metadata, in addition to multiple users, by providing a
built-in versioning system for repository development.

See also the following resources:

= "Managing the Repository Lifecycle in a Multiuser Development Environment" for
additional information about working in a multiuser development environment

»  Chapter 4, "Using a Source Control Management System for Repository
Development" for information about saving your repository in MDS XML format
and integrating the Administration Tool with a third-party source control
management system

This chapter contains the following topics:

= About the Multiuser Development Environment

s Setting Up Projects

s Setting Up the Multiuser Development Directory

= Making Changes in a Multiuser Development Environment

s Publishing Changes to Multiuser Development Repository Projects
s Branching in Multiuser Development

= Viewing and Deleting History for Multiuser Development

= Setting Multiuser Development Options

About the Multiuser Development Environment

In Oracle Business Intelligence, multiuser development facilitates the development of
application metadata in enterprise-scale deployments. Application metadata is stored
in a centralized metadata repository (RPD) file. The Administration Tool is used to
work with these repositories. You do not use a multiuser development environment
with MDS XML-format repositories.
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The following are examples of how you might use a multiuser development
environment:

= Several developers work concurrently on subsets of the metadata and then merge
these subsets back into a master repository without their work conflicting with
other developers. For example, after completing an implementation of data
warehousing at a company, an administrator might want to deploy Oracle
Business Intelligence to other functional areas.

Note: In this chapter, "master repository" refers to the copy of a
repository in the multiuser development directory

= A single developer manages all development. For simplicity and performance, this
developer might want to use the multiuser development environment to maintain
metadata code in smaller chunks instead of in a large repository.

In both examples, an administrator creates projects in the repository file in the
Administration Tool, then copies this repository file to a shared network directory
(called the multiuser development directory). Developers are able to check out
projects, make changes and then merge the changes into the master repository. When
developers check out projects using the Administration Tool, files are automatically
copied and overwritten in the background. Therefore, it is important for the
administrator to perform setup tasks and for the developers to perform check-out and
merge/publish procedures carefully, paying close attention to the Administration Tool
messages that appear.

When developers check out projects, repository files are not automatically copied or
overwritten. Instead, the Administration Tool creates two new files when projects are
checked out: one to hold the original project data, and one to hold the project changes.

For example, when a repository developer checks out project A from master.rpd in the
C:\multiuser development directory, the Administration Tool extracts all metadata
related to project A and prompts the developer for a new file name to save the data.
When the developer chooses a new file name, for example Mychanges.rpd, the
Administration Tool creates two new files:

= A file called MyChanges.rpd that will contain the changes made by the developer
= A file called originalMyChanges.rpd that contains the original project data

The originalMyChanges.rpd file helps determine what changes have been made by the
developer in Mychanges.rpd. This information is needed during the multiuser
development merge process.

Note: To reduce storage needs, repositories in Oracle Business
Intelligence Enterprise Edition 11g Release 1 (11.1.1) are stored in a
compressed format. Because of this, you might notice that the size of
an RPD file opened and saved in this release is significantly smaller
than the size of RPD files from previous releases.

About the Multiuser Development Process

Multiuser development presupposes a clear understanding of customer technical and
business objectives. It also requires that you follow clearly defined development
processes and adhere rigorously to those processes, including consistent merging and
reconciliation practices.
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The following procedure shows the general steps to follow when deploying a
multiuser development environment. The first three steps are usually performed by an
administrator, and the remaining steps are usually performed by one or more
developers.

To deploy a multiuser development environment:

1. Define projects to organize voluminous metadata into manageable components.
See "Creating Projects" for more information. Consider these tips:

s Use smaller RPDs to shorten and simplify development effort and unit testing.

= Organize development resources by projects to spread workload and reduce
inconsistencies and overwrites.

Set up a shared network directory to use as the multiuser development directory.
Copy the master repository to the multiuser development directory.

Extract one or more projects for local development.

o ©Dbd

Merge repository objects and resolve conflicts.

= Because metadata objects are often highly interrelated, several developers
could be working on the same objects.

= You can perform regular subset refreshes to merge your local changes with the
latest version of the master. When configuration conflicts occur during the
merge process, developers are prompted for the correct process.

6. Publish changes to the network.

= A final subset refresh (merge) is performed during the publishing step. Many
developers can simultaneously work on the same objects, but only one can
publish at a time. The repository is locked during the publishing step.

7. Use Logging and Backup features to identify points of erroneous or incorrect
configuration.

s The log file tracks multi-development activity, along with comments.

s The master repository and developer repositories are automatically backed up
for future reference and for use in manual rollback.

Setting Up Projects

Projects are the central enabler of metadata management. A project consists of a
discretely-defined subset of the repository metadata, in the form of groups of logical
stars with associated metadata. A project has the following characteristics:

= Islargely defined by logical fact tables in the applicable business model

= Automatically adds related logical dimension tables and other metadata during
extract

= Can have one to many logical fact tables

For projects that are just beginning, the best practice is to begin with a repository
containing all the necessary physical table and join definitions. In this repository, you
create a logical fact table as a placeholder in the Business Model and Mapping layer
and a subject area as a placeholder in the Presentation layer. As you add business
model and subject area metadata, new projects based on individual subject areas and
logical facts can be created.

Follow these guidelines when setting up projects:
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= Only one person at a time can create projects in a master repository.
= Do not delete projects unless they are no longer under active development.

= Choose your project name carefully when creating a project. Do not rename
projects.

= Use care when removing objects from projects to avoid problems with repository
extract/check-out.

This section contains the following topics:
= About Projects
s Creating Projects

= About Converting Older Projects During Repository Upgrade

About Projects

Projects can consist of Presentation layer subject areas and their associated business
model logical facts, dimensions, groups, users, variables, and initialization blocks.
Administrators can create projects so that developers and groups of developers can
work on projects in their area of responsibility.

The primary reason to create projects is to support multiuser development. During the
development process, you can split up the work (metadata) between different teams
within your company by extracting the metadata into projects so that each project
group can access a different part of the metadata.

In addition to multiuser development, you may want to create projects for licensing
reasons. Before releasing a new software version, you may want to ensure that only
the metadata that is relevant to the licensed application is in a project and that
everything is consistent and complete. You can accomplish this by adding only the fact
tables that are relevant to the application.

Project extractions are fact table centric. This ensures that project extracts are
consistent and makes licensing much easier to manage.

About the Project Dialog

In the Project dialog, the left pane contains objects that you can use to create a project.
The objects in the right pane are all the objects you chose (directly or indirectly) that
reflect the complete set of data that makes each addition consistent. For example, if
you select a subject area from the top node of the left-hand tree to add to your project,
underlying fact tables of other subject areas are automatically added if needed to make
the extract consistent.

The following describes the left pane of the Project dialog;:

= You can choose to group fact tables by Business Model or Subject Area, to help
select the fact tables you want. Typically, grouping fact tables according to which
ones are used by a particular subject area is a more convenient way to choose fact
tables for your project. Note that a fact table can be associated with multiple
subject areas, but belongs to one and only one business model.

Although it appears that you can add a subject area from the top node when you
group facts by subject area, you are actually adding only the underlying fact
tables. The subject areas only appear as choices to help you to add the elements
you want in your project. Additionally, it adds any other objects that are necessary
to make the extract consistent. To add an actual subject area, use the Presentation
node at the bottom of the tree.
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= When grouped by business model, the left pane displays only facts that belong to
the business model.

= The Presentation node contains presentation layer objects. You must explicitly
include these objects in your project if you want to work with them; they are not
added automatically.

If you add presentation objects that are not related to any fact tables in the project,
a warning appears when you click OK. The consistency checker also notes this
discrepancy.

The right pane of the Project dialog shows the objects you select to be extracted, such
as fact tables (under the Business Models folder), Presentation layer objects (under the
Presentation folder), users, application roles, variables, and initialization blocks. These
objects are extracted when you click OK.

Figure 3-1 shows the Project dialog.

Figure 3—1 Project Dialog with Fact Tables Grouped by Business Model
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Creating Projects

When creating a project, you typically select a subject area or a subset of logical fact
tables related to the selected subject area, and the Administration Tool automatically
adds any business model and Physical layer objects that are related. An object can be
part of multiple projects. Alternatively, if you choose to group facts by business
model, you can select a particular business model or a set of logical fact tables that are
part of a business model. You also need to explicitly add any Presentation layer objects
if you want them to be part of your project.

Note that although the project definition itself does not include Physical layer objects,
these objects are extracted and determined through the project definition.

After you create projects, they become part of the metadata and are available to
multiple developers who need to perform development tasks on the same master
repository. When defined this way, projects typically become a consistent repository
after a developer checks out the projects and saves them as a new repository file.
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To create a project for a multiuser development environment:

1.
2.

10.

In the Administration Tool, choose File > Open > Offline.

In the Open dialog, select the repository that you want to make available for
multiuser development, then click OK. Provide the repository password, then
click OK again.

Select Manage, then select Projects.

In the Project Manager dialog, in the right pane, right-click and then select New
Project.

The left pane contains the objects that are available to be placed in a project. The
right pane contains the objects that you select to be part of the project.

In the Project dialog, type a name for the project.

Choose whether to group facts by business model, or subject area. It is typically
more convenient to group facts by subject area.

Perform one or more of the following steps to add fact tables to your project:

— In the left pane, select a subject area or business model and then click Add.
The Administration Tool automatically adds all the associated logical fact
tables.

— In the left pane, expand the subject areas or business models and select one or
more logical fact tables that are related to the subject area or that are within
the business model, then click Add.

The project is defined as explicitly containing the selected logical fact tables
and implicitly containing all logical dimension tables that are joined to the
selected logical fact tables (even though they do not appear in the right pane).

See "About the Project Dialog" for more information about the objects that appear
in the left and right panes.

To remove fact tables from the project, in the right pane, select a fact table and
click Remove. You can also remove all fact tables associated with a subject area or
business model by selecting a subject area or business model and clicking
Remove.

Optionally, add any application roles, users, variables, initialization blocks, or
lookup tables needed for the project. Although objects like variables and
initialization blocks that are directly referenced by other extracted objects are
included automatically, you might want to include objects in your project that are
not referenced. For example:

= If you are using initialization blocks for authentication, include any necessary
initialization blocks.

= Include repository variables or other objects that are not yet referenced by
other objects, but that you might want to use in future repository
development.

s Include users and application roles that are currently being used, or will be
used in the future, as part of your data access security settings.

Tip: You may want to add the top node for each object type (for example,
Variables), then selectively remove individual objects from the right pane.

Select the Presentation layer objects that you want to include in your project from
the left pane and click Add. You must add these objects to see them in the project;
they are not added automatically.
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You can also remove particular presentation tables or columns from the project
definition by double-clicking the object in the right pane, or selecting the object
and clicking Remove.

Note: If you do not see the set of subject areas you expect after the
project is created, edit the project to explicitly add the subject areas
you need.

11. Click OK.

About Converting Older Projects During Repository Upgrade

When you upgrade a repository from Oracle Business Intelligence versions before
10.1.3.2, the project definition is upgraded. During the upgrade, the project definition,
subject areas, target levels, list catalogs, and existing fact tables are automatically
converted into simple fact tables in the following way:

= Get presentation columns related to the target levels through the qualifying keys.
= Get presentation columns related to the list catalogs through the qualifying keys.
= Get presentation columns related to the subject areas.

= Get all the logical columns from all the presentation columns.

= Get all the logical columns from the fact tables in the project.

= Get the fact tables from all the logical columns.

After the upgrade, projects contain only simple fact tables. All the security objects
remain unchanged.

In addition, projects in repositories from any version before 11g Release 1 (11.1.1) are
upgraded so that they explicitly contain Presentation layer objects. In previous
releases, Presentation layer objects were implicitly included based on the permissions
of the users included in the project.

Setting Up the Multiuser Development Directory
To prepare for multiuser development, an administrator performs the following tasks:

= Identify or create a shared network directory that will be dedicated to multiuser
development.

= After creating all projects, copy the repository file in which you created the
projects to the multiuser development directory where it will be used as your
master repository for multiuser development.

After the administrator has identified the multiuser development directory and copied
the repository file, developers must set up to the Administration Tool to point to the
multiuser development directory before they can check out projects.

This section contains the following topics:

s Identifying the Multiuser Development Directory

= Copying the Master Repository to the Multiuser Development Directory
»  Setting Up a Pointer to the Multiuser Development Directory
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Identifying the Multiuser Development Directory

After defining all projects, the administrator must identify or create a shared network
directory (called the multiuser development directory) that all developers can access,
and then upload the new master repository to that location. This shared network
directory should be used only for multiuser development. This directory typically
contains copies of repositories that need to be maintained by multiple developers. The
multiuser development directory must be on a Windows system.

Developers create a pointer to the multiuser development directory when they set up
the Administration Tool on their computers.

Caution: The administrator must set up a separate, shared network
directory that is dedicated to multiuser development. If not set up and
used as specified, critical repository files can be unintentionally
overwritten and repository data can be lost.

Copying the Master Repository to the Multiuser Development Directory

After the multiuser development directory is identified, the administrator must copy
the master repository file to the multiuser development directory. Projects from this
master repository will be extracted and downloaded by the developers who will make
changes and then merge these changes back into the master repository.

After you copy the repository to the multiuser development network directory, notify
developers that the multiuser development environment is ready:.

Even after starting repository development, it might be necessary to make manual
changes to the master repository from time to time. See "Manually Updating the
Master MUD Repository" for specific instructions on how to do this.

Setting Up a Pointer to the Multiuser Development Directory

Before checking out projects, each developer must set up their Administration Tool to
point to the multiuser development directory on the network. The Administration Tool
uses this location when the developer checks out and checks in objects in the multiuser
development directory.

Note: Unitil the pointer is set up, the multiuser options are not
available in the Administration Tool.

Initially, the network directory contains the master repositories. The repositories in
this location are shared with other developers. Later, the network directory contains
additional multiuser development history files, including historical subsets and
repository versions. Do not manually delete any files in the multiuser development
directory; these files are important and are used by the system.

When setting up the pointer, the developer can also complete the Full Name field.
Although the field is optional, it is recommended that the developer complete this
field to allow other developers to know who has locked the repository.

To set up a pointer to the multiuser development directory:
1. From the Administration Tool menu, choose Tools > Options.

2. In the Options dialog, click the Multiuser tab.
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3. In the Multiuser tab, for Multiuser development directory, enter the full path to
the network directory.

Alternatively, click Browse, select the multiuser development directory, and then
click OK.

4. In the Full Name field, type your complete name, then click OK.

Making Changes in a Multiuser Development Environment

During check-out, refresh, and publish, a copy of the master repository is temporarily
copied to the developer's local repository directory (typically, ORACLE_
INSTANCE\bifoundation\OracleBIServerComponent\coreapplication_
obisn\repository by default). After checking out projects and making changes in a
local repository file, each developer can publish (merge) changes into the master
repository or discard the changes.

To make changes in a multiuser development environment, perform the tasks
described in the following sections:

s Checking Out Repository Projects
= About Changing and Testing Metadata
= Refreshing Your Local Project Extract

= About Multiuser Development Menu Options

Checking Out Repository Projects

After setting up a pointer to the multiuser development default directory, a developer
can check out projects, change metadata, and test the metadata. In the File > Multiuser
submenu, the Checkout option is only available when there is a multiuser
development directory defined in the Multiuser tab of the Options dialog.

This section contains the following topics:

= About Repository Project Checkout

»  Checking Out Projects

= Using the extractprojects Utility to Extract Projects

About Repository Project Checkout

During checkout, the Administration Tool performs the following tasks:

s In the developer's local repository directory, the Administration Tool makes a
temporary copy of the master repository.

Note: If a repository with that name exists in this location, the
developer is asked to confirm overwriting the existing repository. If
the developer clicks Yes, the existing local repository is immediately
overwritten in the background and after the new repository is saved,
the temporary master repository file is automatically deleted.

= In the developer's local repository directory, the Administration Tool saves a local
copy of the selected projects in a new repository, such as Metadatal.rpd. The
developer provides a name for the local copy. The developer makes metadata
changes in this file. The number is incremented for each checkout for that session.
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= Inthe developer's local repository directory, the Administration Tool saves a
second local copy of the new repository, adding 'original’ as the prefix (for
example, originalMetadatal.rpd).

= After the developer saves the new repository file, check out is complete. In the
developer's local repository directory, the temporary copy of the master repository
is automatically deleted.

Caution: When the developer selects and saves the projects to a local
repository file, the Administration Tool does not place a lock on the
projects in the master repository on the shared network drive.
Therefore, nothing physically prevents others from working on the
same project. To determine if a project has been checked out, you need
to look in the log file in the multiuser development directory on the
shared network drive.

Checking Out Projects

This section explains how to check out projects using the Administration Tool.
To check out projects:
1. From the Administration Tool menu, choose File > Multiuser > Checkout.

2. If there is more than one repository in the multiuser development directory, the
Multiuser Development Checkout dialog appears. Select the appropriate
repository, and then click OK.

This dialog does not appear if there is only one repository in the multiuser
development directory.

3. In the Extract from dialog, type the repository password, and then click OK.

If no projects exist in the repository, a message appears and the repository does
not open.

4. If there is more than one project in the master repository, the Browse dialog
appears. Select the projects that you want to be part of your project extract, and
then click OK.

Figure 3-2 shows the Browse dialog for selecting projects.

Figure 3-2 Browse Dialog for Selecting Projects
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If only one project exists in the master repository, it is selected automatically and
the Browse dialog does not appear.

5. In the Create new subset repository dialog, type a name for the new repository
(for example, Metadatal.rpd) and then click Save.

A working project extract repository is saved on your local computer. The name is
exactly as you specified and is opened in offline mode. A log file is also created.

Caution: A second copy of the project extract repository is saved in
the same location. The name of this version contains the word
"original" added to the beginning of the name that you assigned to the
repository extract. Do not change the original project extract
repository. It is used during the multiuser development merge
process, and when you want to compare your changes to the original
projects.

Using the extractprojects Utility to Extract Projects

You can use the Oracle BI Server utility extractprojects to extract projects from a given
repository without the overhead of the MUD environment. The extractprojects utility
is available on both Windows and UNIX systems. You can only use extractprojects
with binary repositories in RPD format.

The extractprojects utility generates an RPD file that includes the set of projects you
specify. The utility does not perform other tasks that are performed when you check
out projects using the Administration Tool, like saving an original repository file or

tracking the extract as a check-out in the MUD directory.

Before running extractprojects, you must first run bi-init to launch a command prompt
that is properly initialized. See "Running bi-init to Launch a Shell Window Initialized
to Your Oracle Instance" for more information.

Syntax

The extractprojects utility takes the following parameters:

extractprojects -B base_repository name -0 output_repository_name {-I input_
project_name} [-P repository_password] [-L]

Where:

base_repository_name is the name and path of the repository from which you want to
extract projects.

output_repository_name is the name and path of the repository generated by the
utility.

input_project_name is the name of a project you want to extract. You can enter
multiple projects. Be sure to precede each project entry with -I (for example, -I projectl
-1 project2). If the project name contains spaces, enclose it in double quotes (for
example, "project 1").

repository_passwordis the password for the repository from which you want to
extract projects.

Note that the repository_password argument is optional. If you do not provide the
password argument, you are prompted to enter the password when you run the
command. To minimize the risk of security breaches, Oracle recommends that you do
not provide password arguments either on the command line or in scripts. Note that
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the password argument is supported for backward compatibility only, and will be
removed in a future release.

- L enables logging. When logging is enabled, a log file in the format
ProjExtr.YYYYMMDD.HHMMSS.xml is created in the Oracle BI Server logging
directory. For example:

ORACLE_INSTANCE/diagnostics/logs/OracleBIServerComponent/coreapplication_
obisn/ProjExtr.20100616.082904.xml
Example

The following example extracts projectl and project2 from my_repos.rpd and creates a
new repository called extract_repos.rpd:

extractprojects -B my_repos.rpd -0 extract_repos.rpd -I projectl -I project2
Give password: my_rpd_password

Note: Be sure to provide the full pathnames to your repository files,
both the input file and the output file, if they are located in a different
directory.

About Changing and Testing Metadata

Most types of changes that can be made to standard repository files are also supported
for local repository files. Developers can add new logical columns, logical tables,
change table definitions, logical table sources, and so on. Developers may also work
simultaneously on the same project locally. It is important to note, however, that
Oracle Business Intelligence assumes the individual developer understands the
implications these changes might have on the master repository. For example, if a
developer deletes an object in a local repository, this change is propagated to the
master repository when local changes are merged without a warning prompt.

To ensure metadata integrity, you should not remove a physical column unless there
are no logical table source mappings to that physical column. Because of this, if you
are using a multiuser development environment, you cannot delete a logical column
and its associated physical column at the same time. Instead, you must first delete the
logical column and perform a merge. Then, you can delete the physical column and
perform another merge to safely remove the object.

Changes to physical connection settings are not propagated to the master repository
upon merge and publish. This ensures that developers can apply settings for their
local test data sources to perform unit testing of their model changes without
impacting other developers.

In addition to physical connection settings, security settings and database feature table
changes are not retained in a multiuser development merge to prevent developers
from overwriting passwords and other important objects in the master repository.

After making changes to a local repository, the developer upload the repository using
Fusion Middleware Control and test the edited metadata.

Note: DSNs specified in the metadata must exist on the developer's
workstation.
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Refreshing Your Local Project Extract

You can use the Refresh Subset option to refresh your local project extract with any
changes made to the master repository. This option also merges your latest changes
with the local project extract. Perform this task as an incremental step during
development before publishing your final changes at the end of your development
session.

It is a best practice to refresh your local project extract frequently so that conflicts
during merge can be identified and dealt with on an incremental basis. If too many
changes are merged at one time, making the appropriate merge decisions for conflicts
can be confusing and error-prone.

About Multiuser Development Menu Options

After the local developer makes changes, tests the changes, and saves the repository
locally, the local developer can perform the following tasks from the File > Multiuser
submenu:

s Compare with Original. Compares the working extracted local repository to the
original extracted repository. When this option is selected, the Compare
repositories dialog opens and lists all the changes made to the working extracted
repository since you checked out the projects.

= Refresh Subset. Refreshes your local project extract with any changes made to the
master repository. The changes from the master are merged with your local
changes.

If changes have been made to the master repository, the old project extract file
(originalfilename.rpd) is replaced with a new project extract file called
currentfilename.rpd.

s Publish to Network. Publishes changes made to your local project extract to the
master repository. A lock is acquired to lock the master repository during the
publish step. Publishing your changes automatically performs a Refresh Subset
operation to merge your local changes with any additional changes from the
master. Then, the merged changes are published to the master repository, the lock
is released, and the local repository is closed.

= Undo Publishing. Used when mandatory consistency checks are enforced during
the publishing step, and errors occur. When you are notified of consistency check
errors during publishing, you can choose to fix the errors immediately, as part of
the publishing step. The master repository is locked during this process. If you
need to release the lock on the master and fix the changes later, select Undo
Publishing to release the lock and return to your latest subset extract repository.

s Discard Local Changes. Any time after check out and before publishing, you can
discard your changes. When you select this option, the working repository closes
without giving you an opportunity to save your work.

Caution: If you select this option, there is no opportunity to change
your mind. For example, no confirmation dialog appears.

Publishing Changes to Multiuser Development Repository Projects

After changing and testing the metadata on a local computer, the developer must
publish local changes to the master repository in the multiuser development directory.
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The Oracle Bl repository development process uses a three-way merge to manage
concurrent development. Metadata merges are done first on local environments and
then merged with the master repository. A three-way merge identifies local changes
based on the following repository characteristics:

s The Master RPD
»  The Baseline RPD or Master RPD snapshot at time of project extraction
s The current locally developed and changed RPD

Changes are managed by merge and reconciliation. Most of the merging process is
automatic, and changes do not conflict. In case of any conflicting metadata sources,
developers can locate and resolve them.

An administrator can also merge the changes from multiple repositories manually, or
import objects from different repositories outside of a particular MUD environment.

Make sure to merge your changes frequently. The merge process is very complex and
can become difficult if there are too many changes. See Appendix D, "Merge Rules" for
more information about how objects are merged during the merge process.

It is a best practice to refresh your subset repository regularly to identify conflicts
early. Refreshing your subset performs a subset remerge with the latest version of the
master, then leaves the repository open for you to continue making changes until you
are ready to publish.

This section contains the following topics:

= About the Multiuser Development Merge Process

= Publishing to the Network

= Enforcing Consistent Repositories When Publishing Changes

About the Multiuser Development Merge Process

The merge process involves the following files:

= Local (subset) repository, either original or current (refreshed). The local subset
repository can be one of the following:

— If no subset refresh has been performed, contains the state of the projects as
originally extracted. This repository name begins with "original" (for example,
originalDevelopment2.rpd).

— If a subset refresh has been performed, contains the state of the projects since
the last merge that occurred during the subset refresh. The repository name
begins with "current” (for example, currentDevelopment2.rpd).

= Modified local (subset) repository. Contains the extracted projects after being
modified by the developer. This version is stored in the same location as the
original or current version of the local subset repository.

s Latest master repository. The latest master is copied locally for the merge, then
published to the multiuser development directory after the merge. Note that this
file may have been modified by other developers before this merge.

During the merge, the Administration Tool checks for added objects and if found, a
warning message appears. The following list describes what happens during this step:

= Warning about added objects. When a person checks out a project, they have the
ability to modify that project in any way and check it back in. Deletions and
modifications are ways in which the integrity of the project is maintained.
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However, adding objects might introduce objects into the repository that do not
belong to any project. Therefore, all project related objects are checked and if a
new object is found, a warning message appears.

Caution: You must add newly created metadata to the project
definition in the master repository for it to be visible in future
extracted versions of the project. For example, if a developer checks
out a project, adds a new object, and then checks it in, the new object
is not visible in extracted versions of the project until it is explicitly
added to the project definition. See "Creating Projects” for instructions.

= Aggregation of related objects. In the warning message, only the parent object is
reported. The Administration Tool aggregates all the objects to make the message
more usable. For example, if a developer added a new business model, only the
business model appears in the warning message to the user, not the tables,
columns, dimensions, and so on.

When a developer publishes changes to the network, the following actions occur:

s The master repository in the multiuser development directory is overwritten with
the repository containing the developer's changes.

»  The master_repository.Ick file is deleted. If another developer checks out the
changed project from the master repository, the changes made by the first
developer are exposed to the other developer.

How are Multiuser Merges Different from Standard Repository Merges?

The multiuser development publishing process uses the same technology as the
standard repository merge process with a few important differences. For example, for
MUD merges, you typically do not want to retain changes to security settings and data
sources, to prevent developers from overwriting passwords and other important
objects in the master repository. Because of this, changes to security settings and data
source connections are not retained when you perform a MUD merge. In addition,
inserts (created objects) are applied automatically.

See "Merge Rules and Behavior for Multiuser Development Merges" for full details.

Publishing to the Network

When the publishing process begins, the Administration Tool automatically copies the
current version of the master repository from the multiuser development directory to
the local repository directory on the developer's computer (typically ORACLE_
INSTANCE\Dbifoundation\OracleBIServerComponent\coreapplication_
obisn\repository) and updates the log files in the local and multiuser development
directories. This is necessary because the master repository in the multiuser
development directory might have changed after the developer checked out the
projects, or since the last subset refresh.
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Note: In previous releases, objects that were part of the master
repository, but that did not belong to a currently checked-out project,
could be added between the merge and publish steps, because the
entire repository was locked until publishing was complete. Now that
the merge and publish steps are combined in a single Publish to
Network step, you must explicitly check out a project that contains the
desired object to add it to your currently open project.

For example, suppose that you want to add fact table "A" that is part
of project "Other Project” to your own project, "My Project.” To do this,
you must check out both "Other Project” and "My Project," as
described in the "Checking Out Projects” section. Then, add Fact Table
"A" to "My Project" and publish the changes to the network. The next
time you check out "My Project", the fact table will be part of the
repository subset.

To publish local changes to the master repository:

1. In the Administration Tool, select File > Multiuser > Publish to Network, then
click Yes if prompted to save changes.

2. In the Lock Information dialog, in the Comment field, type a description of the
changes that you made, then click OK.

Figure 3-3 shows the Lock Information dialog.

Figure 3-3 Lock Information Dialog
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3. If there are any conflicts, the Merge Repository Wizard opens and displays the
Define Merge Strategy screen. Make merge decisions about whether to include or
exclude objects by choosing Current or Modified from the Decision list. When
you select an object in the decision table, the read-only text box below the decision
table describes what changes were made to that object in the current repository.
You can also click View Change Statistics to see a summary of changes. Click
Finish when you are finished making merge decisions.

See "Performing Full Repository Merges" for additional information about the
Define Merge Strategy screen.
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A lack of conflicts does not mean that there are no differences between the
repositories. Instead, it means that there are no decisions that have to be explicitly
made by the developer to publish changes. See "How are Multiuser Merges
Different from Standard Repository Merges?" for information about conflicts that
are resolved automatically in a MUD merge.

In both cases, a CSV file is created in the local directory that contains details of the
merged changes.

4. After you confirm all the changes, click Save.

The master repository in the multiuser development directory is overwritten with
the copy of the repository containing the developer's changes.

Enforcing Consistent Repositories When Publishing Changes

You can enforce a mandatory consistency check during the Publish to Network step by
setting the Mandatory Consistency Check option to Yes in the multiuser development

options file. See "Setting Multiuser Development Options" for more information about
the options file.

When this option is set to Yes, the Consistency Checker will run as part of the
publishing process. Publishing cannot proceed unless there are no errors in the given
repository.

If consistency errors occur, a message is displayed. Choose one of the following

options:

= Yes: Select this option to fix the consistency check errors immediately. The master
repository remains locked during this process.

If you select this option and then change your mind (such as when you need to
release the lock on the master, or when fixing the changes is more complex than
you anticipated), select File > Multiuser > Undo Publishing. This option unlocks
the master repository and returns you to your latest subset repository (as an
extract from the currently merged master repository).

= No: Select this option to cancel the publishing step and fix the consistency check
errors later. The master repository is unlocked, and you are returned to your latest
subset extract repository.

Branching in Multiuser Development

Branching is a further refinement of the merging development process. Branching can
provide higher efficiencies over large development teams that have overlapping
releases, but it requires significant administrative overhead.

This section contains the following topics:
s About Branching
s Using the Multi-Team, Multi-Release Model in Oracle Business Intelligence

= Synchronizing RPD Branches

About Branching

In branching, developers work on private branches to isolate their code from other
developers and merge changes back to the main branch. Different strategies can be
followed, depending on the size of the development team.
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In the Simple Development Model, all development occurs on a single main branch.
This strategy has the following characteristics:

= Only for emergency fixes
s Checkouts may not be most current code
s Carries a stability risk for the mainline branch

Figure 3—4 shows the Simple Development Model.

Figure 3—-4 Simple Development Model
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Shows the Simple Development Model branching strategy used in multiuser
development. A single main release branch appears, with small quick fixes branching
off of it that are then merged back into the main branch.
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In the Small Team Development Model, development occurs on a single Dev branch,
with a separate Main branch strictly for releases. This strategy has the following
characteristics:

s The Mainline is the official release branch

= Development occurs on a separate branch

= Stable code is merged back to Main at key milestones
= Branches are synchronized periodically

Figure 3-5 shows the Small Team Development Model.

Figure 3-5 Small Team Development Model
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Shows the Small Team Development Model branching strategy used in multiuser
development. A main release branch appears, with small quick fixes branching off of it
that are then merged back into the main branch. A second Dev branch appears parallel
to the main branch, with changes merged in to the mainline periodically.
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In the Multi-Team, Multi-Release Model, development occurs on multiple Dev
branches, again with a separate Main branch strictly for releases. This strategy has the
following characteristics:

= Supports more efficiency over disparate teams

= Development occurs on separate branches

= Stable code is merged back to Main at key milestones
= Branches are synchronized periodically

Figure 3-6 shows the Multi-Team, Multi-Release Model.

Figure 3-6 Multi-Team, Multi-Release Model
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Shows the Multi-Team, Multi-Release Model branching strategy used in multiuser
development. A main release branch appears, with small quick fixes branching off of it
that are then merged back into the main branch. A second and third Dev branch
appears parallel to the main branch, with changes merged in to the mainline
periodically.
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Using the Multi-Team, Multi-Release Model in Oracle Business Intelligence

Using complex branching strategies in Oracle Business Intelligence requires attentive
organization of repository files, as well as altering the Multiuser setting in the
Administration Tool. The following procedure provides an overview of the required
steps.

To use the multi-team, multi-release model branching strategy:

1. Create a Main repository (Master Repository) and store it in the Master multiuser
development directory.

»  Projects must be explicitly defined.

= Branch developers should not have access to the Master directory.
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2. Create a subset of branch repositories by extracting from Main and storing them as
the Team1 and Team?2 multiuser development directories. The Main and Team
RPDs must be stored and secured in separate directories on the network.

3. Developers must check out, develop, merge, and publish from their respective
Team RPDs. Developers Al through A3 and Bl through B3 should manage their
metadata work and merge to their Team repository.

s Teams 1 and 2 must maintain their own repositories and periodically
synchronize from Main to Team branches.

s The Team repositories must be merged back into and published in the Main
repository.

4. One specific group (for example, release management) should manage all project
definitions, perform merges, publish, and synchronize the Team RPDs back to
Main.

Synchronizing RPD Branches

For large development teams, it is a good practice to perform periodic branch
synchronization as Main changes, in order to ease the ultimate Team publishing step.
Use the Administration Tool to synchronize repositories in a three-way merge.

To synchronize repository branches:

1. Publish all changes from your Team development branch and open the RPD in the
Administration Tool. This the current repository.

2. Extract a fresh Branch subset from Main. This is the modified repository.

3. Inthe Administration Tool, select File, then select Merge and browse to the
backup of the previous Branch subset. This is the original repository.

4. Resolve all issues and perform the merge.

The RPD named in the Save merged repository as field becomes the new branch
development RPD and is called the Original in future synchronizations.

Viewing and Deleting History for Multiuser Development

You can view and delete the development history of a multiuser development
repository.

This section contains the following topics:
s Viewing Multiuser Development History

s Deleting Multiuser Development History

Viewing Multiuser Development History

You can view the development history of a multiuser development repository. In the
Administration Tool, multiuser development history is only available when no
repository is open and after the administrator sets up the shared network directory.
This prevents the confusion that could occur if a user opened a history log that did not
match an open, unrelated repository.

To view multiuser development history:
1. Open the Administration Tool.

2. Without opening a repository, select File > Multiuser > History.
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3. Inthe Multiuser Development History dialog, select a repository.

A list of all master repositories in the multiuser development directory appears. If
directory contains only one master repository, it is selected by default, and no list
appears.

4. In the Open Offline dialog, type the password for the repository. The Multi User
History dialog appears.

Figure 3-7 shows the Multi User History dialog.

Figure 3—7 Multi User History Dialog
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5. Inthe Multi User History dialog, right-click a row and select an option. Table 3-1
describes the options in the Multi User History dialog.

Tip: To see details for all revisions, right-click in the background with no rows
selected and select View > Details.

Table 3-1 Options in the Multi User History Dialog

Action Description

View > Repository Loads the selected master version of the repository in the
Administration Tool in read-only mode.

View > Prior to Merge > Loads the selected version of a modified subset repository in the

Projects Administration Tool in read-only mode.

View > Conflict Resolution | Loads all necessary repositories of the selected version. Also
shows the Merge dialog in read-only mode with all selected
decisions as they were during the Merge Local Changes activity
at that time. Double-clicking a row for a version with conflict
resolutions has the same effect as selecting this menu item.

Note: This menu item is only enabled for versions that had
conflict resolutions.

View > Details Displays a log with details for the selected versions, or displays
details for all versions if no specific versions are selected.

View > Prior to Merge > Compares modified subset repository of the selected version

Changes with original subset repository and shows all changes made by
the user in the selected version.

Find and Find Again Lets you search the list.

Select All Selects all items displayed in the dialog.

Delete Available only to multiuser development administrators.
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Deleting Multiuser Development History

Only multiuser development administrators can delete history. Administrators are
defined in a special hidden option file in the multiuser development directory. See
"Setting Multiuser Development Options" for more information.

An administrator can delete the entire MUD history, or the oldest 1 to n versions. It is
not possible to delete versions in the middle of the range. For example, an
administrator cannot delete version 3 if there are still versions 1 and 2. If an
administrator deletes the entire MUD history, newly assigned version numbers restart
at version 1.

If an administrator deletes a MUD history version from which a developer has
checked out a subset, and the developer is still working on it, the developer will not be
able to publish to the MUD directory. As a result, deleting all MUD history prevents
any developer who has currently checked out a subset from publishing it. Because of
this, administrators should communicate with developers before the MUD history is
cleared.

Setting Multiuser Development Options

You can create a multiuser development option file to specify options for multiuser
development. The option file is a text file, in standard Windows INI format. It has the
following properties and characteristics:

= The option file must be placed in the multiuser development directory. The file
has the same name as the corresponding master repository, but with an .opt
extension. For example, for \ \network\MUD\sales.rpd, create an option file
called \\network\MUD\sales.opt.

»  The file should have the Hidden flag turned on.

= In general, the option file should be managed only by multiuser development
administrators. To ensure this, you may want to change the sharing permissions
for the file.

The following example shows a multiuser development option file:

[Options]

BuildNumber = Yes

Admin = adminl;admin2

Mandatory Consistency Check = Yes
Equalize During Merge = Yes

Options that are not explicitly set are turned off by default. To turn an option on, set
its value to Yes. To turn an option off, either remove it from the option file, or set its
value to No.

Table 3-2 explains the options in the multiuser development option file.

Table 3-2 Options in the Multiuser Development Option File

Option Description

BuildNumber When set to Yes, the build version of the Administration Tool is
displayed in the MUD history.
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Table 3-2 (Cont.) Options in the Multiuser Development Option File

Option

Description

Admin

Lists multiuser development administrators. Administrators
must be defined in the option file before they can delete MUD
history.

Administrators are defined by their computer/network login
names. When multiple administrators exist, separate
administrator names by semicolons. For example:

Admin=jsmith;mramirez;plafleur

Mandatory Consistency
Check

When set to Yes, the publish step performs a consistency check.
Publishing cannot proceed unless there are no errors in the
given repository.

Equalize During Merge

When set to Yes, the multiuser development merge process
performs mandatory equalization during MUD merges. Note
that setting this option to Yes affects the performance of the
merge process.

Setting Up and Using the Multiuser Development Environment
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4

Using a Source Control Management System
for Repository Development

This chapter describes how to integrate the Oracle BI Administration Tool with
third-party source control management systems for Oracle Bl repository development.

The Administration Tool achieves this integration through the ability to save
repository metadata as a set of XML documents in MDS XML format rather than as a
single binary repository file (RPD). Using this integration, you can configure the
Administration Tool to work with your own source control management system and
save your repository output as MDS XML.

This chapter contains the following topics:
= About Using a Source Control Management System with the Administration Tool

s Setting Up Your System for Repository Development Under Source Control
Management

= Using Source Control Management in Day to Day Repository Development

= Using Source Control Management with MUD

About Using a Source Control Management System with the
Administration Tool

You can choose to integrate the Administration Tool with a third-party source control
management system, such as Subversion or Rational ClearCase, during your
repository development process. This feature is centered around the following
integration points:

= Converting your binary RPD file to a set of MDS XML documents. Rather than
using a single large binary repository file, you can save your repository in MDS
XML format. In this format, each repository object, such as a connection pool,
physical table, or business model, is represented in its own XML file. The set of
XML files that make up your repository can then be managed in your source
control management system.

= Setting up a software configuration management (SCM) configuration file. You
can use the SCM Configuration Editor in the Administration Tool to specify
commands specific to your SCM system, such as Add File, Delete, and Check Out,
as well as environment variables required by your SCM system.

= Designating your repository as under source control. The first time you open
your MDS XML repository in the Administration Tool, you are prompted to
specify whether the repository is a standalone MDS XML repository, or whether it
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is under source control. Choose Use Source Control to enable SCM integration for
this repository in the Administration Tool.

About MDS XML

MDS XML format is typically used for repositories under source control. MDS XML is
not the same XML format that was used in previous releases to represent the Oracle BI
repository in XML format. The previous Oracle BI Server XML schema, based on the
xudmll.xsd XML schema file in ORACLE_HOME /bifoundation/server/bin,
represents the Oracle Bl repository in one large XML file. MDS XML, in contrast,
represents the Oracle Bl repository across a set of XML files, rather than in a single file.

For example, each repository connection pool is stored in its own file, with an XML
representation like the following:

<?xml version="1.0" encoding="UTF-8" ?>

<ConnectionPool mdsid="m80ca62c5-0bd5-0000-714b-e31400000000"
name="SampleApp_Lite Xml" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns="http://www.oracle.com/obis/repository"
password="94F9321C85340FC48E4D9093AA941FF28844074B88D5AA6364E4815DEED7FIB
8792EF452219C2155DB68F61EE1555B4FA886F77E060E2E17F45AD8D18CAB2E4AD3EFALISBT5E
30D8B4BFA8C7B2D70552BD" timeout="4294967295" maxConnDiff="10" maxConn="10"
dataSource="VALUEOF (BI_EE_HOME) /sample/SampleAppFiles/Data" type="Default"
reqQualifedTableName="false" isSharedLogin="false"
isConcurrentQueriesInConnection="false" isCloseAfterEveryRequest="true"
xmlRefreshInterval="2147483647" outputType="xml" ignoreFirstLine="false"
bulkInsertBufferSize="0" transactionBoundary="0" xmlaUseSession="false"
multiThreaded="false" supportParams="false" isSiebelJDBSecured="false"
databaseRef="/oracle/bi/server/base/Database/Sample App Lite Data_80ca62c4
-0bcf-0000-714b-e31d00000000.xm1#m80ca62c4-0bcf-0000-714b-e31d00000000"

>

<Description>

<! [CDATA[

SampleAppLite connection pool to XML datasource. This connection pool points the
database to the location where physical XML files are stored. The location uses
the value of an RPD variable : BI_EE HOME.

This variable needs to be correctly set in order for the server to connect to the
files.

11>

</Description>

</ConnectionPool>

The SampleAppLite repository will generate MDS XML files in a structure like the
following:
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E) 153 MDS_¥ML_Output
=l 1) oracle
B 2 bi
B ) server
= ) base
) AggrRule
) BusinessModel
) ConnectionPool
) Database
() Dimension
) Group
) LogicalComplex Jain
) LogicalLevel
) LogicalSourceFalder
) LogicalTable
) LogicalTableSource
) MeasureDefn
) ObjectPrivilege
) PhysicalTable
() PresentationCatalog
) PresentationHierarchy
) PresentationLevel
) PresentationTable
() PrivilegePackage
) QueryPrivilege
() User
) Yariable

Note that there is not a one-to-one relationship between repository objects in the
Administration Tool and the set of files produced as XML output. For example,
physical columns appear as independent objects in the Administration Tool, but in
MDS XML they are considered part of the Physical Table object.

See "About the Oracle BI Server MDS XML API" in Oracle Fusion Middleware XML
Schema Reference for Oracle Business Intelligence Enterprise Edition for full information
about the MDS XML schema representation of repository objects.

Setting Up Your System for Repository Development Under Source
Control Management

This section explains how to set up an SCM configuration file with commands specific
to your SCM system, as well as how to generate an MDS XML repository and check it
into your SCM system.

This section contains the following topics:
s Creating an SCM Configuration File
s Creating an MDS XML Repository and Checking In Files to the SCM System

Creating an SCM Configuration File

To integrate the Administration Tool with your source control management system,
you must create an XML configuration file based on your specific SCM system. The
configuration file contains the SCM system commands for adding, deleting, checking
out, and renaming files. The Administration Tool will issue these commands to the
SCM system when repository objects are created or updated, resulting in
corresponding new or changed MDS XML files.
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Note: The Administration Tool does not commit the changes to the
SCM system. The repository developer must always check the files
into the SCM system directly. This way, the repository developer can
view any conflicts or make merge decisions in the SCM environment
rather than the Administration Tool environment.

To create a configuration file for your SCM system:

1.
2.
3.

Open the Administration Tool and select Tools, then select Options.
Select the Source Control tab.

Click New to create a new configuration file. The Specify new configuration file
window is displayed.

Note: This procedure assumes that you do not have an open MDS XML repository
in the Administration Tool. If you create or edit an SCM configuration file while
an MDS XML repository is open, you must ensure that Use Source Control is
selected to enable the New or Edit buttons.

Provide a file name and click Save. The file must have the XML file extension.

The default location for SCM configuration files is ORACLE_

INSTANCE/ config/OracleBIServerComponent/coreapplication_obisn. Although
templates are also available in this location, do not select a template file during
this step. Instead, you can load a template in the next step.

To load a template configuration file, click Load in the SCM Configuration Editor.
Then, select a template file (for example, scm-conf-svn.template) and click Open.

Unless it is your intention to modify the configuration file template itself, ensure
that Edit in Configuration Editor is not selected. If you select this option, the file
name displayed in the Configuration File field in the SCM Configuration Editor
changes from the file name you provided in step 4 to the template file name, and
changes are saved by default to the template file.

In the SCM Configuration Editor, provide an optional description, then enter or
edit commands for your system in the Commands subtab. For longer commands,
click the ellipsis button to enter commands in the Command Editor window.

Use the ${file}, ${filelist}, ${from}, and ${to} tokens to define the commands. You
can also use the List File option in conjunction with the ${filelist} command to set
the behavior. The tokens can be used as follows:

»  ${file} specifies that a command must be run sequentially, one file at a time.
${file} is required for the Add Folder and Add File commands.

»  The behavior of ${filelist} varies, depending on whether List File is selected:

- $lifilelist} without List File selected causes the Administration Tool to
group as many files as possible for the given command (such as
Pre-Delete, Delete, or Check-out), staying under the 32k character limit for
launching a process. Execution is repeated until all files have been
processed.

—  $i{filelist} with List File selected enables the Administration Tool to create
a temporary list of files to be used with the given command (such as
Pre-Delete, Delete, or Check-out). Always select List File for SCM systems
that support it. It results in much faster operations.
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You can use either ${file} or ${filelist} for Pre-Delete, Delete, and Checkout.
List File only works in conjunction with ${filelist}.

= $i{from} and ${to} are used to specify the original file name and new file name
in Rename commands.

Not all SCM systems support file rename operations natively. If this is the
case, leave the Rename field blank rather than attempting to construct a
rename operation by concatenating different commands. The Administration
Tool will do this for you with greater efficiency.

Note: Some SCM systems do not include commands for working
with folders. If this is the case, leave Add Folder blank. The
Administration Tool always creates folders for you when needed.

Even if your SCM system does include folder management
commands, the Administration Tool does not remove folders. You
must remove folders directly in the SCM system if necessary.

Figure 4-1 shows the Commands tab of the SCM Configuration Editor.

Figure 4-1 Commands Tab of SCM Configuration Editor

SCM Configuration Editor - ade-confxml - | a Iil
Configuration File | C+\00\TESTDIRconfiglade-conf xml Load... [ Save As... |
Description |

Commands 1En\-’ironrnent Variables | Post-save comment |

SCM commands

Add Folder |

Add File | ade.exe mkelem -nc -recursive ${file}

Pre-Delete® | ade.exe unco ${filelist}

Delete I ade.exe rmname -listfile ${filelist}

Check-out I ade.exe co -nc -list ${filelist}

Rename Iade.exe mv ${from} ${to}

* Optional command to run before deleting a checked-out file

’TI Cancel [ Help l

7. Select the Environment Variables subtab, and then specify environment variables
required by your SCM system.

You can paste environment variables directly from your operating system variable
list, paste environment variables from the clipboard, or manually add
environment variables. Table 4-1 describes the options available for managing
environment variables in the Environment Variables subtab.
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Table 4-1 Options for Managing Environment Variables in the SCM Configuration Editor

Option Description

Paste environment Enables you to paste environment variables directly from your

variables operating system. Click this option to open a window where
you can enter filter criteria, then click OK. Enter * in the filter

window to paste all environment variables.

Paste from clipboard Enables you to paste text from the clipboard. To use this option,
copy text in the following format:

variable_namel=variable_valuel

variable_name2=variable_value2

Each environment variable must be on its own line.

Add Adds a row to the table so that you can manually enter
environment variables. Provide the variable name in the
Variable column, and its definition in the Value column.

Leading and trailing white space is trimmed. You can use
%VAR% in the variable definition to reference a previously
defined variable.

Delete Deletes the given row in the environment variables table.

Note that you should not store security-sensitive environment variables in the
configuration file. If security-sensitive variables are required by your SCM system,
to avoid the security risk, you can launch the Administration Tool from a DOS
window with any security-sensitive variables already set.

8. Click Test in the Environment Variables subtab to open the Test SCM
Configuration window. Then, enter a command and click Execute to test a
particular command. If the environment is correct, the correct output should
appear after executing the command.

9. Select the Post-save comment subtab to enter text that will appear after changes
are saved in the Administration Tool. This capability is a way to remind
developers to check files directly into their SCM system after saving. For example,
a post-save comment might be:

Files have been synchronized to source control. Remember to check in changes
after testing.

10. Click OK to save the configuration file, or click Save As to save a copy if you
loaded and modified a template configuration file.

Creating an MDS XML Repository and Checking In Files to the SCM System

To integrate with an SCM system, you must convert your Oracle BI repository to MDS
XML format. Use one of the following options to create an MDS XML repository and
check it into your source control system:

= Saving an Existing Repository File in MDS XML Format
n  Creating a New Repository in MDS XML Format

= Linking to Source Control Files to Convert Your Repository (Small Repositories
Only)
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Saving an Existing Repository File in MDS XML Format
If you have an existing repository file, follow these steps to convert it to MDS XML:

1. Open your existing repository file (RPD) in the Administration Tool in offline
mode.

2. Select File, then select Save As, then select MDS XML Documents.
3. Select a root location for your MDS XML repository files, and then click OK.

4. Perform the necessary steps in your source control management system to add
and check in the files.

Use the specialized commands for bulk file import, available for most SCM

systems. These commands are optimized to deliver entire trees of files to source

control in a very efficient way. For example, in Subversion, use the following
command:

svn import module name -m "Initial import"

The steps described in this section are the recommended method for initial import.

Note: You can also use the biserverxmlgen utility with the -Mand -D
options to generate MDS XML from an existing RPD. See "Generating
MDS XML from an Existing RPD Using a Command-Line Utility" in
Oracle Fusion Middleware XML Schema Reference for Oracle Business
Intelligence Enterprise Edition for more information.

Creating a New Repository in MDS XML Format

To create a new repository in MDS XML format, follow these steps:

1. Open the Administration Tool and select File, then select New Repository to open

the Create New Repository Wizard.

2. Select the MDS XML Documents option in the wizard. Complete the other wizard

steps.

3. Perform the necessary steps in your source control management system to add
and check in the files. For large repositories, use the specialized commands for
bulk file import for your SCM system.

Note: Do not create a new MDS XML-format repository, add objects,
and then select Link to Source Control. This method will not work,
and no SCM commands will be generated.

Linking to Source Control Files to Convert Your Repository (Small Repositories
Only)

For very small repositories, you can use the Link to Source Control Files method to
convert a binary RPD file to MDS XML format:

1. Ensure that you have an SCM configuration file defined. See "Creating an SCM
Configuration File" for more information.

2. Create an empty root folder for the MDS XML repository.

3. Open your existing RPD file in the Administration Tool in offline mode.

4. Select File, then select Source Control, then select Link to Source Control Files.

Using a Source Control Management System for Repository Development
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5. Select the root folder you created, and the appropriate SCM configuration file.

Note: If you need to change the configuration file later, you can go Tools >
Options > Source Control and click Edit to change the configuration file.

6. Click Save. An MDS XML repository is created, and the necessary add file
operations are performed in your source control system.

7. Commit the changes in your SCM system.

Note: Using the Link to Source Control Files method to initially
import your repository is only recommended for very small
repositories. This method is too slow for large repositories (tens of
thousands of files) because the Administration Tool imports the files
one at a time using the standard "add file" command, rather than
using specialized commands for bulk file import.

Note also that the repeated invocation of the "add file" command
might increase the chances of transient errors. If these occur, you
might need to restart the process a few times before all files are
successfully imported to source control.

Using Source Control Management in Day to Day Repository
Development

This section describes typical scenarios that occur during day to day repository
development.

This section contains the following topics:

s Updating, Saving, and Checking In Changes for Repositories Under Source
Control

= Handling Errors
s Testing Repositories Under Source Control

= Viewing the Source Control Log

Updating, Saving, and Checking In Changes for Repositories Under Source Control

After your MDS XML repository is set up under source control, follow these steps to
update, save, and check in changes to your repository:

1. Ensure that you have a local copy of your working MDS XML repository files that
are under source control by issuing the appropriate commands in your SCM
system. For example, for Subversion, you can issue the command svn info as
shown in the following example text:

C:\myProj\repos>svn info

Path: .

Working Copy Root Path: C:\myProj\repos
URL: file:///C:/SVN/myProj/trunk/samplel
Repository Root: file:///C:/SVN/myProj
Repository UUID: 6b995c92-3ec0-fadb-9d58-c98e54£41792
Revision: 3

Node Kind: directory

Schedule: normal

Last Changed Author: joe_user

Last Changed Rev: 2
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Last Changed Date: 2011-11-19 15:20:42 -0600 (Sat, 19 Nov 2011)

2. Open your MDS XML repository in the Administration Tool in offline mode. To
do this, select File, then select Open, then select MDS XML.

3. Select the root folder location for your MDS XML files and click OK.

4. If this is the first time you have opened this MDS XML repository in the
Administration Tool, you are prompted to specify whether this repository is a
standalone MDS XML repository, or whether it is under source control. Select Use
Source Control and click OK.

This choice is saved for this repository. To view the status of this repository at any
time, select Tools, then select Options, then select the Source Control tab.

5. After you make changes to your repository, select File, then select Save, or click
Save on the toolbar. The Administration Tool displays a list of changes. For
example:

Oracle BI Administration Tool (=] ﬁ

% “hanges described below have to be perfomed in Source Contral Management,
_..' Do you want ko proceed?

"odified Files:
oraclelbilserver\baselDatabase!5999F 130-0be4-1000-9225-0ae43ba40000. xml
oraclelbilserver\baselLogicalTableSourcel59d4fes3-0bed- 1 000-9225-0ae48ba40000. xml
oraclelbilserver\base\PhysicalTable\59b1befD-0bed-1000-922a-0ae48ba40000. xml
oracle\bi\server\base\PhysicalTable! 59c19d70-0be4- 1000-9225-0ae48ba4 0000, xml

Files to delete:
oracle\bilserveribaselConnectionPooli599ef a4 0-0be4- 1000-922 a-0ae48ba40000, xml

,

6. Click Yes. The Administration Tool runs the necessary commands in the SCM
system.

After you accept the changes, you cannot cancel. Canceling in the middle would
leave an inconsistent repository. You must wait for the SCM commands to be
executed.

Note also that when the Administration Tool issues the SCM commands, they may
be rearranged into the most optimal order.

7. Check in the changes directly in your SCM system.

Handling Errors

Sometimes, errors might occur when the Administration Tool delivers changes to the
SCM system, such as an expired label or network problem. If errors occur, perform the
following steps:

1. In the Administration Tool, select File, then select Save As to save the repository
to a temporary location in RPD format or MDS XML format. Close the
Administration Tool.

Note: Saving to a binary RPD is the simplest option for transient
problems like network errors, where you just need to try again later.
Saving as MDS XML is required when some sort of work is required
to fix the problem, such as merging conflicting changes.
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2, Take action to resolve the issue. For example, refresh an expired label or
test/bring up a failed network connection.

In the case of an expired label, you also need to merge the contents of the
refreshed label with the temporary saved MDS XML repository. Use a third-party
merge tool to do this.

For detailed information about the MDS XML representation of repository objects
so that you can successfully make merge decisions, see Oracle Fusion Middleware
XML Schema Reference for Oracle Business Intelligence Enterprise Edition.

3. Open the saved repository in the Administration Tool.
4. Select File, then select Source Control, then select Link to Source Control.

5. Click Save to save changes from the saved repository into the MDS XML files
under source control.

Steps 4 and 5 of this procedure cause the Administration Tool to keep memory objects
loaded from the saved RPD file or MDS XML files, but to then consider them to belong
to the source control MDS XML repository instead. When you click Save, the
Administration Tool saves the memory objects to the source control repository.

Testing Repositories Under Source Control

During the course of repository development, you will need to perform testing in
online mode to validate your repository. You can only load an Oracle BI repository in
RPD format into the Oracle BI Server to make it available for queries. Because of this,
you must save your development MDS XML repository in RPD format from time to
time when you want to perform online testing. To do this, open your MDS XML
repository in offline mode and select Save As, then select Repository.

See "Making the Repository Available for Queries" for more information about
uploading repositories.

Viewing the Source Control Log

The Source Control Log window shows the commands that the Administration Tool
issues to your SCM system. It also shows any post-save text you specified in the
Post-save comment tab of the SCM Configuration Editor.

By default, the Source Control Log window appears when SCM commands are being
executed. Alternatively, you can select File, then select Source Control, then select
View Logs to see the Source Control Log window.

Figure 4-2 shows the Source Control Log window.
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Figure 4-2 Source Control Log Window

Source Contral Log ] ﬁ

Aduintool> Updating file oracle\hi\server\hase\PhysicalTa.ble\59hlhefD—th

Admintool> Updating file oracle‘\bi‘serwerhbase‘\PhysicalTable59c19d470-0b

> ade.exe unco oraclebbi‘server‘baseh\ConnectionPool?, 599efadl-0bed-1000-9
ade WARNING: Sawved content of 'C:/ADE/olouchar main nt/bifndn/MDS1/oracl
Cancelled checkout of bifndn/MD5l/oracle/bisserver/base/ConnectionPool/s

> ade.exe rmname -liztfile C:hUzera‘\olouchar’ippData’LocalyTempy 2705, top
Fenoved bifndn/MD31/oracle/bifserver/base/ConnectionPool/59%efad0-0bed-1

Files hawe been synchronized to source control. Eemewmber to check-in
changes after testing.

I™ Close when commands Finish

I™ only show dialog when errors acour Copy | Closg |

Shows the Source Control Log window in the Administration Tool.

34 3 e 3 e e 3 e 3 e e e 3 e 3 e e e 3 e S e S 3 A A e e S A S e e e A A e A KA A AN KN A A KA A KA A AN AN

You can choose the following options for this dialog:

= Close when commands finish: Causes the log window to close automatically
when commands are complete, unless errors occur.

= Only show dialog when errors occur: Hides the window during SCM command
execution unless errors occur. By default, the Source Control Log appears
automatically when SCM commands are being executed unless this option is
selected.

The text displayed in the Source Control Log is persistent until you close the
repository. This means that all SCM command output is available for view, regardless
of whether the dialog is open during individual operations.

The Source Control Log does have a 32K character limit. When the window buffer
becomes full, then the oldest commands are removed from the Source Control Log
display to make room for the latest command output. To see the full output, go to the
Administration Tool log at:

ORACLE_INSTANCE/diagnostics/logs/OracleBIServerComponent/coreapplication_obisn/
user_name_NQSAdminTool.log

Note: While SCM commands are being executed, the Close button is
disabled until the SCM commands have finished or have stopped with
an error (unless Only show dialog when errors occur has been
selected).

Using Source Control Management with MUD

You can use source control management with your multiuser development
environment. This section provides a general outline of how you might use both
processes together.

For example, if you have an existing repository under multiuser development and you
want to begin using source control management, you might follow the steps described
in the following subsections:
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Putting the MUD Master Repository and MUD Log File Under Source Control

Checking In New Versions of the MUD Master and MUD Log File to Source
Control

Putting the MUD Master Repository and MUD Log File Under Source Control

1.

3.

Convert your master MUD RPD to a set of MDS XML files on the file system. See
"Saving an Existing Repository File in MDS XML Format" for information on how
to do this.

Use the mhlconverter command-line utility to convert your MUD log file (*.mhl)
to an XML file. To do this, follow these steps:

a. Run bi-init to launch a command prompt that is properly initialized. See
"Running bi-init to Launch a Shell Window Initialized to Your Oracle Instance"
for more information.

b. At the command prompt, type mhlconverter with the input MHL file name
and path, and the output XML file name and path. For example:

mhlconverter -I C:\MUD\mud_repository.mhl -O C:\MUD\mud_repository.xml

Check the MDS XML files and XML-format MUD log file into your SCM system.

Checking In New Versions of the MUD Master and MUD Log File to Source Control

After creating and checking in the initial version of the master MUD repository, you
will need to check in updated versions of the MUD master repository on an ongoing
basis. This section describes two different ways to perform this task:

Manually Checking In the Updated MUD Master Repository and Log File
Using a Script to Check In the Updated MUD Master Repository and Log File

Manually Checking In the Updated MUD Master Repository and Log File

Follow these steps to manually check in changes to the master RPD and log file that
have occurred as part of the multiuser development process:

1.
2

Open the latest copy of the master RPD in the Administration Tool.

Create or select the appropriate SCM configuration file. See "Creating an SCM
Configuration File" for more information.

Select File, then select Source Control, then select Link to Source Control. Select
the directory that contains the MDS XML version of the master MUD repository.

Using Link to Source Control is not recommended for large repositories and
might cause time-outs. Consider using the automated check-in method described
in "Using a Script to Check In the Updated MUD Master Repository and Log File"
if you have a large repository.

Click Save to save changes from the master MUD repository into the MDS XML
files under source control. The Administration Tool determines which files to add,
check out, modify, and delete and issues the commands to your SCM system.

Close the Administration Tool.
Follow these steps to update the MUD log file:
a. Inyour SCM system, check out the XML-format MUD log file.
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b.

C.

Use the mhlconverter utility to overwrite the XML-format MUD log file with
the latest changes from the .mhl version.

Check in the latest XML-format MUD log file to your SCM system.

7. Check all changes into your SCM system.

It is recommended that you perform the steps in this section regularly to avoid having
too many changes in a single transaction.

Using a Script to Check In the Updated MUD Master Repository and Log File

As an alternative to manually checking in changes, you can create a script to perform
the check-in tasks and then schedule it to run at regular intervals. For example, follow
these steps:

1. Identify the latest copy of the master RPD that you want to check into your SCM
system.

2. Identify the last version of the master RPD that was checked into the SCM system.
You can review the latest XML-format MUD log file under source control to
determine this version.

Note: If you do not have the last checked-in version of the master
repository in RPD format, you can use the biserverxmlexec utility
with the -D option to read the latest MDS XML files checked into
source control and re-create an RPD version.

3. Use the comparerpd utility with the -M option to compare the latest copy of the
master RPD (the modified version) with the version that was last checked in (the
original version). An MDS XML format diff is generated. See "Comparing
Repositories Using comparerpd” for more information.

4. Create a script that does the following:

b.

Reads the MDS XML diff directory to identify which files are present.

Issues commands in source control to check out the identified files or add new
files.

Copies the latest version of the files from the MDS XML diff directory to the
source control directory.

Reads the oracle\bi\server\base\DeletedFiles.txt file inside the MDS XML
diff directory to determine which files to delete.

Issues commands in source control to delete the appropriate files.

Checks out the MDS XML-format MUD log file, runs the mhlconverter utility
to convert the latest MHL-format log file to XML format, overwrites the
existing MDS XML-format MUD log file with the new one, and checks it in.

Performs all necessary check-in steps in the SCM system.

Using a Source Control Management System for Repository Development 4-13



Using Source Control Management with MUD

4-14 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



O

Importing Metadata and Working with Data
Sources

This chapter describes how to create a new Oracle Bl repository, set up back-end data
sources, and import metadata using the Import Metadata Wizard in the Oracle BI
Administration Tool. It also describes how to use a standby database with Oracle
Business Intelligence.

This chapter contains the following topics:

= About Importing Metadata and Working with Data Sources
ms  Creating a New Oracle BI Repository

s Performing Data Source Preconfiguration Tasks

» Importing Metadata from Relational Data Sources

» Importing Metadata from Multidimensional Data Sources

» Importing Metadata from XML Data Sources

» Using a Standby Database with Oracle Business Intelligence

About Importing Metadata and Working with Data Sources

If you do not already have an Oracle Bl repository file, you must create one. Then, you
can import metadata from your data sources into the Physical layer of your repository.
The Physical layer of the Administration Tool defines the data sources to which the
Oracle BI Server submits queries, and the relationships between physical databases
and other data sources that are used to process multiple data source queries.

Metadata imports to an Oracle BI repository must occur through an ODBC or native
database connection to the underlying data source. Metadata can also be imported
from software such as Microsoft Excel through an ODBC connection.

Importing metadata directly from each data source saves you time and effort by
importing the structure for the Physical layer. Data from these sources can be
displayed on Oracle BI Interactive Dashboards and other clients. You can only import
metadata from supported data sources.

After you import metadata, properties in the associated database object and
connection pool are typically set automatically. However, you may want to adjust
database or connection pool settings. See Chapter 7, "Setting Up Database Objects and
Connection Pools" for more information.
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Although you can create the Physical layer manually rather than importing metadata,
it is a labor-intensive and error-prone activity. It is strongly recommended that you
import metadata.

Creating a New Oracle Bl Repository

You can use the Create New Repository Wizard in the Administration Tool to create a
new Oracle Bl repository, in either binary (RPD) or MDS XML format. You do not
need to create a new repository if you already have an existing repository.

If you have an existing repository, you can use the existing data source settings in that
file as a template to connect to different data sources. To do this, use the existing data
source settings and just change the database type and connection pool information.
See "Setting Up Database Objects" and "Creating or Changing Connection Pools" for
details.

To create a new Oracle BI repository:

1. In the Administration Tool, select File, then select New Repository. The Create
New Repository Wizard appears.

If an existing repository is open, you are prompted to save your changes, and the
existing repository is closed.

2. Select Binary if you want to create a repository in RPD format. To create a
repository in MDS XML format, select MDS XML Documents.

3. For binary repositories, type a name for the repository. Keep the name to 156
characters or less to avoid problems with the metadata dictionary URL. An RPD
file extension is automatically added if you do not explicitly specify it.

4. For Location, follow the steps appropriate for your repository type:

= For binary repositories, select a location for the RPD file. By default, new
binary repositories are stored in the repository subdirectory, located at
ORACLE_
INSTANCE\bifoundation\OracleBIServerComponent\coreapplication_
obisn\repository.

»  For MDS XML format repositories, select a root folder location for the set of
MDS XML files.

5. If you want to import metadata into the repository now, select Yes (the default) for
Import Metadata. If you do not want to import metadata, select No.

6. Enter and confirm the password you want to use for this repository. The
repository password must be longer than five characters and cannot be empty.

You enter the repository password when you open the repository in online or
offline mode. It is used to encrypt the repository contents.

7. If you selected Yes for Import Metadata, click Next.

Refer to the following sections for information about the Import screens, according
to your data source type:

» Importing Metadata from Relational Data Sources

» Importing Metadata from Multidimensional Data Sources
» Importing Metadata from XML Data Sources

s Working with ADF Data Sources
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Note that you many need to set up your data sources before you import
information into the repository. See "Performing Data Source Preconfiguration
Tasks" for more information.

8. If you selected No for Import Metadata, click Finish to create an empty
repository.

Performing Data Source Preconfiguration Tasks

Before you can import physical objects from your data sources into your repository
file, or set up connection pools to your data sources, you might need to perform
configuration steps so that the data sources can be accessed by Oracle Business
Intelligence.

For many data sources, you need to install client components. Client components are
typically installed on the computer hosting the Oracle BI Server for query access, and
on the computer hosting the Administration Tool (if different) for offline operations
such as import. In some cases, client components must be installed on the computer
where the JavaHost process is located.

Note: See also the following related topics:

»  If the Oracle BI Server is running on a non-Windows platform, see
Chapter 16, "Setting Up Data Sources on Linux and UNIX" for
additional instructions.

= See Chapter 6, "Working with ADF Data Sources" for information
about setting up ADF data sources.

= See "System Requirements and Certification" for information
about the data source versions supported by Oracle Business
Intelligence.

This section contains the following topics:

»  Setting Up ODBC Data Source Names (DSNs)

= Setting Up Oracle Database Data Sources

= Setting Up Oracle OLAP Data Sources

= Setting Up Oracle TimesTen In-Memory Database Data Sources
»  Setting Up Essbase Data Sources

= Setting Up Hyperion Financial Management Data Sources

= Setting Up SAP/BW Data Sources

s Setting Up Oracle RPAS Data Sources

»  Setting Up Teradata Data Sources

Setting Up ODBC Data Source Names (DSNs)

Before you can import from a data source through an ODBC connection, or set up a
connection pool to an ODBC data source, you must first create an ODBC Data Source
Name (DSN) for that data source on the client computer. You reference this DSN in
the Import Metadata Wizard when you import metadata from the data source.

You can only use ODBC DSNs for import on Windows systems.
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To set up an ODBC DSN on Windows:

1. Open the Windows Control Panel by selecting Start > Settings > Control Panel,
double-click Administrative Tools, and then double-click Data Sources (ODBC).

2. Inthe ODBC Data Source Administrator dialog, click the System DSN tab, and
then click Add.

3. From the Create New Data Source dialog, select the driver appropriate for your
data source, and then click Finish.

The remaining configuration steps are specific to the data source you want to
configure. Refer to the documentation for your data source for more information.

ODBC DSNs on Windows systems are used for both initial import, and for access to
the data source during query execution. On UNIX systems, ODBC DSNs are only used
for data access. For information about setting up ODBC data sources on UNIX, see
Chapter 16, "Setting Up Data Sources on Linux and UNIX."

See also "Setting Up Teradata Data Sources" for additional information specific to
Teradata.

Setting Up Oracle Database Data Sources

You should always use OCI when importing metadata from or connecting to an Oracle
Database. Before you can import schemas or set up a connection pool, you must add a
TNS names entry to your tnsnames.ora file. See the Oracle Database documentation
for more information.

When you import metadata from an Oracle Database data source or set up a
connection pool, you can include the entire connect string for Data Source Name, or
you can use the net service name defined in the tnsnames.ora file. If you choose to
enter only the net service name, you must set up a tnsnames.ora file in the following
location within the Oracle Business Intelligence environment, so that the Oracle BI
Server can locate the entry:

ORACLE_BI_HOME\network\admin

Note: If you are running Oracle BI EE on a Windows 7 64-bit
computer, you must ensure that the default authentication service is
not set to use Windows domain credentials. Check the sqlnet.ora file
in ORACLE_BI HOME\network\admin to ensure that the
AUTHENTICATION_SERVICES parameter appears as follows:

SQLNET . AUTHENTICATION_SERVICES= (NONE)

Otherwise, you might receive a connection error when importing from
an Oracle Database because the Administration Tool will attempt to
log in using your Windows domain credentials.

Additional Oracle Database Configuration for Client Installations

If you install the Administration Tool using the Oracle Business Intelligence Enterprise
Edition Plus Client Installer, you must install the Oracle Database Client on the
Administration Tool computer before you can import from Oracle Database sources.
Use either the Administrator or Runtime client install option.

If you are running a 32-bit Administration Tool, you must install the 32-bit Oracle
Database Client. If you are running a 64-bit Administration Tool, you must install the
64-bit Oracle Database Client.
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After installing the Oracle Database Client, create an environment variable called
ORACLE_HOME and set it to the Oracle home for the Oracle Database Client. Then,
create an environment variable called TNS_ADMIN and set it to the location of the
TNSNAMES.ORA file (ORACLE_HOME\network\admin).

Setting Up Oracle OLAP Data Sources

Before you import from an Oracle OLAP data source, ensure that the data source is a
standard form Analytic Workspace.

In addition, the JavaHost process must be running to import from Oracle OLAP data
sources, for both offline and online imports. If you have a client installation of the
Administration Tool, see also the following section for JavaHost and other
configuration steps.

Additional Oracle OLAP Configuration for Client Installations

If you install the Administration Tool using the Oracle Business Intelligence Enterprise
Edition Plus Client Installer, you must install the Oracle Database Client on the
Administration Tool computer before you can import from Oracle OLAP sources. Use
either the Administrator or Runtime client install option.

If you are running a 32-bit Administration Tool, you must install the 32-bit Oracle
Database Client. If you are running a 64-bit Administration Tool, you must install the
64-bit Oracle Database Client.

After installing the Oracle Database Client, create an environment variable called
ORACLE_HOME and set it to the Oracle home for the Oracle Database Client. Then,
create an environment variable called TNS_ADMIN and set it to the location of the
TNSNAMES.ORA file (ORACLE_HOME\network\admin).

In addition, to import from Oracle OLAP data sources in offline mode, the
Administration Tool must point to the location of a running JavaHost. The following
steps are only required for client installations of the Administration Tool.

To point the Administration Tool at a running JavaHost:
1. Close the Administration Tool, if it is open.

2, On the same computer as the Administration Tool, open the local NQSConfig.INI
file in a text editor. You can find this file at:

ORACLE_INSTANCE/config/OracleBIServerComponent/coreapplication_obisn
3. Locate the JAVAHOST_HOSTNAME_OR_IP_ADDRESSES parameter, near the

bottom of the file. Update this parameter to point to a running JavaHost, using a
fully-qualified host name or IP address and port number. For example:

JAVAHOST_HOSTNAME_OR_IP_ADDRESSES = "myhost.example.com:9810"

Note that in a full (non-client) Oracle Business Intelligence installation, you cannot
manually edit this setting because it is managed by Oracle Enterprise Manager
Fusion Middleware Control.

4. Save and close the file.

Setting Up Oracle TimesTen In-Memory Database Data Sources

Oracle TimesTen In-Memory Database is a high-performance, in-memory data
manager that supports both ODBC and JDBC interfaces. These preconfiguration
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instructions assume that you have already installed TimesTen; see Oracle TimesTen
In-Memory Database Installation Guide for more information.

Note: If you plan to create aggregates on your TimesTen source, you
must also ensure that PL/SQL is enabled for the instance, and that the
PL/SQL first connection attribute PLSQL is set to 1. You can enable
PL/SQL at install time, or run the ttmodinstall utility to enable it
post-install. See Oracle TimesTen In-Memory Database Reference for more
information.

This section contains the following topics:
s Configuring TimesTen Data Sources
= Improving Use of System Memory Resources with TimesTen Data Sources

= Ensuring that OPMN Can Access the TimesTen DLL on Windows

Configuring TimesTen Data Sources

This section describes the TimesTen configuration necessary before you can use
TimesTen as a data source for Oracle Business Intelligence.

To set up TimesTen data sources:

1. On the computer where TimesTen has been installed, create a Data Manager DSN
(as a system DSN). See "Defining a Data Manager DSN" in Oracle TimesTen
In-Memory Database Operations Guide for more information.

2. Perform an initial connection to the data store to load the TimesTen database into
memory, and then create users and grant privileges, if you have not done so
already. See "Managing Access Control" in Oracle TimesTen In-Memory Database
Operations Guide for more information. Note that the default user of the data store
is the instance administrator, or in other words, the operating system user who
installed the database.

3. On the computer running the Oracle BI Server, install the TimesTen Client. See
Oracle TimesTen In-Memory Database Installation Guide for more information.

4. On the computer where the TimesTen Client has been installed, create a Client
DSN (as a system DSN). See "Creating Client DSNs" in Oracle TimesTen In-Memory
Database Operations Guide for more information.

See "Configuring Database Connections Using Native ODBC Drivers" for
information about how to perform this step when the Oracle BI Server is running
on Linux or UNIX.

Note that if the TimesTen database is installed on the same computer as the TimesTen
client, you can specify either the Data Manager DSN or the Client DSN in the Import
Metadata Wizard.

After importing data from your TimesTen source, or when manually setting up a
database object and connection pool, ensure that your database type and version are
set correctly in the Database field of the General tab of the Database dialog. You must
also ensure that the Call interface field in the General tab of the Connection Pool
dialog is set correctly. See the following resources:

s "Creating a Database Object Manually in the Physical Layer"

= "Setting Connection Pool Properties in the General Tab"
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Oracle Fusion Middleware Installation and Administration Guide for Oracle Exalytics
In-Memory Machine for specific instructions on setting up TimesTen sources on the
Oracle Exalytics Machine

See "System Requirements and Certification" for information about supported
TimesTen versions for Oracle Business Intelligence.

Improving Use of System Memory Resources with TimesTen Data Sources

To improve the use of system memory resources, it is recommended that you increase
the maximum number of connections for the TimesTen server, as follows:

1.

In your TimesTen environment, open the ttendaemon.options file for editing. You
can find this file at:

install_dir/srv /info

Add the following line:

-MaxConnsPerServer number_of_connections

To determine number_of_connections, use the following formula: if there are M
connections for each connection pool in the Oracle Bl repository, N connection

pools in the Oracle BI repository, and P Oracle BI Servers, then the total number of
connections required is M * N * P.

Save and close the file.

In the ODBC DSN you are using to connect to the TimesTen server, set the
Connections parameter to the same value you entered in Step 2:

s On Windows, open the TimesTen ODBC Setup wizard from the Windows
ODBC Data Source Administrator. The Connections parameter is located in
the First Connection tab.

= On UNIX, open the odbc.INI file and add the Connections attribute to the
TimesTen DSN entry, as follows:

Connections=number of connections
Stop all processes connecting to TimesTen, such as the ttisql process and the
Oracle BI Server.
Stop the TimesTen process.

After you have verified that the TimesTen process has been stopped, restart the
TimesTen process.

Note: To avoid lock timeouts, you might also want to adjust the
LockWait interval for the connection as appropriate for your
deployment. See "LockWait" in Oracle TimesTen In-Memory Database
Reference for more information.

Ensuring that OPMN Can Access the TimesTen DLL on Windows

If the user that starts OPMN does not have the path to the TimesTen DLL
($TIMESTEN_HOME/1ib) in their operating system PATH variable, you must add the
TimesTen DLL path as a variable in the opmn.xml file.

To update opmn.xml to include TimesTen variables on Windows:

1.

Open opmn.xml for editing. You can find opmn.xml at:
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ORACLE_INSTANCE/config/OPMN/opmn/opmn . xml

2. Locate the ias-component tag for the Oracle BI Server process. For example:

<ias-component id="coreapplication_obisl" inherit-environment="true">

3. Under the Oracle BI Server ias-component tag, add the required TimesTen
variable TIMESTEN_DLL, and also update the PATH variable, as shown in the
following example. Replace the example values with the correct path for your
TimesTen client:

<ias-component id="coreapplication_obisl" inherit-environment="true">
<environment>

<variable id="TIMESTEN_ DLL" value="$TIMESTEN HOME/lib/libttclient.so" />
<variable id="PATH" value="$TIMESTEN HOME/lib:$ORACLE_HOME/bifoundation/
server/bin$ :SORACLE_HOME/bifoundation/web/bin$:SORACLE_HOME/clients/
epm/Essbase/EssbaseRTC/bin$:" append="true" />

</environment>

4. Save and close the file.
5. Restart OPMN.

6. Repeat these steps on each computer that runs the Oracle BI Server process. If you
are running multiple Oracle Bl Server instances on the same computer, be sure to
update the ias-component tag appropriately for each instance in opmn.xml (for
example, ias-component id="coreapplication_obis1", ias-component
id="coreapplication_obis2", and so on).

Setting Up Essbase Data Sources

The Oracle BI Server uses the Essbase client libraries to connect to Essbase data
sources. The Essbase client libraries are installed by default with Oracle BI Enterprise
Edition. No additional configuration is required to enable Essbase data source access
for full installations of Oracle Bl Enterprise Edition.

Additional Essbase Configuration Steps for Client Installations

If you install the Administration Tool using the Oracle Business Intelligence Enterprise
Edition Plus Client Installer, you must perform additional configuration before you
can import metadata from Essbase data sources.

For client installations of the Administration Tool, you must ensure that the Essbase
client libraries are installed on the client Administration Tool computer before you can
set up a connection to or import metadata from Essbase data sources. See "System
Requirements and Certification" for information about supported versions of the
Essbase Client for use with Oracle Business Intelligence.

After you ensure that the Essbase client libraries are installed on the Administration
Tool client computer, you must ensure that the PATH environment variable on each
computer includes the location of the Essbase client driver (for example, EPM_
ORACLE_HOME /products/Essbase/EssbaseClient).

You also need to ensure that the ESSBASEPATH environment variable is set
appropriately for each computer. For more information, see Oracle Hyperion Enterprise
Performance Management System Installation and Configuration Guide (or the equivalent
title for your client version).

In addition, you need to update bi-init.bat on the Administration Tool computer.
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To add Essbase environment variables to bi-init.bat:
1. Open the bi-init.bat file for editing. You can find bi-init.bat at:

ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup

2. Add a line setting the ESSBASEPATH environment variable, as appropriate for your
version and installed location of the Essbase client libraries. For example:

set ORACLE_INSTANCE=C:\mw_home\instances\instancel

set ORACLE_BI_APPLICATION=coreapplication

set ESSBASEPATH=C:\products\Essbase\EssbaseClient

call $ORACLE_INSTANCE%\bifoundation\OracleBIApplication\
$ORACLE_BI_APPLICATION%\setup\user.cmd

3. Locate the line that sets the PATH environment variable, and add the location of the
Essbase client binaries. For example:

set PATH=%0ORACLE_HOME%\bifoundation\server\bin;%$ORACLE_HOME$%\
bifoundation\web\bin; $ORACLE_HOME%\bin; %ESSSBASEPATH%\bin; $PATH%

4. Save and close the file.

Setting Up Hyperion Financial Management Data Sources

Before you can import from or set up a connection to Hyperion Financial Management
data sources, you must ensure that the Hyperion Financial Management client is
installed on the computer running the Oracle Bl JavaHost process. If you are using
Hyperion Financial Management version 9.3.1, you must also install the HFM
Application Builder version 9.2.0.1 component on the JavaHost computer.

When you install the Hyperion Financial Management client, make sure to perform
the following steps in the Server/Cluster Registration tab of the Client Configuration
utility:

= Inthe Server and Cluster Registration area, provide the IP address or host name of
the Hyperion Financial Management server and select Use One Server Only.

s In the Enable DCOM area, click Enable DCOM.

In addition, you must edit the file opmn.xml on each computer running the Oracle BI
JavaHost process to include environment variables required by Hyperion Financial
Management.

Note that the JavaHost process must be running to import from Hyperion Financial
Management data sources, for both offline and online imports. If you have a client
installation of the Administration Tool, see also "Additional Hyperion Configuration
for Client Installations" for JavaHost configuration steps.

Note: You can only use Hyperion Financial Management data
sources with Oracle BI EE when Oracle BI EE is running in a
Windows-only deployment.

For Hyperion Financial Management 9.3.1:
1. Open opmn.xml for editing. You can find opmn.xml at:

ORACLE_INSTANCE/config/OPMN/opmn/opmn .xml

2. Locate the ias-component tag for the JavaHost process. For example:
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<ias-component id="coreapplication_obijhl">

3. Within the environment tag, add new variables required for Hyperion Financial
Management, using the following example as a guide. Update the actual values as
appropriate for your installation.

<variable id="HYPERION_HOME" value="C:/Hyperion"/>

<variable id="ADM_HOME" value="$SHYPERION_HOME/common/ADM/9.3.1"/>

<variable id="HFM_HOME" value="$SHYPERION_HOME/FinancialManagement/Client"/>
<variable id="ADM_ESS_NATIVE_HOME" value="$ADM_HOME/Essbase/9.3.1"/>

4. Update the PATH variable to include ADM_ESS_NATIVE_HOME/bin and HFM_HOME. For
example:

<variable 1d="PATH" value="$ADM_ESS NATIVE HOME/bin$:$HFM_HOMES: SORACLE_
HOME/bifoundation/server/bin$:SORACLE_HOME/bifoundation/web/bin$: SORACLE
HOME /common/ODBC/Merant/5.3/1ib$ : SORACLE_INSTANCES : SORACLE_HOME/1lib"
append="true" />

5. Save and close the file.
6. Restart OPMN.

7. Repeat these steps on each computer that runs the Oracle Bl JavaHost process. If
you are running multiple JavaHost instances on the same computer, be sure to
update the ias-component tag appropriately for each instance in opmn.xml (for
example, ias-component id="coreapplication_obijh1", ias-component
id="coreapplication_obijh2", and so on).

You should run more than one JavaHost process to ensure that JavaHost is not a
single point of failure for HFM access. To do this, scale out the JavaHost process
using Fusion Middleware Control. See "Scaling Your Deployment" in Oracle Fusion
Middleware System Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition for more information about scaling out processes.

For Hyperion Financial Management 11.1.2:
1. Open opmn.xml for editing. You can find opmn.xml at:

ORACLE_INSTANCE/config/OPMN/opmn/opmn . xml

2. Locate the ias-component tag for the JavaHost process. For example:

<ias-component id="coreapplication_obijhl">

3. Within the environment tag, add new variables required for Hyperion Financial
Management, using the following example as a guide. Update the actual values as
appropriate for your installation.

<variable id="HYPERION_HOME" value="C:/oracle/Middleware/EPMSystemllR1"/>
<variable id="EPM_HOME" value="C:/MW_Home/Oracle_BIl/common/jlib/11.1.2.0"/>
<variable id="ADM_HOME" value="C:/MW_Home/Oracle_ BI1l/common/ADM/11.1.2.0"/>
<variable id="HFM_HOME" value="S$SHYPERION_
HOME/products/FinancialManagement/Client" />

<variable id="ADM_ESS_NATIVE_HOME" value="SADM_HOME/"/>

<variable 1d="CSS_HOME" value="c:/MW_Home/Oracle_BIl/common/CSS/11.1.2.0"/>

4. Update the PATH variable to include ADM_HOME/bin and the client and common
subdirectories of HYPERION_HOME. For example:

<variable id="PATH" value="C:\oracle\product\10.2.0\db_1\BINS:
$ADM_HOME/bin$: $HYPERION HOME/products/FinancialManagement/Commons$ :
$HYPERION HOME/products/FinancialManagement/Client$:SORACLE_HOME/
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common/ODBC/Merant/5.3/1ib$: SORACLE_HOME/bifoundation/server/bin$:
SORACLE_HOME/bifoundation/web/bin$ : SORACLE_HOME/common/ODBC/
Merant/5.3/11ib$:SORACLE_INSTANCES:SORACLE_HOME/lib" append="true"/>

Locate the data id="start-args" tag and update the classpath attribute to include
the location of required jar files. For example:

<data id="start-args" value="-Xmx1024M -Djava.security.manager=default -DXDO_
FONT_DIR=SORACLE_HOME/common/fonts -Djava.security.policy=$ORACLE_
INSTANCE/config/$COMPONENT TYPE/S$COMPONENT _NAME/java.policy
-Djava.util.logging.config.class=oracle.core.ojdl.logging.LoggingConfiguration
-Doracle.core.ojdl.logging.config.file=SORACLE_INSTANCE/config/SCOMPONENT_
TYPE/SCOMPONENT _NAME/logging-config.xml -Doracle.home=$ORACLE_HOME
-Doracle.instance=$ORACLE_INSTANCE -Doracle.component.type=$COMPONENT_TYPE
-Doracle.component .name=$COMPONENT_NAME -classpath $COMMON_COMPONENTS_
HOME/modules/oracle.odl_11.1.1/0jdl.jar$:$ORACLE_
HOME/bifoundation/javahost/lib/core/sautils.jar$:SORACLE_
HOME/bifoundation/javahost/lib/core/mad.jars$: SORACLE_
HOME/bifoundation/javahost/lib/core/sawconnect.jar$: SORACLE
HOME/bifoundation/javahost/lib/core/javahost.jars$: SCOMMON_COMPONENTS_
HOME/modules/oracle.xdk_11.1.0/xmlparserv2.jar$:SORACLE_
HOME/opmn/lib/ons. jar$: SCOMMON_COMPONENTS_HOME/modules/oracle. jps_
11.1.1/jps-manifest.jar$: SCOMMON_COMPONENTS_HOME/modules/oracle.jps_
11.1.1/jps-api.jar$: SCOMMON_COMPONENTS_HOME/modules/oracle.jps_
11.1.1/jps-common. jar$ : SCOMMON_COMPONENTS_HOME /modules/oracle. jps_
11.1.1/jps-internal.jar$: SCOMMON_COMPONENTS_HOME/modules/oracle.nlsrtl_
11.1.0/0rail8n.jar$: SCOMMON_COMPONENTS_HOME/modules/oracle.nlsrtl_
11.1.0/orail8n-collation.jar$: SCOMMON_COMPONENTS_HOME/modules/oracle.nlsrtl_
11.1.0/orail8n-mapping.jars : SCOMMON_COMPONENTS_HOME/modules/oracle.dms_
11.1.1/dms.jar$: $EPM_HOME/epm.jar$:$ADM_HOME/lib/adm.jar$:$ADM
HOME/lib/ap.jar$:$CSS_HOME/lib/css.jar$:$CSS_HOME/lib/common-model.jar$
com.siebel.analytics.javahost.standalone.Main"/>

Save and close the file.

Go to the directory ORACLE_
HOME /bifoundation/javahost/lib/obisintegration/adm and delete all jar files
except for admintegration.jar and admimport jar.

Restart the JavaHost process.

Repeat these steps on each computer that runs the Oracle Bl JavaHost process. If
you are running multiple JavaHost instances on the same computer, be sure to
update the ias-component tag appropriately for each instance in opmn.xml (for
example, ias-component id="coreapplication_obijh1", ias-component
id="coreapplication_obijh2", and so on).

You should run more than one JavaHost process to ensure that JavaHost is not a
single point of failure for HFM access. To do this, scale out the JavaHost process
using Fusion Middleware Control. See "Scaling Your Deployment" in Oracle Fusion
Middleware System Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition for more information about scaling out processes.

Additional Hyperion Configuration for Client Installations

If you install the Administration Tool using the Oracle Business Intelligence Enterprise
Edition Plus Client Installer, you must perform additional configuration before you
can perform offline imports from Hyperion Financial Management data sources. To
import from Hyperion Financial Management data sources in offline mode, the
Administration Tool must point to the location of a running JavaHost. The steps in this
section are only required for client installations of the Administration Tool.
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To point the Administration Tool at a running JavaHost:
1. Close the Administration Tool, if it is open.

2, On the same computer as the Administration Tool, open the local NQSConfig.INI
file in a text editor. You can find this file at:

ORACLE_INSTANCE/config/OracleBIServerComponent/coreapplication_obisn

3. Locate the JAVAHOST_HOSTNAME_OR_IP_ADDRESSES parameter, near the
bottom of the file. Update this parameter to point to a running JavaHost, using a
fully-qualified host name or IP address and port number. For example:

JAVAHOST_HOSTNAME_OR_IP_ADDRESSES = "myhost.example.com:9810"

Note that in a full (non-client) Oracle Business Intelligence installation, you cannot
manually edit this setting because it is managed by Oracle Enterprise Manager
Fusion Middleware Control.

4. Save and close the file.

Setting Up SAP/BW Data Sources

You can connect to SAP/BW data sources using either the XMLA connection type, or
the SAP BW Native connection type (BAPI). SAP BW Native connections might not be
available on certain platforms. See "System Requirements and Certification" for more
information.

To connect to SAP/BW data sources using the SAP BW Native connection type, you
must first download the BAPI Adapter for OBI Package from the Bristlecone Web site
at:

http://www.bristleconelabs.com/edel/OBIEE_BAPTIAdaptor_
download.asp

Then, follow the configuration instructions in the Readme provided with the
download.

No preconfiguration steps are required to connect to SAP/BW over XMLA.

Setting Up Oracle RPAS Data Sources

Oracle BI Server can connect to Oracle RPAS (Retail Predictive Application Server)
data sources through ODBC DSNS. To set up Oracle RPAS data sources, you must first
install the Oracle RPAS ODBC driver. During set up of the ODBC DSN, you must
select the SQLExtendedFetch option, select DBMS from the Authentication Method
list, and select No from the Normalize Dimension Tables list. See "About Importing
Metadata from Oracle RPAS Data Sources" for more information.

On Windows systems, you can connect to Oracle RPAS data sources for both initial
import and for access to the data source during query execution. On UNIX system:s,
you can only connect to Oracle RPAS data sources for data access.

See "Configuring Oracle RPAS ODBC Data Sources on AIX UNIX" for information
about how to enable ODBC access to Oracle RPAS data sources when the Oracle BI
Server is running on AIX UNIX.

Setting Up Teradata Data Sources

Teradata data sources are accessed using ODBC. See "Setting Up ODBC Data Source
Names (DSNs)" for information about setting up ODBC connections for Teradata.
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After you have installed the latest Teradata ODBC driver and set up an ODBC DSN,
you must add the lib directory for your Teradata data source to your Windows system
Path environment variable. For example:

D:\Program Files\NCR\Common Files\Shared ICU Libraries for Teradata\lib

In addition, you must manually edit opmn.xml on each computer running the Oracle
BI Server to include required Teradata variables.

To update opmn.xml to include Teradata variables on Windows:

1.

Open opmn.xml for editing. You can find opmn.xml at:

ORACLE_INSTANCE/config/OPMN/opmn/opmn . xml

Locate the ias-component tag for the Oracle BI Server process. For example:

<ias-component id="coreapplication_obisl" inherit-environment="true">

Under the Oracle BI Server ias-component tag, add the required Teradata
variables TERA_HOME, TERAGSS_HOME, and TERAICU_HOME, and also update the PATH
variable, as shown in the following example. Replace the example values with the
installed location for your Teradata client:

<ias-component id="coreapplication_obisl" inherit-environment="true">
<environment>

<variable id="TERA HOME" value="C:/Progra~l/Teradata/Client/13.10/
ODBCDR~1" />

<variable id="TERAGSS_HOME" value="C:/Progra~1/Teradata/TERADA~1/nt-i386/
131000~1.02" />

<variable id="TERAICU HOME" value="C:/Progra~l/Teradata/Client/13.10/
SHARED~1" />

<variable id="PATH" value="$TERA_HOME/lib$:$TERAICU HOME/lib$:$TERAGSS_
HOME/bin$: SORACLE_HOME/bifoundation/server/bin$: SORACLE_HOME/
bifoundation/web/bin$:SORACLE_HOME/clients/epm/Essbase/EssbaseRTC/
bin$:" append="true" />

</environment>
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Important: If you use the default location when installing the
Teradata client, then the PATH variable might exceed the 1024 character
limit imposed by Windows. To avoid this issue, install the Teradata
client in a directory with a shortened path name (such as C:\TD), or
use shortened 8.3 file names (such as
"C:\PROGRA~1\Teradata\Client\13.10N\ODBCDR~1\Bin" instead of
"C:\Program Files\Teradata\Client\13.10\ODBC Driver for
Teradata\Bin").

To determine the correct 8.3 file names, run "dir /x" from the
appropriate directory. For example:

C:\>dir /x

Volume in drive C has no label.

Volume Serial Number is 0000-XXXX

Directory of C:\

08/25/2008 03:36 PM  <DIR> DATAEX~1 DataExplorer
04/20/2007 01:38 PM  <DIR> dell

08/28/2010 10:49 AM  <DIR> DOCUME~1 Documents and Settings
07/28/2008 04:50 PM  <DIR> ECLIPS~2 EclipseWorkspace

09/07/2007 11:50 AM  <DIR> Ora92
09/07/2007 11:50 AM  <DIR> oracle
05/21/2009 05:15 PM  <DIR> OracleBI

05/21/2009 05:12 PM <DIR> ORACLE~1 OracleBIData
03/02/2011 04:51 PM  <DIR> PROGRA~1 Program Files

Save and close the file.
Restart OPMN.

Repeat these steps on each computer that runs the Oracle BI Server process. If you
are running multiple Oracle BI Server instances on the same computer, be sure to
update the ias-component tag appropriately for each instance in opmn.xml (for
example, ias-component id="coreapplication_obis1", ias-component
id="coreapplication_obis2", and so on).

Avoiding Spool Space Errors for Queries Against Teradata Data Sources

In some situations, queries against Teradata might get a "No more spool space" error
from the data source. This error can occur for DISTINCT queries resulting from
selecting All Choices in the Filters pane in Answers. To avoid this error, you can
ensure that the Oracle BI Server rewrites the query to use GROUP BY rather than
DISTINCT for these queries. To do this, ensure the following conditions are met:

There is only one dimension column in the projection list, and it is a target column
rather than a combined expression.

The original query from Answers is requesting DISTINCT, and does not include a
GROUP BY clause

The FROM table is a real physical table rather than an opaque view.

The FROM table is an atomic table, not a derived table.

The following ratio must be less than the threshold:

(the distinct number of the projected column) / (number of rows of FROM table)

Both values used in this ratio come from the repository metadata. To populate
these values, click Update Row Count in the Administration Tool for both of the
following objects:
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— The FROM physical table
— The physical column for the projected column

By default, the threshold for this ratio is 0.15. To change the threshold, create an
environment variable on the Oracle BI Server computer called SA_CHOICES_
CNT_SPARSITY and set it to the new threshold.

Importing Metadata from Relational Data Sources

You can import metadata for supported relational data source types by selecting the
appropriate connection type in the Import Metadata Wizard. All metadata imports
must be Local Machine imports, where you have all database connections set up on
your computer. You can perform Local Machine imports in both offline and online
modes.

See "Importing Metadata from Multidimensional Data Sources" and Chapter 6,
"Working with ADF Data Sources" for information about importing from other data
sources.

When you import physical tables, be careful to limit the import to only those tables
that contain data that are likely to be used in the business models you create. You can
use the Find feature to locate and select the tables that you want to import. Importing
large numbers of extraneous tables and other objects adds unnecessary complexity
and increases the size of the repository.

When you import metadata for most data sources, the default is to import tables,
primary keys, and foreign keys. It is recommended that you import primary and
foreign keys along with your tables so that the keys are automatically created in the
Physical layer. If you do not import keys, you must create them manually, which can
be a time-consuming process.

You can also import database views, aliases, synonyms, and system tables. Import
these objects only if you want the Oracle BI Server to generate queries against them.

To import metadata from a relational data source:

1. In the Administration Tool, select File, then select Import Metadata. The Import
Metadata Wizard appears.

Note: If you have already defined an existing database and
connection pool, you can right-click the connection pool in the
Physical layer and select Import Metadata. The Import Metadata
Wizard appears with the information on the Select Data Source screen
pre-filled.

Figure 5-1 shows the Import Metadata Wizard.
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Figure 5-1 Import Metadata Wizard: Relational Data Source
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2. In the Select Data Source screen, in the Connection Type field, select the type of
connection appropriate for your data source, such as ODBC 3.5.

Make sure to choose OCI 10g/11g if your data source is an Oracle Database. Using
OClI as your connection protocol to an Oracle Database ensures better performance
and provides access to native database features that are not available through
ODBC.

Note: For non-Oracle databases, it is recommended that you use
ODBC 3.5 or DB2 CLI (Unicode) for importing schemas with
International characters, such as Japanese table and column names.

The remaining fields and options on the Select Data Source screen vary according
to the connection type you selected:

— For ODBC 2.0 and ODBC 3.5 data sources, in the DSN list, select a data
source from which to import the schema. Then, provide a valid user name and
password for the data source.

Note that when you import through the Oracle BI Server, the DSN entries are
on the Oracle BI Server computer, not on the local computer.

- For OCI 10g/11g and DB2 CLI (Unicode) data sources, provide the name of
the data source in the Data Source Name field, then provide a valid user name
and password for the data source.

For Oracle Database data sources, the data source name is either a full connect
string or a net service name from the tnsnames.ora file. If you enter a net
service name, you must ensure that you have set up a tnsnames.ora file within
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the Oracle Business Intelligence environment, in ORACLE_
HOME /network/admin.

Other data source types are described in other sections:

= See "Importing Metadata from Multidimensional Data Sources" for Essbase,
XMLA, Oracle OLAP, Hyperion ADM, and SAP BW Native. This section also
describes importing from Oracle RPAS data sources over ODBC 3.5.

s See "Importing Metadata from XML Data Sources" for XML.
»  See Chapter 6, "Working with ADF Data Sources" for OracleADF_HTTP.

When you have finished providing information in the Select Data Source screen,
click Next. The Select Metadata Types screen appears.

3. Select the options for the types of objects that you want to import (for example,
Tables, Keys, and Foreign Keys). Some options are automatically selected.
Different types of data sources have different default selections, based on what is
typical for that data source.

If you want to import joins, select both Keys and Foreign Keys. If you want to
import system tables, you must have the system privilege for your data source. To
import from Customer Relationship Management (CRM) tables, select Metadata
from CRM tables.

4. Click Next. The Select Metadata Objects screen appears.

5. Select the objects you want to import in the Available list and move them to the
Selected list, using the > (Import selected) or >> (Import all) buttons. You can also
move objects from the Selected list back to the Available list, using the < (Remove
selected) and << (Remove all) buttons.

To search for a particular item, enter a keyword in the Find box and then click
Find Down or Find Up.

Select Show complete structure to view all objects, including those that have
already been imported. Deselecting this option shows only the objects that are
available for import. When this option is selected, objects that have already been
imported appear grayed out.

6. Click Finish.

If some objects could not be imported, a list of warning messages appears. In the
dialog displaying the messages, you can perform the following actions:

- To search for specific terms, click Find and then Find Again.

— To copy the contents of the window so that you can paste the messages in
another file, click Copy.

After you import metadata, you should check to ensure that your database and
connection pool settings are correct. In rare cases, the Oracle BI Server cannot
determine the exact database type during import and instead assigns an approximate
type to the database object. See "Setting Up Database Objects" and "Creating or
Changing Connection Pools" for more information about working with these objects.

It is also a good practice to visually inspect the imported data in the Physical layer,
such as physical columns and tables, to ensure that the import completed successfully.

About the Map to Logical Model and Publish to Warehouse Screens

The Map to Logical Model and Publish to Warehouse screens are available only for
ADF data sources. See the following resources:
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= "Automatically Mapping Flex Object Changes to the Logical Model" for
information about the Map to Logical Model screen

= "Running the BI Extender to Update Informatica, DAC, and the RPD" for
information about the Publish to Warehouse screen

Importing Metadata from Multidimensional Data Sources

You can use the Administration Tool to import metadata from a multidimensional
data source to the Physical layer of the Oracle BI repository. The ability to use
multidimensional data sources enables the Oracle Bl Server to connect to sources such
as Essbase, Oracle OLAP, Hyperion Financial Management, Microsoft Analysis
Services, and SAP/BW (SAP/Business Warehouse) to extract data. Data from these
sources can be displayed on dashboards.

The primary differences between setting up multidimensional data sources and
relational data sources are in the Physical layer. The setup in the Business Model and
Presentation layers for multidimensional data sources and relational data sources is
almost identical.

During the import process, each cube in a multidimensional data source is created as a
single physical cube table. The Oracle BI Server imports the cube metadata, including
its metrics, dimensions and hierarchies. After importing the cubes, you need to ensure
that the physical cube columns have the correct aggregation rule and that the
hierarchy type is correct. See "Working with Physical Hierarchy Objects" for more
information.

Caution: Manually creating a physical schema from a
multidimensional data source is labor-intensive and error prone.
Therefore, it is strongly recommended that you use the import
method.

It is recommended that you remove hierarchies and columns from the Physical layer if
they will not be used in the business model. This eliminates maintaining unnecessary
objects in the Administration Tool and might result in better performance.

To import metadata from a multidimensional data source:

1. In the Administration Tool, select File, then select Import Metadata. The Import
Metadata Wizard appears.

Note: If you have already defined an existing database and
connection pool, you can right-click the connection pool in the
Physical layer and select Import Metadata. The Import Metadata
Wizard appears with the information on the Select Data Source screen
pre-filled. You can also use this method to perform incremental
imports.

Figure 5-2 shows the Import Metadata Wizard.
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Figure 5-2 Import Metadata Wizard: Multidimensional Data Source
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Shows the Import Metadata Wizard in the Administration Tool, for an Essbase data
source.
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Note that the Map to Logical Model and Publish to Warehouse screens are
available only for ADF data sources. "About the Map to Logical Model and
Publish to Warehouse Screens" for more information.

2. In the Select Data Source screen, in the Connection Type field, select the type of
connection appropriate for your data source.

The remaining fields and options on the Select Data Source screen vary according
to the connection type you selected. Table 5-1 describes the multidimensional
connection types.

Table 5-1 Multidimensional Connection Options

Connection Type Description

ODBC 3.5 The ODBC 3.5 connection type is used for Oracle RPAS data sources.
Select the DSN entry and provide the user name and password for
the selected data source. See "Setting Up ODBC Data Source Names
(DSNs)" for more information.

Essbase Provide the host name of the computer where the Essbase server is
running in the Essbase Server field, then provide a valid user name
and password for the data source. This information should be
obtained from your data source administrator.

See "Working with Essbase Data Sources" for information about how
data from Essbase data sources is modeled in the Physical layer.

Note: You must ensure that Essbase client libraries are installed on
the computer running the Oracle BI Server before you can import
metadata from Essbase data sources. See "Setting Up Essbase Data
Sources" for more information.
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Table 5-1 (Cont.) Multidimensional Connection Options

Connection Type

Description

XMLA

The XMLA connection type is used for Microsoft Analysis Services
and SAP/BW. Enter the URL of a data source from which to import
the schema. Then, enter the Provider Type (such as Analysis Services
2000 or SAP/BW 3.5/7.0) and a valid user name and password for
the data source.

For Target Database, do one of the following;:

= Select New and enter the name you want to use for the new
database object.

= Select Existing and then click Browse to select an existing
database object.

Oracle OLAP

Provide the name of the data source (net service name) in the Data
Source Name field, then provide a valid user name and password for
the data source. The data source name is the same as the entry you
created in the tnsnames.ora file. Make sure that the name you use is
from the tnsnames.ora file within the Oracle Business Intelligence
environment. You can also choose to enter a full connect string rather
than the net service name.

For Target Database, do one of the following;:

= Select New and enter the name you want to use for the new
database object.

= Select Existing and then click Browse to select an existing
database object.

The JavaHost process must be running to import from Oracle OLAP
data sources, for both offline and online imports.

See "Working with Oracle OLAP Data Sources” for information about
how data from Oracle OLAP data sources is modeled in the Physical
layer.

Note: Oracle Database data sources with the OLAP option can
contain both relational tables and multidimensional tables. However,
you should avoid having both table types in the same database object
in the Administration Tool, because you may need to specify
different database feature sets for the different table types.

For example, Oracle OLAP queries fail if the database feature GROUP_
BY_GROUPING_SETS_SUPPORTED is enabled. However, you may need
this feature enabled for Oracle Database relational tables.

As a best practice, create two separate database objects for relational
and multidimensional tables.
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Table 5-1 (Cont.) Multidimensional Connection Options

Connection Type

Description

Hyperion ADM

Provide the URL for the Hyperion Financial Management server,
including the driver and application name (cube name), in the
following format:

adm:native:HsvADMDriver: ip_or host:application_name
For example:
adm:native:HsvADMDriver:130.35.40.80:UCFHFM

You also need to enter a valid user name and password for your data
source.

Note that the JavaHost process must be running to import from
Hyperion Financial Management data sources, for both offline and
online imports.

See "Working with Hyperion Financial Management Data Sources"
for information about how data from Hyperion Financial
Management data sources is modeled in the Physical layer.

Note: Be sure to complete the preconfiguration steps described in
"Setting Up Hyperion Financial Management Data Sources" before
import.

SAP BW Native

Provide the following information:

= System IP or Hostname: The host name or IP address of the SAP
data server. This field corresponds to the parameter ashost in
the SAP/BW connect string.

= System Number: The SAP system number. This is a two-digit
number assigned to an SAP instance, also called Web
Application Server, or WAS. This field corresponds to the
parameter sysnr in the SAP/BW connect string.

= Client Number: The SAP client number. This is a three-digit
number assigned to the self-contained unit called Client in SAP.
A Client can be a training, development, testing, or production
client, or it can represent different divisions in a large company.
This field corresponds to the parameter client in the SAP/BW
connect string.

= Language: The SAP language code used when logging in to the
data source (for example, EN for English or DE for German).
This field corresponds to the parameter lang in the SAP/BW
connect string.

= Additional Parameters: Additional connection string parameters
in the format param=value. Delimit multiple parameters with a
colon. This field is optional.

s User Name: A valid user name for the data source.

= Password: The corresponding user password. The password is
case-sensitive.

The first five fields constitute the elements of the SAP/BW connect
string, in the format:

ashost=value:sysnr=value:client=value:lang=value:additional
_param=value

For example:
ashost=10.30.0.19:sysnr=00:client=100:1lang=EN

Note: Be sure to complete the preconfiguration steps described in
"Setting Up SAP/BW Data Sources" before import.

Other data source types are described in other sections:
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s See "Importing Metadata from XML Data Sources" for XML.

= See "Importing Metadata from Relational Data Sources" for ODBC 2.0, OCI
10g/11g, and DB2 CLI (Unicode).

= See Chapter 6, "Working with ADF Data Sources" for OracleADF_HTTP.

When you have finished providing information in the Select Data Source screen,
click Next.

3. For Oracle RPAS data sources only, the Select Metadata Types screen is displayed.
For Oracle RPAS, select Tables, Keys, and Foreign Keys. Then, click Next.

See "About Importing Metadata from Oracle RPAS Data Sources" for more
information.

4. In the Select Metadata Objects screen, select the objects you want to import in the
Available list and move them to the Selected list, using the > (Import selected) or
>> (Import all) buttons. You can also move objects from the Selected list back to
the Available list, using the < (Remove selected) and << (Remove all) buttons.

To search for a particular item, enter a keyword in the Find box and then click
Find Down or Find Up.

Select Show complete structure to view all objects, including those that have
already been imported. Deselecting this option shows only the objects that are
available for import. When this option is selected, objects that have already been
imported appear grayed out

For Essbase data sources, select Import UDAs if you want to import UDAs
(user-defined attributes).

5. Click Finish.

If some objects could not be imported, a list of warning messages appears. In the
dialog displaying the messages, you can perform the following actions:

- To search for specific terms, click Find and then Find Again.

- To copy the contents of the window so that you can paste the messages in
another file, click Copy.

After you import metadata, you should check to ensure that your database and
connection pool settings are correct. In rare cases, the Oracle Bl Server cannot
determine the exact database type during import and instead assigns an approximate
type to the database object. See "Setting Up Database Objects" and "Creating or
Changing Connection Pools" for more information about working with these objects.

It is also a good practice to visually inspect the imported data in the Physical layer,
such as physical columns and hierarchical levels, to ensure that the import completed
successfully.

For Essbase data sources, all hierarchies are imported as Unbalanced by default.
Review the Hierarchy Type property for each physical hierarchy and change the value
if necessary. Supported hierarchy types for Essbase are Unbalanced, Fully balanced,
and Value.

About Importing Metadata from Oracle RPAS Data Sources

This section provides important information about using the Administration Tool to
import metadata from Oracle RPAS, as follows:

= Oracle RPAS schemas can only be imported on Windows.
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= Before you import RPAS schemas, you must set the Normalize Dimension Tables
field value in the ODBC DSN Setup page to Yes for the following reasons:

- Setting this value to Yes uses an appropriate schema model (the snowflake
schema) that creates joins correctly and enables drill down in the data.

- Setting this value to No uses a less appropriate schema model (the star
schema) that creates joins between all of the tables, causing drill down to not
work correctly. Many of the joins created in this way are unwanted, and
would need to be removed manually.

See "Setting Up ODBC Data Source Names (DSNs)" for more information.

= When you import RPAS schemas in the Administration Tool, you must import the
data with joins. To do this, select the metadata types Keys and Foreign Keys in the
Import Metadata Wizard.

= After you have imported RPAS schemas, you must change the Normalize
Dimension Tables field value in the ODBC DSN Setup page back to No. You need
to revert this setting back to No after import to enable the Oracle BI Server to
correctly generate optimized SQL against the RPAS driver.

Note: If you do not change the Normalize Dimension Tables setting value to No,
most queries will fail with an error message similar to the following:

[nQSError: 16001] ODBC error state: S0022 code: 0 message: [Oracle Retail] [RPAS
ODBC]Column:YEAR_LABEL not found..[nQSError: 16014] SQL statement preparation
failed. Statement execute failed.

= If Oracle RPAS is the only data source, you must set the value of NULL_VALUES_
SORT_FIRST to ON in the NQSConfig.INI file. See Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for more
information about setting values in NQSConfig.INL

Importing Metadata from XML Data Sources

This section describes how to import metadata from Extensible Markup Language
(XML) documents. XML is the universal format for structured documents and data on
the Web. It can also be used as a database to store structured data.

The Oracle BI Server supports two XML access modes: access through the Oracle BI
Server XML Gateway, and access through an XML ODBC driver.

This section contains the following topics:

= About Using XML as a Data Source

s Importing Metadata from XML Data Sources Using the XML Gateway
s Importing Metadata from XML Data Sources Using XML ODBC

»  Examples of XML Documents

About Using XML as a Data Source

The Oracle BI Server supports the use of XML data as a data source for the Physical
layer in the repository. Depending on the method used to access XML data sources, a
data source may be represented by a URL pointing to one of the following sources:

s A static XML file or HTML file that contains XML data islands on the Internet
(including intranet or extranet). For example:

tap://216.217.17.176 /[ DEOA48DE-1C3E-11D4-97C9-00105A A70303]. XML
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s Dynamic XML generated from a server site. For example:
tap://www.aspserver.com/example.asp

s An XML file or HTML file that contains XML data islands on a local or network
drive. For example:

d:/xmldir/example.xml
d:/htmldir/island.htm

You can also specify a directory path for local or network XML files, or you can
use the asterisk ( * ) as a wildcard with the filenames. If you specify a directory
path without a filename specification (like d:/xmldir), all files with the XML suffix
are imported. For example:

d:/xmldir/
d:/xmldir/exam*.xml
d:/htmldir/exam*.htm
d:/htmldir/exam*.html

= An HTML file that contains tables, defined by a pair of <table> and </table> tags.
The HTML file may reside on the Internet (including intranet or extranet), or on a
local or network drive. See "Accessing HTML Tables" for more information.

URLs can include repository or session variables, providing support for HTTP data
sources that accept user IDs and passwords embedded in the URL. For example:

http://somewebserver/cgi.pl?userid=valueof (session_variablel) &password=
valueof (session_variable2)

This functionality also lets you create an XML data source with a location that is
dynamically determined by some run-time parameters. For more information about
variables, see Chapter 19.

If the Oracle BI Server needs to access any nonlocal files (network files or files on the
Internet, for example), you must run the Oracle BI Server using a valid user ID and
password with sufficient network privileges to access these remote files.

Importing Metadata from XML Data Sources Using the XML Gateway

Using the Oracle Bl Server XML Gateway, the metadata import process flattens the
XML document to a tabular form using the stem of the XML filename (that is, the
filename without the suffix) as the table name and the second level element in the
XML document as the row delimiter. All leaf nodes are imported as columns
belonging to the table. The hierarchical access path to leaf nodes is also imported.

The Oracle BI Server XML Gateway uses the metadata information contained in an
XML schema. The XML schema is contained within the XML document, or is
referenced within the root element of the XML document.

Where there is no schema available, all XML data is imported as text data. In building
the repository, you can alter the data types of the columns in the Physical layer,
overriding the data types for the corresponding columns defined in the schema. The
gateway converts the incoming data to the desired type as specified in the Physical
layer. You can also map the text data type to other data types in the Business Model
and Mapping layer of the Administration Tool, using the CAST operator.

The Oracle BI Server XML Gateway does not support:
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= Resolution of external references contained in an XML document (other than a
reference to an external XML schema, as demonstrated in the example file in
"Examples of XML Documents Generated by the Oracle BI Server XML Gateway").

s Element and attribute inheritance contained within the Microsoft XML schema.

= Element types of a mixed content model (such as XML elements that contain a
mixture of elements and CDATA, such as <p> hello <b>Joe</b>, how are you
doing?</p>).

To import XML data using the Oracle BI Server XML Gateway:

1. In the Administration Tool, select File, then select Import Metadata. The Import
Metadata Wizard appears.

Note: If you have already defined an existing database and
connection pool, you can right-click the connection pool in the
Physical layer and select Import Metadata. The Import Metadata
Wizard appears with the information on the Select Data Source screen
pre-filled.

Figure 5-3 shows the Import Metadata Wizard.

Figure 5-3 Import Metadata Wizard: XML Data Source
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Shows the Import Metadata Wizard in the Administration Tool, for an XML data
source.
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Note that the Map to Logical Model and Publish to Warehouse screens are
available only for ADF data sources. "About the Map to Logical Model and
Publish to Warehouse Screens" for more information.

2. In the Select Data Source screen, select XML for Connection Type. Then, provide
the following values:
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s For URL, specify the XML data source URL. The Oracle BI Server XML
Gateway supports all data sources described in the previous section.

URLs can include repository or session variables. For more information about
variables, see Chapter 19.

If you click Browse, the Select XML File dialog appears, from which you can
select a single file. For XML documents, the file name in the URL that you
specify must have the suffix .xml. Otherwise, the documents are treated as
HTML documents.

= Type an optional user name and password in the appropriate fields for
connections to HTTP sites that employ the HTTP Basic Authentication security
mode.

In addition to HTTP Basic Authentication security mode, the Oracle BI Server
XML Gateway also supports Secure HTTP protocol and Integrated Windows
Authentication (for Windows 2000), formerly called NTLM or Windows NT
Challenge/Response authentication.

When you have finished providing information in the Select Data Source screen,
click Next. The Select Metadata Types screen appears.

3. Select the options for the types of objects that you want to import (for example,
Tables, Keys, and Foreign Keys). The most typical options are automatically
selected.

If you want to import joins, select both Keys and Foreign Keys. If you want to
import system tables, you must have the system privilege for your data source.

4. Click Next. The Select Metadata Objects screen appears.

5. Select the objects you want to import in the Available list and move them to the
Selected list, using the > (Import selected) or >> (Import all) buttons. You can also
move objects from the Selected list back to the Available list, using the < (Remove
selected) and << (Remove all) buttons.

To search for a particular item, enter a keyword in the Find box and then click
Find Down or Find Up.

Select Show complete structure to view all objects, including those that have
already been imported. Deselecting this option shows only the objects that are
available for import. When this option is selected, objects that have already been
imported appear grayed out.

6. Click Finish.

After you import XML data, you must adjust connection pool settings. See "Creating
or Changing Connection Pools" for complete information. Minimally, you can do the
following:

= In the Connection Pool dialog, type a name and optional description for the
connection on the General tab.

s Click the XML tab to set additional connection properties, including the URL
refresh interval and the length of time to wait for a URL to load before timing out.

Because XML data sources are typically updated frequently and in real time, you
can specify a refresh interval for Oracle BI Server XML Gateway data sources. The
default timeout interval for queries (URL loading time-out) is 15 minutes. For
more information, see "About the Refresh Interval for XML Data Sources" in Oracle
Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition.
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Examples of XML Documents Generated by the Oracle Bl Server XML Gateway

Example 5-1 and Example 5-2 show sample XML documents and the corresponding
columns that are generated by the Oracle BI Server XML Gateway.

Example 5-1 XML Schema Contained in an External File

The following sample XML data document (mytest.xml) references an XML schema
contained in an external file. The schema file is shown following the data document.
The generated XML schema information available for import to the repository is
shown at the end.

<?xml version="1.0"?>
<test xmlns="x-schema:mytest_sch.xml">

<row>
<pl>0</pl>
<p2 width="5">
<p3>hi</p3>
<p4d>
<pb>xx0</pb6>
<p7>yy0</p7>
</pd>
<p5>zz0</p5>
</p2>
</row>

<row>
<pl>1</pl>
<p2 width="6">
<p3>how are you</p3>
<p4d>
<pb>xx1</pb>
<p7>yyl</p7>
</pd>
<p5>zz1</p5>
</p2>
</row>

<row>
<pl>a</pl>
<p2 width="7">
<p3>hi</p3>
<p4d>
<pPb6>XX2</p6>
<p7>yy2</pT>
</pd>
<p5>zz2</p5>
</p2>
</row>

<row>
<pl>b</pl>
<p2 width="8">
<p3>how are they</p3>
<pd>
<pb>xx3</p6>
<p7>yy3</pT>
</p4>
<p5>zz2</p5>
</p2>
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</row>
</test>

The corresponding schema file follows:

<Schema xmlns="urn:schemas-microsoft-com:xml-data"
xmlns:dt="urn:schemas-microsoft-com:datatypes">
<ElementType name="test" content="eltOnly" order="many">
<element type="row"/>
</ElementType>
<ElementType name="row" content="eltOnly" order="many">
<element type="pl"/>
<element type="p2"/>
</ElementType>
<ElementType name="p2" content="eltOnly" order="many">
<AttributeType name="width" dt:type="int" />
<attribute type="width" />
<element type="p3"/>
<element type="p4"/>
<element type="p5"/>
</ElementType>
<ElementType name="p4" content="eltOnly" order="many">
<element type="p6"/>
<element type="p7"/>
</ElementType>
<ElementType name="pl" content="textOnly" dt:type="string"/>
<ElementType name="p3" content="textOnly" dt:type="string"/>
<ElementType name="p5" content="textOnly" dt:type="string"/>
<ElementType name="p6" content="textOnly" dt:type="string"/>
<ElementType name="p7" content="textOnly" dt:type="string"/>
</Schema>

The name of the table generated from the preceding XML data document (mytest.xml)
would be mytest and the column names would be pl, p3, p6, p7, p5, and width.

In addition, to preserve the context in which each column occurs in the document and
to distinguish between columns derived from XML elements with identical names but
appearing in different contexts, a list of fully qualified column names is generated,
based on the XPath proposal of the World Wide Web Consortium, as follows:

//test/row/pl
//test/row/p2/p3
//test/row/p2/pld/pb
//test/row/p2/pd/p7
//test/row/p2/p5
//test/row/p2@width

Example 5-2 Nested Table Structures in an XML Document

The following example is a more complex example that demonstrates the use of nested
table structures in an XML document. You can optionally omit references to an
external schema file, in which case all elements are treated as being of the Varchar
character type.

===Invoice.xml===
<INVOICE>
<CUSTOMER>
<CUST_ID>1</CUST_ID>
<FIRST_NAME>Nancy</FIRST NAME>
<LAST_NAME>Fuller</LAST NAME>
<ADDRESS>
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<ADD1>507 - 20th Ave. E.,</ADD1>
<ADD2>Apt. 2A</ADD2>
<CITY>Seattle</CITY>
<STATE>WA</STATE>
<ZIP>98122</ZIP>

</ADDRESS>

<PRODUCTS>

<CATEGORY>
<CATEGORY_ID>CAT1</CATEGORY_ID>

<CATEGORY_NAME>NAME1</CATEGORY_NAME>

<ITEMS>
<ITEM>
<ITEM_ID>1</ITEM_ID>
<NAME>< /NAME>
<PRICE>0.50</PRICE>
<QTY>2000</QTY>
</ITEM>
<ITEM>
<ITEM_ID>2</ITEM_ID>
<NAME>SPRITE</NAME>
<PRICE>0.30</PRICE>
<QTY></QTY>
</ITEM>
</ITEMS>
</CATEGORY>
<CATEGORY>
<CATEGORY_ID>CAT2</CATEGORY_ID>

<CATEGORY_NAME>NAME2</CATEGORY_NAME>

<ITEMS>
<ITEM>
<ITEM_ID>11</ITEM_ID>
<NAME>ACOKE</NAME>
<PRICE>1.50</PRICE>
<QTY>3000</QTY>
</ITEM>
<ITEM>
<ITEM_ID>12</ITEM_ID>
<NAME>SOME SPRITE</NAME>
<PRICE>3.30</PRICE>
<QTY>2000</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
</PRODUCTS>

</CUSTOMER>
<CUSTOMER>

<CUST_ID>2</CUST_ID>
<FIRST NAME>Andrew</FIRST NAME>
<LAST NAME>Carnegie</LAST NAME>
<ADDRESS>
<ADD1>2955 Campus Dr.</ADD1>
<ADD2>Ste. 300</ADD2>
<CITY>San Mateo</CITY>
<STATE>CA</STATE>
<7ZIP>94403</ZIP>
</ADDRESS>
<PRODUCTS>
<CATEGORY>

<CATEGORY_ID>CAT22</CATEGORY_ID>

<CATEGORY_NAME>NAMEA1</CATEGORY_NAME>
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<ITEMS>
<ITEM>
<ITEM_ID>122</ITEM_ID>
<NAME>DDDCOKE< /NAME>
<PRICE>11.50</PRICE>
<QTY>2</QTY>
</ITEM>
<ITEM>
<ITEM_ID>22</ITEM_ID>
<NAME>PSPRITE</NAME>
<PRICE>9.30</PRICE>
<QTY>1978</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
<CATEGORY>
<CATEGORY_ID>CAT24</CATEGORY_ID>
<CATEGORY_NAME>NAMEA2</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>19</ITEM_ID>
<NAME>SOME COKE</NAME>
<PRICE>1.58</PRICE>
<QTY>3</QTY>
</ITEM>
<ITEM>
<ITEM_ID>15</ITEM_ID>
<NAME>DIET SPRITE</NAME>
<PRICE>9.30</PRICE>
<QTY>12000</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
</PRODUCTS>
</CUSTOMER>
<CUSTOMER>
<CUST_ID>3</CUST_ID>
<FIRST_NAME>Margaret</FIRST_NAME>
<LAST_NAME>Leverling</LAST_NAME>
<ADDRESS>
<ADD1>722 Moss Bay Blvd.</ADD1>
<ADD2> </ADD2>
<CITY>Kirkland</CITY>
<STATE>WA</STATE>
<7ZIP>98033</ZIP>
</ADDRESS>
<PRODUCTS>
<CATEGORY>
<CATEGORY_ID>CAT31</CATEGORY_ID>
<CATEGORY_NAME>NAMEA3</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>13</ITEM_ID>
<NAME>COKE33</NAME>
<PRICE>30.50</PRICE>
<QTY>20033</QTY>
</ITEM>
<ITEM>
<ITEM_ID>23</ITEM_ID>
<NAME>SPRITE33</NAME>
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<PRICE>0.38</PRICE>
<QTY>20099</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
<CATEGORY>
<CATEGORY_ID>CAT288</CATEGORY_ID>
<CATEGORY_NAME>NAME H</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>19</ITEM_ID>
<NAME>COLA< /NAME>
<PRICE>1.0</PRICE>
<QTY>3</QTY>
</ITEM>
<ITEM>
<ITEM_ID>18</ITEM_ID>
<NAME>MY SPRITE</NAME>
<PRICE>8.30</PRICE>
<QTY>123</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
</PRODUCTS>
</CUSTOMER>
</INVOICE>

The generated XML schema consists of one table (INVOICE) with the following column
names and their corresponding fully qualified names.

Column Fully Qualified Name

ADD1 / /INVOICE/CUSTOMER/ADDRESS/ADD1
ADD2 / /INVOICE /CUSTOMER/ADDRESS/ADD2
CITY //INVOICE/CUSTOMER/ADDRESS/CITY
STATE //INVOICE/CUSTOMER/ADDRESS/STATE
VAlY / /INVOICE/CUSTOMER /ADDRESS/ZIP
CUST_ID //INVOICE/CUSTOMER/CUST_ID
FIRST_NAME //INVOICE/CUSTOMER /FIRST_NAME
LAST_NAME //INVOICE/CUSTOMER/LAST_NAME

CATEGORY_ID

/ /INVOICE/CUSTOMER/PRODUCTS/CATEGORY /CATEGORY _
1D

CATEGORY_NAME

/ /INVOICE/CUSTOMER/PRODUCTS/CATEGORY /CATEGORY_
NAME

ITEM_ID //INVOICE/CUSTOMER/PRODUCTS/CATEGORY /ITEMS/ITEM
/ITEM_ID

NAME //INVOICE/CUSTOMER/PRODUCTS/CATEGORY /ITEMS/ITEM
/NAME

PRICE //INVOICE/CUSTOMER/PRODUCTS/CATEGORY /ITEMS/ITEM
/PRICE

QTY //INVOICE/CUSTOMER /PRODUCTS/CATEGORY /ITEMS/ITEM

/QTY
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Only tags with values are extracted as columns. An XML query generates fully
qualified tag names, to help ensure appropriate columns are retrieved.

The following shows the results of a sample query against the INVOICE table:

SELECT first_name, last_name, price, gty, name FROM invoice

FIRST_NAME LAST NAME PRICE QTY NAME

Andrew Carnegie 1.58 3 SOME COKE
Andrew Carnegie 11.50 2 DDDCOKE
Andrew Carnegie 9.30 12000 DIET SPRITE
Andrew Carnegie 9.30 1978 PSPRITE
Margar Leverling 0.38 20099 SPRITE33
Margar Leverling 1.0 3 COLA

Margar Leverling 30.50 20033 COKE33
Margar Leverling 8.30 123 MY SPRITE
Nancy Fuller 0.30 SPRITE
Nancy Fuller 0.50 2000

Nancy Fuller 1.50 3000 ACOKE
Nancy Fuller 3.30 2000 SOME SPRITE

Row count: 12

Accessing HTML Tables

The Oracle BI Server XML Gateway also supports the use of tables in HTML files as a
data source. The HTML file can be identified as a URL pointing to a file on the internet
(including intranet or extranet) or as a file on a local or network drive.

Even though tables, defined by the <table> and </table> tag pair, are native
constructs of the HTML 4.0 specification, they are often used by Web designers as a
general formatting device to achieve specific visual effects rather than as a data
structure. The Oracle BI Server XML Gateway is currently the most effective in
extracting tables that include specific column headers, defined by <th> and </th> tag
pairs.

For tables that do not contain specific column headers, the Oracle BI Server XML
Gateway employs some simple heuristics to make a best effort to determine the
portions of an HTML file that appear to be genuine data tables.

The following is a sample HTML file with one table.

<html>
<body>
<table border=1 cellpadding=2 cellspacing=0>
<tr>
<th colspan=1>Transaction</th>
<th colspan=2>Measurements</th>
</tr>
<tr>
<th>Quality</th>
<th>Count</th>
<th>Percent</th>
</tr>
<tr>
<td>Failed</td>
<td>66,672</td>
<td>4.1%</td>
</tr>
<tr>
<td>Poor</td>
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<td>126,304</td>
<td>7.7%</td>

</tr>

<tr>
<td>Warning</td>
<td>355,728</td>
<td>21.6%</td>

</tr>

<tr>
<td>0K</td>
<td>1,095,056</td>
<td>66.6%</td>

</tr>

<tr>
<td colspan=1>Grand Total</td>
<td>1,643,760</td>
<td>100.0%</td>

</tr>

</table>
</body>
</html>

The table name is derived from the HTML filename, and the column names are
formed by concatenating the headings (defined by the <th> and </th> tag pairs) for
the corresponding columns, separated by an underscore.

Assuming that our sample file is named 18.htm, the table name would be 18_0
(because it is the first table in that HTML file), with the following column names and
their corresponding fully qualified names:

Column Fully Qualified Name
Transaction_Quality \\18_0\Transaction_Quality
Measurements_Count \\18_0\Measurements_Count
Measurements_Percent \\18_0\Measurements_Percent

If the table column headings appear in more than one row, the column names are
formed by concatenating the corresponding field contents of those header rows.

For tables without any heading tag pairs, the Oracle Bl Server XML Gateway assumes
the field values (as delimited by the <td> and </td> tag pairs) in the first row to be the
column names. The columns are named by the order in which they appear (c0, c1, and
SO on).

See "Importing Metadata from XML Data Sources Using XML ODBC" and "Examples
of XML Documents" for additional XML examples.

Importing Metadata from XML Data Sources Using XML ODBC

Using the XML ODBC database type, you can access XML data sources through an
ODBC interface. The data types of the XML elements representing physical columns in
physical tables are derived from the data types of the XML elements as defined in the
XML schema. In the absence of a proper XML schema, the default data type of string is
used. Data Type settings in the Physical layer do not override those defined in the
XML data sources. When accessing XML data without XML schema, use the CAST
operator to perform data type conversions in the Business Model and Mapping layer
of the Administration Tool.
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To import XML data using ODBC:

1. To access XML data sources through ODBC, you first need to license and install an
XML ODBC driver.

2. Create ODBC DSNs that point to the XML data sources you want to access,
making sure you select the XML ODBC database type.

3. In the Administration Tool, select File, then select Import Metadata.

4. Follow the instructions in the dialogs to import the ODBC DSNs into the
repository. See "Importing Metadata from Relational Data Sources" for more
information.

Caution: Due to XML ODBC limitations, you must select the
Synonyms option in the Select Metadata Types screen, or no tables are
imported.

Example of an XML ODBC Data Source

Example 5-3 shows an example of an XML ODBC data source in the Microsoft ADO
persisted file format. Both the data and the schema could be contained inside the same
document.

Example 5-3 XML ODBC Example

<xml xmlns:s='uuid:BDC6E3F0-6DA3-11d1-A2A3-00AA00C14882"
xmlns:dt="uuid:C2F41010-65B3-11d1-A29F-00AA00C14882"
xmlns:rs='urn:schemas-microsoft-com:rowset'
xmlns:z="'4#RowsetSchema'>
<s:Schema id='RowsetSchema'>
<s:ElementType name='row' content='eltOnly' rs:CommandTimeout='30"
rs:updatable='true'>
<s:AttributeType name='ShipperID' rs:number='1l' rs:writeunknown='true'
rs:basecatalog='Paint' rs:basetable='Shippers' rs:basecolumn='ShipperID'>
<s:datatype dt:type='i2' dt:maxLength='2' rs:precision='5"
rs:fixedlength="'true' rs:benull='false'/>
</s:AttributeType>
<s:AttributeType name='CompanyName' rs:number='2' rs:writeunknown='true'
rs:basecatalog='Paint' rs:basetable='Shippers' rs:basecolumn='CompanyName'>
<s:datatype dt:type='string' rs:dbtype='str' dt:maxLength='40"
rs:benull="'false'/>
</s:AttributeType>
<s:AttributeType name='Phone' rs:number='3"' rs:nullable='true’
rs:writeunknown='true' rs:basecatalog='Paint' rs:basetable='Shippers'
rs:basecolumn="'Phone' >
<s:datatype dt:type='string' rs:dbtype='str' dt:maxLength='24"
rs:fixedlength="true'/>
</s:AttributeType>
<s:extends type='rs:rowbase'/>
</s:ElementType>
</s:Schema>
<rs:data>
<z:row ShipperID='1' CompanyName='Speedy Express' Phone='(503)
555-9831 '/>
<z:row ShipperID='2' CompanyName='United Package' Phone="'(503)
555-3199 V>
<z:row ShipperID='3' CompanyName='Federal Shipping' Phone="'(503)
555-9931 V>
</rs:data>
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</xml>

Examples of XML Documents

The following XML documents provide examples of several different situations and
explain how the Oracle BI Server XML access method handles those situations.

The XML documents 83.xml and 8_sch.xml (shown in Example 54 and
Example 5-5) demonstrate the use of the same element declarations in different
scope. For example, <p3> could appear within <p2> as well as within <p4>.

Because the element <p3> in the preceding examples appears in two different
scopes, each element is given a distinct column name by appending an index
number to the second occurrence of the element during the import process. In this
case, the second occurrence becomes p3_1. If <p3> occurs in additional contexts,
they become p3_2, p3_3.

The XML documents 83.xml and 84.xml (shown in Example 54 and Example 5-6)
demonstrate that multiple XML files can share the same schema (8_sch.xml).

Internet Explorer version 5 and higher supports HTML documents containing
embedded XML fragments called XML islands. The XML document island2.htm
(shown in Example 5-7) demonstrates a simple situation where multiple XML
data islands, and therefore multiple tables, could be generated from one
document. One table is generated for each instance of an XML island. Tables are
distinguished by appending an appropriate index to the document name. For
island2.htm, the two XML tables generated would be island2_0 and island2_1.

Example 5-4 83.xml

===83.xml===

<?xml version="1.0"?>

<test xmlns:"x—schema:8_sch.xm1">|
<row>

<pl>0</pl>

<p2 width="5" height="2">

<p3>hi</p3>
<pd>
<p3>hi</p3>
<pb6>xx0</pb>
<p7>yy0</p7>
</pd>
<p5>zz0</p5>

</p2>
</row>

<row>
<pl>1</pl>
<p2 width="6" height="3">

<p3>how are you</p3>
<p4d>
<p3>hi</p3>
<p6>xx1</p6>
<p7>yyl</pT7>
</pd>
<p5>zzl1</p5>

</p2>
</row>
</test>
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Example 5-5 8_sch.xml

===8_sch.xml===
<Schema xmlns="urn:schemas-microsoft-com:xml-data"
xmlns:dt="urn:schemas-microsoft-com:datatypes">
<AttributeType name="height" dt:type="int" />
<ElementType name="test" content="eltOnly" order="many">
<AttributeType name="height" dt:type="int" />
<element type="row"/>
</ElementType>
<ElementType name="row" content="eltOnly" order="many">
<element type="pl"/>
<element type="p2"/>
</ElementType>
<ElementType name="p2" content="eltOnly" order="many">
<AttributeType name="width" dt:type="int" />
<AttributeType name="height" dt:type="int" />
<attribute type="width" />
<attribute type="height" />
<element type="p3"/>
<element type="p4"/>
<element type="p5"/>
</ElementType>
<ElementType name="p4" content="eltOnly" order="many">
<element type="p3"/>
<element type="p6"/>
<element type="p7"/>
</ElementType>
<ElementType name="test0" content="eltOnly" order="many">
<element type="row"/>
</ElementType>
<ElementType name="pl" content="textOnly" dt:type="string"/>
<ElementType name="p3" content="textOnly" dt:type="string"/>
<ElementType name="p5" content="textOnly" dt:type="string"/>
<ElementType name="p6" content="textOnly" dt:type="string"/>
<ElementType name="p7" content="textOnly" dt:type="string"/>
</Schema>

Example 5-6 84.xml

===84.xml===
<?xml version="1.0"?>
<test(0 xmlns="x-schema:8_sch.xml">
<row>
<pl>0</pl>
<p2 width="5" height="2">
<p3>hi</p3>
<p4d>
<p3>hi</p3>
<p6>xx0</p6>
<p7>yy0</p7>
</pd>
<p5>zz0</p5>
</p2>
</row>

<row>

<pl>1</pl>

<p2 width="6" height="3">
<p3>how are you</p3>
<p4d>
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<p3>hi</p3>
<p6>xx1</p6>
<p7>yyl</p7>
</pd>
<p5>zzl</p5>
</p2>
</row>
</test0>

Example 5-7 Island2.htm

===igland2.htm===
<HTML>
<HEAD>
<TITLE>HTML Document with Data Island</TITLE>
</HEAD>
<BODY>
<p>This is an example of an XML data island in I.E. 5</p>
<XML ID="12345">
test>
<row>
<fieldl>00</fieldl>
<field2>01</field2>
</row>
<row>
<fieldl>10</fieldl>
<field2>11</field2>
</row>
<row>
<fieldl1>20</fieldl>
<field2>21</field2>
</row>
</test>
</XML>
<p>End of first example.</p>
<XML ID="12346">
<test>
<row>
<fieldl1>00</fieldll>
<fieldl2>01</fieldl2>
</row>
<row>
<fieldl1>10</fieldll>
<fieldl2>11</field12>
</row>
<row>
<fieldl1>20</fieldll>
<fieldl2>21</field12>
</row>
</test>
</XML>
<p>End of second example.</p>
</BODY>
</HTML>

Using a Standby Database with Oracle Business Intelligence

A standby database is used mainly for its high availability and failover functions as a
backup for the primary database. In a standby database configuration, there is
regularly scheduled replication from the primary database to the secondary database.
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The latency of this replication must be short enough that writing to the primary
database while reading from the secondary database does not cause any
synchronization or data integrity problems.

Because a standby database is essentially a read-only database, it can be used as a
business intelligence query server, relieving the workload of the primary database and
improving query performance.

The following sections explain how to use a standby database with Oracle Business
Intelligence:

= About Using a Standby Database with Oracle Business Intelligence

s Creating the Database Object for the Standby Database Configuration
s Creating Connection Pools for the Standby Database Configuration

s Updating Write-Back Scripts in a Standby Database Configuration

s Setting Up Usage Tracking in a Standby Database Configuration

= Setting Up Event Polling in a Standby Database Configuration

s Setting Up Oracle BI Scheduler in a Standby Database Configuration

About Using a Standby Database with Oracle Business Intelligence

In a standby database configuration, you have two databases: a primary database that
handles all write operations and is the source of truth for data integrity, and a
secondary database that is exposed as a read-only source. When you use a standby
database configuration with Oracle Business Intelligence, all write operations are
offloaded to the primary database, and read operations are sent to the standby
database.

Write operations that need to be routed to the primary source may include the
following:

s Oracle BI Scheduler job and instance data

s Temporary tables for performance enhancements

= Writeback scripts for aggregate persistence

s Usage tracking data, if usage tracking has been enabled

= Event polling table data, if event polling tables are being used

The following list provides an overview of how to configure the Oracle BI Server to
use a standby database:

1. Create a single database object for the standby database configuration, with
temporary table creation disabled.

2. Configure two connection pools for the database object:
= A read-only connection pool that points to the standby database

= A second connection pool that points to the primary database for write
operations

3. Update any connection scripts that write to the database so that they explicitly
specify the primary database connection pool.

4. If usage tracking has been enabled, update the usage tracking configuration to use
the primary connection.
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5. If event polling tables are being used, update the event polling database
configuration to use the primary connection.

6. Ensure that Oracle BI Scheduler is not configured to use any standby sources.

Even though there are two separate physical data sources for the standby database
configuration, you create only one database object in the Physical layer. Figure 54
shows the database object and connection pools for the standby database
configuration in the Physical layer.

Figure 5-4 Standby Database Configuration in the Physical Layer
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Creating the Database Object for the Standby Database Configuration

Use the Administration Tool to create a database object in the repository for the
standby database configuration. When you create the database object, make sure that
the persist connection pool is not assigned, to prevent the Oracle BI Server from
creating temporary tables in the standby database.

To create a database object for the standby database configuration:

1. In the Administration Tool, right-click the Physical layer and select New
Database.

2. Provide a name for the database, and then select the type of database in the
Database list.

3. Ensure that the Persist connection pool is "not assigned.”

Figure 5-5 shows the Database dialog for a standby database configuration.
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Figure 5-5 Database Dialog for Standby Database Configuration
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Creating Connection Pools for the Standby Database Configuration

After you have created a database object in the repository for the standby database
configuration, use the Administration Tool to create two connection pools: one that
points to the standby database, and another that points to the primary database.

Because the standby connection pool is used for the majority of connections, make
sure that the standby connection pool is listed first.

Note: Connection pools are used in the order listed, until the
maximum number of connections is achieved. Ensure that the
maximum number of connections is set in accordance with the
standby database tuning.

See "Creating or Changing Connection Pools" for more information
about setting the maximum number of connections.

To create a standby connection pool for the standby database configuration:

1. In the Administration Tool, in the Physical layer, right-click the database object for
the standby database configuration and select New Object, then select
Connection Pool.

2. Provide a name for the connection pool, and ensure that the call interface is
appropriate for the standby database type.

3. Provide the Data source name for the standby database.
4. Enter a user name and password for the standby database.
5. Click OK.

Figure 5-6 shows the Connection Pool dialog for the standby connection pool.
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Figure 5-6 Connection Pool Dialog for Standby Connection Pool

Connection Pool - Standby Connection 10l =|

General | Connection Scriptsl HML I ‘wiite Back | Mizcellaneous I

Mame: IStandby Connection Permiszions... |

Call interface: IDefauIt [OCI 10a/114) j

M arimum connections: I 103:

™ Require fully qualified table names

[rata source name: Imy_ds_name

V¥ Shared logon

Uszer name: I Password: I

V¥ Enable connection podling
Timeout: |5 I [minutes] j

¥ Use multithreaded connections

¥ Parameters supported

Izolation level: I Default j
Description:
=
[

QK I Cancel | Help |

Shows the connection pool dialog for the standby connection pool.
O34 6 636 6 3 3 3 3 3 3 30 30 3 e e 4 e 6 6 36 3 3 3 3 3 3 30 3 30 4 e e 4 e e 636 6 3 3 3 3 3 30 30 e e 4 e 4 4 6 3 3 3 3 3 3 3 3 3 3 0 e e 4 4 e 3 2 S S A A A A e S AN
To create the primary connection pool for the standby database configuration:

1. In the Administration Tool, in the Physical layer, right-click the database object for
the standby database configuration and select New Object, then select
Connection Pool.

2. Provide a name for the connection pool, and ensure that the call interface is
appropriate for the primary database type.

3. Provide the Data source name for the primary database.
4. Enter a user name and password for the primary database.
5. Click OK.

Figure 5-7 shows the Connection Pool dialog for the primary connection pool.
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Figure 5-7 Connection Pool Dialog for Primary Connection Pool
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Updating Write-Back Scripts in a Standby Database Configuration

If you use scripts that write to the database, such as scripts for aggregate persistence,
you must update the scripts to explicitly refer to the primary connection pool.
Information written through the primary connection will be automatically transferred
to the standby database (through the regularly scheduled replication between the
primary and secondary databases), and will become available through the standby
connection pool.

The following example shows a writeback script for aggregate persistence that
explicitly specifies the primary connection pool:

create aggregates sc_rev_gty_yr_cat for "DimSnowflakeSales"."SalesFacts"
("Revenue", "QtySold") at levels ("DimSnowflakeSales"."Time"."Year",
"DimSnowflakeSales"."Product"."Category") using connection pool
"StandbyDemo" . "Primary Connection" in "StandbyDemo"."My_ Schema"

Setting Up Usage Tracking in a Standby Database Configuration

The Oracle BI Server supports the collection of usage tracking data. When usage
tracking is enabled, the Oracle BI Server collects usage tracking data for each query
and writes statistics to a usage tracking log file or inserts them directly to a database
table.

If you want to enable usage tracking on a standby database configuration using direct
insertion, you must create the table used to store the usage tracking data (typically S_
NQ_ACCT) on the primary database. Then, import the table into the physical layer of the
repository using the Administration Tool.
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You must ensure that the database object for the usage tracking table is configured
with both the standby connection pool and the primary connection pool. Then, ensure
that the CONNECTION_POOL parameter for usage tracking points to the primary
database. For example, in NQSConfig.ini:

CONNECTION_POOL = "StandbyDatabaseConfiguration"."Primary Connection";

See "Managing Usage Tracking" in Oracle Fusion Middleware System Administrator’s
Guide for Oracle Business Intelligence Enterprise Edition for full information about usage
tracking, including how to create tables for usage tracking data and how to set
parameters for usage tracking.

Setting Up Event Polling in a Standby Database Configuration

You can use an Oracle Bl Server event polling table (event table) as a way to notify the
Oracle BI Server that one or more physical tables have been updated. The event table
is a physical table that resides on a database accessible to the Oracle BI Server. It is
normally exposed only in the Physical layer of the Administration Tool, where it is
identified in the Physical Table dialog as an Oracle BI Server event table.

The Oracle BI Server requires write access to the event polling table. Because of this, if
you are using event polling in a standby database configuration, you must ensure that
the database object for the event table only references the primary connection pool.

See "Cache Event Processing with an Event Polling Table" in Oracle Fusion Middleware
System Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for full
information about event polling, including how to set up, activate, and populate event
tables.

Setting Up Oracle Bl Scheduler in a Standby Database Configuration

Oracle BI Scheduler is an extensible application and server that manages and
schedules jobs, both scripted and unscripted. To use Oracle BI Scheduler in a standby
database configuration, you must ensure that the database object for Oracle BI
Scheduler only references the primary connection pool.

See "Configuration Tasks for Oracle BI Scheduler" in Oracle Fusion Middleware
Scheduling Jobs Guide for Oracle Business Intelligence Enterprise Edition for full
information about setting up and using Oracle BI Scheduler.
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Working with ADF Data Sources

This chapter describes how to set up Oracle ADF Business Components for use with
Oracle Business Intelligence, and how to import metadata from ADF data sources.

Connecting to ADF data sources enables Oracle Business Intelligence users to query
data from any application that is built using the ADF Framework. For example,
because Oracle CRM applications are developed using the ADF Framework, Oracle
Business Intelligence users can report on CRM data using an ADF data source that
implements the required ADF Application Programming Interface (API).

By using the ADF components as a data source to the Oracle BI Server, users can
quickly integrate operational reporting with any application that is built on top of the
ADF Framework.

This chapter contains the following topics:

= What Are ADF Business Components?

= What Happens During Import?

= About Specifying a SQL Bypass Database

s Setting Up ADF Data Sources

»  Importing Metadata from ADF Data Sources

= Using the BI Extender to Propagate Flex Object Changes

s Setting Up and Using ApplCore Grants for ADF Data Security

= Enabling the Ability to Pass Custom Parameters to the ADF Application
= Propagating Labels and Tooltips from ADF Data Sources

What Are ADF Business Components?

Oracle Application Development Framework (Oracle ADF) is an object-relational
framework that can be used to create J2EE business services and expose underlying
database objects. This framework provides an abstraction layer that enables
application developers to build applications quickly and efficiently.

When you use Oracle ADF to build service-oriented Java EE applications, you
implement your core business logic as one or more business services. These back-end
services provide clients with a way to query, insert, update, and delete business data
as required, while enforcing appropriate business rules. ADF Business Components
are prebuilt application objects that provide a ready-to-use implementation of Java EE
design patterns and best practices.
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The ADF model is represented through the ADF Business Component constructs
called Entity Objects and View Objects, usually constructed and defined during design
time:

= Entity Objects: ADF framework components that represent a row in a database
table and simplify modifying its data. Importantly, it enables you to encapsulate
domain business logic for those rows to ensure your business policies and rules
are consistently validated.

= View Objects: ADF framework components that encapsulate a SQL query and
simplify working with its results. In addition to read-only view objects, there are
entity-based view objects that support updatable rows. The view object queries just
the data needed for the client-facing task at hand, then cooperates with one or
more entity objects in your business domain layer to automatically validate and
save changes made to its view rows. Like the read-only view object, an
entity-based view object encapsulates a SQL query, can be linked into
master/detail hierarchies using view links, and can be used in the data model of
your application modules.

Applications built using ADF obtain their data by querying the defined View
Objects using the ADF APlIs.

The ADF model also includes an application module, which is the transactional
component that Ul clients use to work with application data. It defines an updatable
data model along with top-level procedures and functions (called service methods)
related to a logical unit of work related to an end-user task.

The application module serves as a container for multiple View Objects and Entity
Objects, and also contains configuration related to the JDBC data source.

About Operational Reporting with ADF Business Components

You can use Oracle Business Intelligence integration with ADF Business Components
to generate reports on data within your applications. For example, you can generate
reports based on expense report data entered into an Expense Application.

To do this, you would first import the Expense Application metadata into the Oracle
Bl repository using the Administration Tool, then map the data from the Physical layer
to the Business Model and Mapping layer and Presentation layer. After you restart the
Oracle BI Server and reload the metadata into Oracle BI Presentation Services, you can
log in to Oracle BI Answers and drag and drop the columns to generate a report on the
Expense Application data. For example, you can select columns to view a report of
your expenses grouped by category.

What Happens During Import?

On import, the required physical tables and complex joins are automatically created.
The instances (ViewObject and ViewLink) are imported into Oracle Business
Intelligence. During query execution, the definitions retrieved from these instances are
used to create the CompositeVO in ADF.

These complex joins are 'dummy joins' and are not executed in Oracle Business
Intelligence. Instead, they denote ViewLink instances that connect pairs of View
Objects in the ADF model. The physical table and complex join names correspond to
the fully qualified ViewObject and ViewLink instance names, respectively. This
convention allows arbitrary nesting of ApplicationModules in the ADF model.

Note that the External Expression field in the Complex Join dialog for ADF data
sources is populated with the join condition defined in the view link.
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The name of the automatically generated joins follow a naming convention similar to
ViewObjectNamel_ViewObjectName2 (for example, AppModuleAM.AP_VO1_
AppModuleAM_BU_VO1). The ViewLink instance name appears in the ViewLink
Name field of the Complex Join dialog.

The complex joins are only created automatically if a ViewLink instance is available.
They are not created for ViewLink definitions. Joins using ViewLink definitions must
be created manually. To do this, specify the ViewLink definition name in the
ViewLink Name field of the Complex Join dialog.

Alternatively, Oracle Business Intelligence joins between view objects in different
ApplicationModules are created upon import from ADF if custom properties are
defined on the ApplicationModule. Note the following;:

s The property name format is BL VIEW_LINK_property_name

»  The property value format is source_view_object_instance_name, ViewLink_definition_
name, destination_uview_object_instance_name

Be sure to use the fully qualified view object instance names for the source and
destination view objects, as well as the fully qualified package name for the ViewLink
definition.

About Specifying a SQL Bypass Database

The Oracle BI Server can automatically create composite View Objects at run time, so
that an ad-hoc BI query can reference multiple View Objects in the ADF layer. For
improved performance, a SQL bypass query is generated that incorporates the
projection columns, filters, and joins required by the BI query.

The SQL Bypass feature directly queries the database so that aggregations and other
transformations are pushed down where possible, reducing the amount of data
streamed and worked on in Oracle Business Intelligence. When using a SQL Bypass
database, the Oracle BI Server gets the view object query from the ADF data source
and then wraps it with the aggregations in the Logical SQL query. The query,
including the aggregations, is then executed in the database. Because the database
computes the aggregation and less rows are streamed back to Oracle Business
Intelligence, using a SQL Bypass database can result in significant performance gains.

Multiple View Objects are modeled as separate BI physical tables and are connected
with dummy complex joins. These joins only represent the ViewLinks in the ADF
model and are not executed by the Oracle BI Server.

You can specify the name of the SQL Bypass database in the connection pool for the
ADF data source. The SQL Bypass database must be a physical database in the
Physical layer of the repository. The database object for the SQL Bypass database must
have a valid connection pool, with connection information that points to the same
database that is being used by the JDBC Data source defined in the Oracle WebLogic
Server that runs the ADF application.

The SQL Bypass database does not need to have any tables under it. After a valid
database name is supplied, the SQL Bypass feature is enabled for all queries against
that ADF database.

Setting Up ADF Data Sources

This section explains how to configure your ADF Business Components for use with
Oracle Business Intelligence.
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See "System Requirements and Certification" for information about supported
versions.

This section contains the following topics:

s Creating a WebLogic Domain

= Deploying OBIEEBroker as a Shared Library in Oracle WebLogic Server

s Deploying the Application EAR File to Oracle WebLogic Server from JDeveloper

s Setting Up a JDBC Data Source in the WebLogic Server

s Setting the Logging Level for the Deployed Application in Oracle WebLogic Server

Creating a WebLogic Domain

Create a WebLogic Domain for your ADF Business Components that supports
WebLogic Server, Oracle Application Core (Webapp), and Oracle JRF.

To create a WebLogic domain that supports the required components:

1. Start the WebLogic Configuration Wizard. For example, on Windows, run MW_
HOME\wlserver_10.3\common\bin\config.cmd.

2. Select Create a new WebLogic domain and click Next.

3. On the Select Domain Source screen, ensure that Basic WebLogic Server Domain,
Oracle JRF, and Oracle Application Core (Webapp) are selected.

4. Follow the remaining steps in the wizard, providing values appropriate for your
environment.

5. Click Create on the Configuration Summary screen to create the domain.

You can start and stop the Oracle WebLogic Server for this domain using
command-line scripts in the domain directory. For example, on Windows, use the
following:

s  MW_HOME\user_projects\domains\domain_name\bin\startWebLogic.cmmd
s  MW_HOME\user_projects\domains\domain_name\bin\stopWebLogic.cmd

Deploying OBIEEBroker as a Shared Library in Oracle WebLogic Server

The OBIEEBroker shared library is installed as part of your Oracle Business
Intelligence installation. You need to deploy the OBIEEBroker library as a shared
library in Oracle WebLogic Server by installing it (making its physical file or directory
known to Oracle WebLogic Server) and starting it. After the library has been installed
and started, other deployed modules can reference the library.

To deploy OBIEEBroker as a shared library in Oracle WebLogic Server:

1. Ensure that Oracle WebLogic Server is running. If it is not running, start it. For
example, on Windows, run MW_HOME\user_projects\domains \your_
domain\bin\startWebLogic.cmd.

2. Open the WebLogic Server Administration Console. For example, if your Oracle
WebLogic Server is running locally on port 7001, go to
http://localhost:7001/console.

3. Login to the WebLogic Server Administration Console with the credentials you
created when you set up your WebLogic domain.

4. Inthe Change Center, click Lock & Edit.

6-4 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



Setting Up ADF Data Sources

10.

11.

12.

13.
14.

On the Home Page, in the left pane, click Deployments.
In the right pane, click Install.

Using the Install Application Assistant, locate the OBIEEBroker EAR file. You can
find this file at:

ORACLE_HOME\bifoundation\javahost\lib\obisintegration\adf\
oracle.bi.integration.adf.ear

Click Next.
Select Install this deployment as a library and click Next.

Select the servers and/or clusters to which you want to deploy the OBIEEBroker
library. Make sure to select all servers and clusters to which modules or
applications that reference the library are deployed.

Click Next.

You can optionally update settings about the deployment. Typically, the default
values are adequate. Click Help for more information.

Click Next, then click Finish to complete the installation.
In the Change Center, click Activate Changes.

Deploying the Application EAR File to Oracle WebLogic Server from JDeveloper

Follow the steps in this section to deploy the application EAR file to Oracle WebLogic
Server from JDeveloper. Before beginning this procedure, ensure that the following
conditions are true:

You have an ADF Model project that contains ApplicationModules and view
objects that will be exposed to Oracle Business Intelligence.

You have deployed OBIEEBroker as a shared library in Oracle WebLogic Server.
See "Deploying OBIEEBroker as a Shared Library in Oracle WebLogic Server" for
more information.

Oracle WebLogic Server is running.

To deploy the application EAR file to Oracle WebLogic Server from JDeveloper:

1.

Start JDeveloper. For example, on Windows, run MW_
HOME\jdeveloper\jdev\bin\jdev.exe.

Select File, then select Open to open the project that contains your ADF Business
Components in JDeveloper. If prompted, allow JDeveloper to migrate the project
to the latest version.

Create a new Application Module configuration, as follows:

a. In the Model project, double click the application module, then click the
Configurations tab for that application module.

b. Create a new configuration with the following characteristics:
—  Select JDBC DataSource for Connection Type.

- Keep the default DataSource Name (for example,
java:comp/env/jdbc/ApplicationDBDS).

When you set up the JDBC data source in Oracle WebLogic Server in a later
step, you use part of this DataSource Name as the JNDI name required by
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Oracle WebLogic Server. The JNDI name is the DataSource Name without the
java:comp/env context prefix (for example, jdbc/ApplicationDBDS).

4. Create a Business Component Archive deployment profile, as follows:
a. In the Projects window, right-click the Model project and choose New.

b. Select Deployment Profiles under General in the left pane, then choose
Business Components Archive in the right pane and click OK.

c. Provide a name for the deployment profile (for example, MyApplication_
Archive) and click OK.

d. On the Deployment page, click OK.

5. In the Projects window, right-click the Model project and select Deploy > your_
deployment_profile_name > Deploy, or use the deployment wizard by selecting
Deploy to File.

After the project has been deployed, two jar files are created in the deploy
directory for the Model project (for example, MyApplication_Archive_
Common.jar and MyApplication_Archive_MiddleTierjar).

6. Create a new Web Project for the application, as follows:
a. Right-click the global application and select New Project.
b. Select Projects from the left pane, then select Web Project from the right pane.

c. Provide a project name (for example, OBIEEBroker).

e

Click Next until you reach the Web Project Profile page.

e. Modify the Java EE Context Root to a name that better represents your
application (for example, MyApplication).

This value determines the URL that you use to connect to the application from
Oracle Business Intelligence (for example,
http:/ /localhost:7001/MyApplication/obieebroker).

7. Edit the Profile Dependencies of the WAR deployment, as follows:

a. Right-click the Web Project you just created (for example, OBIEEBroker) and
select Project Properties.

b. From the left pane, select Deployment. Then, open the WAR File deployment
profile on the right pane.

c. Select Profile Dependencies from the left pane. Then, on the right pane, select
the Common and MiddleTier deployment profiles of your Model project.

Following this step ensures that the Business Component Archives for the
Model project are included in the WAR file.

8. Expand the Web Project and open web.xml. Then, go to the source view of the file.

9. In the web.xml source, replace the content within the <web-app> element with the
following:

<context-param>
<description>This holds the Principals (CSV) that a valid end user should

have (at least one) in order to query the ADF layer from BI.</description>
<param-name>oracle.bi.integration.approle.whitelist</param-name>
<param-value>Application_Roles List</param-value>

</context-param>

<filter>
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<filter-name>ServletADFFilter</filter-name>
<filter-class>oracle.adf.share.http.ServletADFFilter</filter-class>
</filter>

<filter-mapping>
<filter-name>ServletADFFilter</filter-name>
<servlet-name>0OBIEEBroker</servlet-name>
<dispatcher>FORWARD</dispatcher>
<dispatcher>REQUEST</dispatcher>
</filter-mapping>

<servlet>
<servlet-name>0BIEEBroker</servlet-name>
<servlet-class>oracle.bi.integration.adf.vllg.obieebroker.OBIEEBroker
</servlet-class>

</servlet>

<servlet-mapping>
<servlet-name>0BIEEBroker</servlet-name>
<url-pattern>/obieebroker</url-pattern>
</servlet-mapping>

Following this step ensures that the OBIEEBroker servlet will be used to access
your application from Oracle Business Intelligence

For application_roles_list, provide a list of application roles in CSV form. For
example:

<param-value>FBI_TRANSACTION_ANALYSIS_GENERIC_DUTY, OBIA_ANALYSIS_GENERIC_DUTY,
OBIA_EXTRACT_TRANSFORM_LOAD_DUTY, FUSION_APPS_BI_APPID</param-value>

If you provide a list of application roles, a user's application role is checked before
access is allowed to the application. Note that this run-time check requires the
following grant to be present in the domain_

name/config /fmwconfig/system-jazn-data.xml file for the WebLogic domain:

<grant>
<grantee>
<codesource>
<url>file:${domain.home}/servers/${weblogic.Name}/tmp/
_WL_user/oracle.bi.integration.adf/-</url>
</codesource>
</grantee>
<permissions>
<permission>
<class>oracle.security.jps.JpsPermission</class>
<name>IdentityAssertion</name>
<actions>execute</actions>
</permission>
<permission>
<class>oracle.security.jps.JpsPermission</class>
<name>AppSecurityContext.setApplicationID.obi</name>
</permission>
</permissions>
</grant>

If you do not want application roles to be checked by the OBIEEBroker servlet, use
DISABLE_WHITELIST_ROLE_CHECK as the value for the <context-param> in
web.xml. For example:

<param-value>DISABLE_BI_WHITELIST ROLE_CHECK</param-value>
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10.

11.

12.
13.

14.

15.

Create an EAR deployment profile for the application, as follows:
a. Right-click the global application and select Application Properties.

b. From the left pane, select Deployment, then click New on the right pane to
create a new deployment profile.

c. For Archive Type, select EAR File. Then, provide a name for the deployment
profile (for example, MyApplication).

The deployment profile name is used as the name displayed in the list of
deployments in Oracle WebLogic Server.

d. From the left pane, select Application Assembly. Then, on the right pane,
select the webapp deployment profile of your Web Project.

Following this step ensures that the WAR file from your Web Project is
included in the EAR file.

Under Application Resources, select Descriptors > META-INF >
weblogic-application.xml.

On the left, select the Libraries tab.
Create two new Shared Library References, as follows:
»  Create the first Shared Library Reference with the following characteristics:
- Library Name: oracle.bi.integration.adf
— Implementation Version: 11.1.1.2.0
»  Create the second Shared Library Reference with the following characteristics:
- Library Name: oracle.applcore.model
— Implementation Version: 11.1.1.0.0

These two Shared Library References create the following entries in the
weblogic-application.xml file for the application:

<library-ref>
<library-name>oracle.bi.integration.adf</library-name>
<implementation-version>11.1.1.2.0</implementation-version>

</library-ref>

<library-ref>
<library-name>oracle.applcore.model</library-name>
<implementation-version>11.1.1.0.0</implementation-version>

</library-ref>

Deploy the EAR file to Oracle WebLogic Server by right-clicking the global
application, then selecting Deploy > EAR_deployment_profile_name. From the
dialog that appears, select Deploy to Application Server and then follow the
instructions in the wizard.

To verify that the application has been deployed, log in to the WebLogic Server
Administration Console and click Deployments under Your Deployed Resources.
Verify that your application appears in the list (for example, obieebroker_app_
name).

Setting Up a JDBC Data Source in the WebLogic Server

You must set up a JDBC data source in Oracle WebLogic Server for your application.

To set up a JDBC data source in Oracle WebLogic Server:
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Ensure that Oracle WebLogic Server is running. If it is not running, start it. For
example, on Windows, run MW_HOME\user_projects\domains \your_
domain\bin\startWebLogic.cmd.

Open the WebLogic Server Administration Console. For example, if your Oracle
WebLogic Server is running locally on port 7001, go to
http://localhost:7001/console.

Log in to the WebLogic Server Administration Console with the credentials you
created when you set up your WebLogic domain.

On the Home Page, select JDBC, then select Data Sources.
Click New.

Provide information for your data source. For Name and JNDI Name, provide the
DataSource Name you specified in the Application Module configuration for the
application, without the java:comp/env context prefix (for example,
jdbc/ApplicationDBDS). In addition, make sure to select the target on which you
want to deploy the data source before exiting the wizard.

Click Finish when you are done providing JDBC data source settings.

Setting the Logging Level for the Deployed Application in Oracle WebLogic Server

The log file for the server to which your application is deployed (server_
name-diagnostic.log) records information about your deployed application. You can
find this file in the server-specific directory within your domain. For example, on
Windows, the log file for the AdminServer is located in:

MW_HOME\user_projects\domains\your_domain\servers\AdminServer\logs

To set the logging level for your deployed application:

1.

Open the Oracle WebLogic Server file logging.xml for editing. You can find this
file in:

MW_HOME\user_projects\domains\your_domain\config\fmwconfig\servers\server_name

Within the <loggers> element, add the following child elements:

<logger name="oracle.bi.integration.adf" level="LOG_LEVEL"/>
<logger name="oracle.bi.integration.adf.vllg.obieebroker" level="LOG_LEVEL"/>

Log levels include SEVERE, WARNING, INFO, CONFIG, FINE, FINER, and FINEST. Refer
to the Oracle WebLogic Server documentation for information about logger levels.

Save and close the file.

Restart Oracle WebLogic Server.

Importing Metadata from ADF Data Sources

This section describes different import scenarios for ADF data sources. You must
complete the steps in "Setting Up ADF Data Sources" before you can import metadata
from ADF sources.

This section contains the following topics:

Performing an Initial Import from ADF Data Sources

Using Incremental Import to Propagate Flex Object Changes
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= Automatically Mapping Flex Object Changes to the Logical Model
= Automatically Mapping Flex Object Changes Using the biserverextender Utility

Performing an Initial Import from ADF Data Sources

This section describes how to use the Import Metadata Wizard to perform an initial
import from ADF data sources.

To import metadata from an ADF data source:

1. In the Administration Tool, select File, then select Import Metadata. The Import
Metadata Wizard appears.

Note: If you have already defined an existing ADF data source and
connection pool, you can right-click the connection pool in the
Physical layer and select Import Metadata. The Import Metadata
Wizard appears with the information on the Select Data Source screen
pre-filled.

Figure 6-1 shows the Import Metadata Wizard.

Figure 6—1 Import Metadata Wizard: ADF Data Source

Import Metadata - Select Data Source i =] |
1 Select Data Source Import Type: ILocaI IMachine j
Connection Type: IOracIeADF_HTTP j
2 | Select Metadata Tupes
Connection Poal:
3 | Select Metadata Objects % New Connection ¢ Existing Connection Brawse, . |
4 | Map to Logical Model Daka Source: I jdbcfnwindDs

) AppModule Definition: | snowflakesales, Snowflakesalesipp
5 | Publizh to W arehouze

AppModule Config: I SnowflakesalesMyOappLocal

LRL: | http: ffcomputer . corp.com: 7001 /SnowflakesalestiOboiesbroker
User Mame: I my_User

Password: I [TTTTTIYT Y

Help | Eack | Mext I Fimish | Cancel |

[Far Help, press F1 A

Shows the Import Metadata Wizard in the Administration Tool, for an ADF data
source.
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2. In the Select Data Source screen, select OracleADF_HTTP for Connection Type.
Then, provide the following values:

— Select New Connection, or select Existing Connection if you already have a
connection pool for this data source. Click Browse to locate and select an
existing connection pool. If you select Existing Connection, you do not
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provide information for Data Source, AppModule Definition, AppModule
Config, or URL, and the User Name and Password fields are prefilled.

— Keep the Data Source field blank to use the default JDBC data source
configured in the application module. You only need to provide data source
information (a JDBC data source name, such as jdbc/nWindORAO5) if you
want to use a different data source than the one set up in the application
module.

- For AppModule Definition, provide the fully qualified Java package name of
the Root Application Module to which you want to connect, such as
oracle.apps.fii.receivables.model.RootAppModule, or
snowflakesales.SnowflakeSalesApp.

- For AppModule Config, provide the name of the configuration you want to
use in your connection, such as RootAppModuleShared or
SnowflakeSalesAppLocal. See step 3 of "Deploying the Application EAR File
to Oracle WebLogic Server from JDeveloper" for more information.

- For URL, provide the URL to the Oracle Business Intelligence broker servlet,
in the format:

http://host:port/APP_DEPLOYMENT NAME/obieebroker

For example:

http://localhost:7001/MyApp/obieebroker

The URL is case-sensitive.

— For User Name and Password, provide a valid user name and password for
the Oracle ADF application. The user name and password must be set up and
authenticated in the Oracle WebLogic Server security realm.

For Oracle Fusion Applications, you must connect as the FUSION_APPS_BI_
APPID user.

When you have finished providing information in the Select Data Source screen,
click Next. The Select Metadata Objects screen appears.

Select the objects you want to import in the Data source view and move them to
the Repository View, using the > (Import selected) or >> (Import all) buttons. You
can also move objects from the Repository View back to the Data source view,
using the < (Remove selected) and << (Remove all) buttons.

To search for a particular item, enter a keyword in the Find box and then click
Find Down or Find Up.

Select Show complete structure to view all objects, including those that have
already been imported. Deselecting this option shows only the objects that are
available for import. When this option is selected, objects that have already been
imported appear grayed out.

If this import is creating a new connection to the data source, when you move the
items from the Data source view to the Repository View list, the Connection Pool
dialog opens, showing the values that you provided in the Select Data Source
screen of the Import Metadata Wizard. Optionally, click the Miscellaneous tab of
the Connection Pool dialog and provide the name of a SQL Bypass database in the
SQL Bypass Database field. Then, click OK. If you do not want to specify a SQL
Bypass database, click Cancel.

See "About Specifying a SQL Bypass Database" for more information.
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Note: When importing flexfields from Oracle Fusion Applications
sources, you must always import both the name_ and name_c
attributes for each segment. The name_ attribute contains the value.
The name_c attribute contains the code of the value set that the value
comes from. Both attributes are mapped to the corresponding
dimension view object. You typically use the name_ attribute in
reports.

For DFF segments, you can also optionally import:
»  DESC_name_ attribute: contains a description of the value

s TRAN_name_ attribute: contains translated values, when available

4. Click Finish to close the wizard, or click Next to continue to the Map to Logical

Model screen. See "Automatically Mapping Flex Object Changes to the Logical
Model" for more information.

To validate that your import was successful, expand the database object for the
ADF data source in the Physical layer. Then, right-click a physical table and click
View Data. If the appropriate data is displayed, the import completed
successfully.

Using Incremental Import to Propagate Flex Object Changes

If you make changes to flexfields in your ADF applications, then you can use the
Import Metadata Wizard in the Administration Tool to incrementally import the
changes to the Physical layer of the Oracle Bl repository.

Note: See also the following resources in Oracle Fusion Applications
Developer’s Guide on designating flexfields as business
intelligence-enabled:

s '"Preparing Descriptive Flexfield Business Components for Oracle
Business Intelligence”

= "How to Prepare Key Flexfield Business Components for Oracle
Business Intelligence"

The Import Metadata Wizard includes a synchronization feature for ADF data sources
that enables you to import only the changes made to objects. The synchronization
feature detects the changed objects, including new joined dimensions (KFF) and new
attributes (DFF), so that they can be added automatically, without you having to
search for them. The synchronization feature detects the following:

Changes in columns

Additions or deletions of tables and columns
Additions of keys and foreign keys

Newly joined tables

Note that new tables that are joined to any existing table are only imported when
you select the option Automatically include any missing joined objects on the
Select Metadata Objects screen.

After import, the ADF data is modeled as shown in Table 6-1.
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Table 6—-1 How the ADF Metadata is Modeled in the Oracle Bl Repository
ADF Metadata Imported Bl Metadata
Root Application Module Database
View Objects Physical Tables
View Object Attribute Physical Column
View Object Key Physical Key
View Links Physical Joins

Note that as data is imported incrementally, modifications to properties of attributes
are detected and propagated. For example, if an attribute changes its data type, that
change is propagated to the physical layer objects.

To incrementally import metadata for ADF data sources:

1. In the Administration Tool, in the Physical layer, right-click the connection pool
for your ADF OLTP source and select Import Metadata.

The Import Metadata Wizard is displayed, starting at Step 3, Select Metadata

Objects.

Figure 6-2 shows the Select Metadata Objects screen of the Import Metadata

Wizard.

Figure 6—2 Select Metadata Objects Screen: ADF Data Source

Import Metadata - Select Metadata Dbjects

Select the metadsta objects you want bo import into the physical layer of the repastory.
Impart Options:

1 | Select Data Sowce
2| Select Metadata Type:

%\g Select Metadata Objects

& Import sebected objects only
" fukomaticaly includs any missing joined obiects

End: [ FLEX_BICategory VI

4 | MaptoLogecal Model

5 | Pubksh to'Warehouse

_ o |

For Help, prass F1

DCuata source wiew:

# £ FsemT opModeltM CataloghM Categony®1
FeemT ophodeléM_CataogiM CalegonSetsP1
+ B FeomT opModelaM CataloghM FNDLookupsP1
- E FsemTopModelaM. CataloghM FNDV shsesP1 -
#-EH FeemTopModelsM CataloghM ltemCatalogTLP1

= B8 FsomTopModeliM CategoryBIAM FLEX,_BI_Category V1

& CONCAT_VALUES

4 CieatedBy

& CieationDate
% DEP s L6
4 LaullpdateDate
& LastUpdatedBy
& 590

[0 FsemTopModeldM CategonBLAM FLEX VS_BASED_CAT
FacmT ophlodel&M_CategoryBLaM FLEX_VS_MIMOR_CAT

FrrmT anbncdaldil r‘nwr.awnunrm FIF Rl Cabee ™

H[=H
3| 2 o
Repository Yiew:
A =@ |
i
3 w@
B cE
ﬁ £ [FacmT opModelM. Categon/BIAM FLEX_BI_Categoy V1|
B CONG
8 cea
8 DEPsLE | |
g Lo
g
el
g L2
H slLa
g vsC_s L3
H vSCaLS
it Kl T

¥ Show complete structure

M[uentlaahlc«:d

Shows the Select Metadata Objects screen of the Import Metadata Wizard for an ADF

data source.
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2. Click Synchronize to locate and automatically select all recent changes for import.
The Synchronize button is located in the upper right corner of the screen, above

the Repository View.

3. Review the selected metadata to locate the new attributes.
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4. Click Finish to close the wizard, or click Next to continue to the Map to Logical
Model screen. See "Automatically Mapping Flex Object Changes to the Logical
Model" for more information.

Automatically Mapping Flex Object Changes to the Logical Model

After importing changes to flexfields in your ADF application, you can use the Map to
Logical Model screen of the Import Metadata Wizard in the Administration Tool to
automatically propagate the changes to the Business Model and Mapping layer and
Presentation layer.

If needed, you can override the default mapping behavior during this step by
renaming logical tables, splitting a view object into multiple tables, combining
multiple view objects into a single logical table, and so on.

See also "Customizing the Mapping Behavior" for information about using XML files
to automate the mapping behavior displayed in this screen.

To automatically map flex object changes to the logical model:

1. In the Administration Tool, in the Physical layer, right-click the connection pool
for your ADF OLTP source and select Import Metadata.

2. Complete the Select Metadata Objects screen and click Next. See "Using
Incremental Import to Propagate Flex Object Changes" for more information about
this screen.

3. In the Map to Logical Model screen, the Table Mapping and Column Mapping
grids display the results of a default drag-and-drop. You can keep the default
behavior, or customize the behavior for your needs. For example, you might want
to rename tables and columns in the Business Model and Mapping layer, map to
an existing logical table, or map a logical column to multiple source columns.

Note that the Column Mapping grid shows alias columns as well as regular
columns, so that you can handle customized mappings that include alias columns.
The Table Mapping grid enables a single physical table to map to multiple logical
tables, and the reverse.

The Table Mapping grid includes a VO Type column. Options include Normal,
ETL Only, and Query Only. ETL Only view objects exist only to extend the ETL
mappings, and are not used for queries. Logical table sources that reference
imported view objects of this type are marked as disabled in the Business Model
and Mapping layer. Query Only view objects are only used for queries, and are
not passed to the BI Extender for extension into the data warehouse.

The Table Mapping grid also includes a Hierarchy column. Select this option for
objects that are hierarchies.

Select Create Logical Joins if the imported tables are being mapped to a new
business model that will be created during the Map to Logical Model step. In other
words, select this option when the imported logical joins do not already exist. Do
not select this option for business models that already have the required logical
joins in place. Doing so will create erroneous multiple logical joins.

Figure 6-3 shows the Map to Logical Model screen.
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Figure 6-3 Map to Logical Model Screen of Import Metadata Wizard
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B R R R R R R R R R R R R R R R R R R s s T

4. Click Finish to close the wizard, or click Next to continue to the Publish to
Warehouse screen. See "Publishing Changes to the Data Warehouse and

Propagating Changes to the Repository” for more information.

Customizing the Mapping Behavior

You can create a set of XML files that specify custom mapping requirements for the
mappings displayed in the Map to Logical Model screen. The Administration Tool
reads the XML files and then automatically maps the KFF and DFF segments
according to the specified logic. Each XML file has a top-level element with an
appName attribute that specifies the application to which the file applies.

You must create your XML files according to the logic in the XML schema files app_
segment_rule.xsd and mapping_rules.xsd. You can find these files in:

ORACLE_HOME\bifoundation\javahost\lib\obisintegration\biextender
All XML files in this directory with the prefix mapping_rules and app_segment_rules
are parsed by the Administration Tool for ADF data sources.

You can use the existing app_segment_rules_*.xml and mapping_rules_*.xml in this
directory as examples.

See Appendix G, "XML Schema Files for ADF Mapping Customizations" for more
information about the app_segment_rule.xsd and mapping_rules.xsd XML schema
files.

Working with ADF Data Sources 6-15



Importing Metadata from ADF Data Sources

Manually Mapping Flex Object Changes to the Logical Model

You can choose to skip the logical mapping step in the Import Metadata Wizard, and
instead drag and drop the physical objects to the Business Model and Mapping layer
and Presentation layer. The Administration Tool supports incremental drag-and-drop
for ADF data sources, which enables physical database and schema objects to be
dragged and dropped into an existing business model, resulting in updates made only
for the incremental changes.

Note that the behavior in previous releases was to create new logical objects for every
physical object that was dragged and dropped. The current logic includes data
source-specific default rules that can enable, for example, logical dimensions and
hierarchies to be automatically created.

Automatically Mapping Flex Object Changes Using the biserverextender Utility

You can use the biserverextender utility to import flex object changes from your
ADF sources and map them to the Business Model and Mapping layer and
Presentation layer. Because this feature does not require the Administration Tool, it is
especially useful when you want to map flex object changes on Linux and UNIX
systems where the Administration Tool is not available.

To use the biserverextender utility, you must first create an XML parameter file that
contains the connection pool for an existing ADF data source. The biserverextender
utility retrieves the existing ADF connection pool name from the parameter file,
synchronizes the ADF data source, updates the deployed objects in the source, and
then maps physical metadata to the Business Model and Mapping and Presentation
layers based on the default rule files in the following directory:

ORACLE_HOME/bifoundation/javahost/lib/obisintegration/biextender
See "Customizing the Mapping Behavior" for more information about the rule files.

Syntax

biserverextender -R base repository_name [-P repository._password]
-0 output_repository_name -1 input XML file [-S]

Where:

-R base_repository_name is the name and path of the repository into which you want
to import and map flex object changes.

-P repository_password is the Oracle Bl repository password for the base repository.

Note that the repository_password argument is optional. If you do not provide the
password argument, you are prompted to enter the password when you run the
command. To minimize the risk of security breaches, Oracle recommends that you do
not provide password arguments either on the command line or in scripts. Note that
the password argument is supported for backward compatibility only, and will be
removed in a future release. For scripting purposes, you can pass the password
through standard input.

-0 output_repository_name is the name and path of the repository generated by the
utility.

-1 input_XML fileis the name and path of an input XML parameter file that contains
the fully-qualified name of a connection pool for an ADF data source.

-5 is optional. If -S is not specified, only the changes from the ADF source's DFF and
KFF objects are synchronized to the Oracle BI Repository. If -S is specified, it reimports
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all DFF and KFF objects from the ADF source based on the ADF source's database
properties, and resynchronizes the Oracle BI Repository.

-S also incorporates the following changes in the app_segment_rules.xml rules file:
= New mapping rules segments
= New alias table creation

= New "ADF VO To Be Exposed" subject area or presentation table

Example

biserverextender -R /scratch/my_repos.rpd -O /scratch/my_repos_modelled.rpd
-I /scratch/ADFSource.xml -S
Give password: password

Sample XML Parameter File

<BIExtenderParameters>
<ConnectionDetails>
<ConnectionPool>
<ConnectionPoolName>"oracle.apps.fscm.model .analytics.applicationModule.Fscm
TopModelAM_ FscmTopModelAMLocal". "Connection Pool"</ConnectionPoolName>
</ConnectionPool>
</ConnectionDetails>
</BIExtenderParameters>

Using the Bl Extender to Propagate Flex Object Changes

You can configure and enable the BI Extender functionality to propagate changes
made on Flex objects to your data warehouse.

This section contains the following topics:

= About Propagating Changes to Flex Objects to the Data Warehouse
s Performing Preconfiguration Tasks for the BI Extender

= Running the BI Extender in a Secured Environment

s Publishing Changes to the Data Warehouse and Propagating Changes to the
Repository

s Setting Up XSL Transform Files to Customize XML Output to the Oracle BI
Extender

About Propagating Changes to Flex Objects to the Data Warehouse

You can use the Administration Tool to propagate changes in your ADF applications
to Informatica, DAC, and the Physical and Business Model and Mapping layers of the
Oracle BI Repository. In this scenario, the BI Extender is the driver that coordinates the
information exchange between the ADF objects and the other targets.

The BI Extender feature supports changes made to flexfields in ADF data sources.
Flexfields are columns within tables that can be reused based on a user-specified
context. There are two types of flexfields:

s Key (KFF). These objects are modeled as dimension view objects. KFF segments
are imported as new dimensions joined to an existing fact table.
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s Descriptive (DFF). These objects are modeled as view object attributes. DFF
segments are imported as new attributes (on both facts and dimensions) on
existing tables.

The BI Extender uses the JavaHost service to propagate flexfield changes. Because of
this, JavaHost must be running for this feature to work, and the NQSConfig.INI file on
the Administration Tool computer must be configured for the correct JavaHost
location.

Figure 6—4 BI Extender Orchestration of Flexfield Object Changes
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Shows the Import Metadata Wizard (importing from an ADF OLTP source)
propagating flexfield changes to the BI Extender using base XML, upon which XSL
transform files are applied. Then, the BI Extender reads information from the
Informatica Repository, writes the change to the Informatica server, and propagates
the flexfield change to DAC. Finally, the BI Extender propagates the change to the
Data Warehouse object in the Physical layer of the repository, and then maps the
change to the logical model in the Business Model and Mapping layer. A final step is
for the user to propagate the change to the data warehouse database using DAC.
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In Figure 6—4, numbers indicate the steps in the flexfield change propagation process.
These numbers represent the following steps:

1. The Import Metadata Wizard sends XML containing the flexfield object changes to
the BI Extender.

2. XSL transform files are applied to the base XML.
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3. The BI Extender retrieves information about mappings from the Informatica
repository.

4. The BI Extender uses the mapping information to propagate the flexfield object
changes to the Informatica Server.

5. The BI Extender propagates the changes to DAC.

6. The BI Extender propagates the changes to the database object for the data
warehouse in the Physical layer of the Oracle BI repository.

7. The BI Extender maps the changes to the logical model.

8. In aseparate step, the DAC user goes to the DAC client and synchronizes the
changes in DAC with the actual data warehouse.

Use Cases for Propagating Flexfield Changes

The BI Extender supports a variety of use cases for propagating changes made to
flexfields. The primary use cases include:

= New attribute added on a dimension (Dimension DFF -
DescriptiveFlexExtensionStandard)

= New attribute added on a fact (Fact DFF - DescriptiveFlexExtensionStandard)

= New Dimension added, joined to an existing Fact (Dimension KFF -
KeyFlexCreationStandard for dimension, KeyFlexExtensionStandard for the fact
foreign key)

= New Dimension added, joined to an existing Dimension (Dimension on
Dimension KFF - KeyFlexCreationStandard on the new dimension,
KeyFlexExtensionStandard for the foreign key)

Note: For an example of an Oracle BI Applications KFF use case, see
"Configuring GL Segment and GL Account Dimensions" in Oracle
Fusion Middleware Installation and Configuration Guide for Oracle
Business Intelligence Applications.

In addition to these standard use cases, some more complex, advanced use cases are
supported. The following sections describe these advanced use cases.

ETL Only View Object A view object that exists only to extend the ETL mappings,
and that will not be used for queries. Imported view objects of this type are marked as
disabled in the Business Model and Mapping layer. View objects of this type are
marked as ETL Only in the Map to Logical Model screen of the Import Metadata
Wizard.

Query Only View Object A view object that is only to be used for queries. View
objects of this type are not passed to the BI Extender. View objects of this type are
marked as Query Only in the Map to Logical Model screen of the Import Metadata
Wizard.

View Objects that Map to Existing Dimensions This occurs when the imported view
object is mapped to an existing logical dimension table that already maps to the data
warehouse. In this case, the BI Extender uses the existing columns to perform the
extensions. A different transformation template (from the specified XSL transform file,
discussed in "Setting Up XSL Transform Files to Customize XML Output to the Oracle
BI Extender") is applied for this use case, as shown in Table 6-2.
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Table 6—2 Normal and Mapped to Existing Transformation Template Names

Normal Template

"Mapped to Existing" Template

KeyFlexCreationStandard

KeyFlexCreationExtract

DescriptiveFlexCreationStandard

DescriptiveFlexCreationExtract

KeyFlexHierarchyCreationStandard

KeyFlexHierarchyCreationExtract

DescriptiveFlexExtensionStandard

DescriptiveFlexExtensionExtract

KeyFlexExtensionStandard KeyFlexExtensionExtract

Hierarchy View Object A special type of view object that is treated differently by the
BI Extender. You can specify a Hierarchy view object in the updatehierarchy.xsl file,
where you specify the HIERARCHY_NAME and DATASOURCE_NUM_ID (required
attributes for Hierarchy view objects). This tells the Administration Tool which view
objects are Hierarchy view objects. In the Map to Logical Model screen of the Import
Metadata Wizard, the Hierarchy check box appears as selected for each Hierarchy
view object.

Striping (W_GL_SEGMENT_D) Some view objects come with predefined filters.
These filter definitions are automatically propagated to the appropriate logical table
source content filter.

The BI Extender configures the logical table source filters for GL accounts by putting
appropriate segment labels in the filters. There is a right-click option for GL-SegmentX
dimension tables to pull in the synchronized custom AM properties into the logical
table source filter.

Performing Preconfiguration Tasks for the Bl Extender

To enable the BI Extender feature, you must configure a connection to Informatica,
DAC, and the data warehouse in the biextension.properties file. You also need to
provide configuration information in the config.xml file for JavaHost, opmn.xml, and
optionally in the ContainerMapping.xml file. The following sections describe the steps
needed for this configuration:

s Configuring the biextension.properties File

s Obtaining the Informatica mapfwkjar File

s Configuring the JavaHost loaders.xml File

s Configuring the opmn.xml File

s Configuring the ContainerMapping.xml File

s Updating NQSConfig.INI

= Optionally Changing the Location of the BI Extender Files

Configuring the biextension.properties File
This section explains how to configure the biextension.properties file.

To configure connections to Informatica, the Informatica repository, and DAC in
biextension.properties:

1. Open the biextension.properties file for editing. You can find this file at:

MW_HOME/Oracle_BIl/bifoundation/javahost/lib/obisintegration/biextender
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2. Set the parameters in biextension.properties as needed for your deployment. The
infa.* parameters define the connection to Informatica, the db.connection.*
parameters define the connection to the Informatica repository, and the dac.*
parameters define the connection to DAC and the data warehouse. The following
table describes the parameters in biextension.properties:

Parameter

Description

infa.connection.sdk.repository
infa.connection.sdk.domainname
infa.connection.sdk.installpath

infa.connection.sdk.ssl_enabled

db.connection.type
db.connection.repository

db.connection.dbname

db.connection.host
db.connection.port

db.connection.dsn
db.connection.driver

db.connection.url

db.connection.ssl_enabled

dac.connection.sdk.container

dac.connection.sdk.primarysource
dac.connection.sdk.primarytarget

dac.connection.sdk.driver
dac.connection.sdk.url

dac.connection.sdk.dbtype

The name of the Informatica repository.
The Informatica domain name.
The Informatica install path.

Whether the Informatica connection is
configured for SSL. Set this parameter to true or
false.

Set this property to url.
The name of the Informatica repository.

The name of the Informatica repository
database.

The Informatica repository database host.
The Informatica repository database port.

The DSN for the Informatica repository
database.

The Informatica repository database driver (for
example, oracle.jdbc.driver.OracleDriver).

The Informatica repository database driver URL
(for example,
jdbc:oracle:thin:@localhost:1521:XE)

Whether the connection to the Informatica
repository database has been configured for SSL.
Set this parameter to true or false.

The DAC container name.

Note: In DAC, you cannot modify objects in the
predefined source system containers either
through the DAC Client or directly through SQL
statements to the DAC repository. You must
make a copy of a predefined container in order
to make any changes to it.

See "About Source System Containers" in Oracle
Fusion Middleware User’s Guide for Oracle Business
Intelligence Data Warehouse Administration Console
for more information.

The DAC primary source.
The DAC primary target.

The DAC repository database driver (for
example, oracle.jdbc.driver.OracleDriver).

The DAC repository database driver URL (for
example, jdbc:oracle:thin:@localhost:1521:XE).

The DAC repository database type (for example,
Oracle).
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Note that for Oracle Database, the driver parameters can use either a service name
or SID. For example:

s jdbc:oracle:thin:@host:port/service name
s jdbc:oracle:thin:@host:port:SID

3. Save and close the file.

Obtaining the Informatica mapfwk.jar File

You must obtain the Informatica mapfwk jar file for the BI Extender to work. This file
is included in the Fusion Applications Install Repository, which is available after you
download and unzip the Oracle Fusion Applications 11g parts available in the Oracle
Fusion Applications Media Pack on the Oracle Software Delivery Cloud.

After downloading and unzipping the Oracle Fusion Applications 11g parts, the
mapfwk jar file is located in:

Fusion_Applications_Install_Repository\installers\PowerCenter

Copy the mapfwk jar file from the given location to the computer running the Java
Host.

Configuring the JavaHost loaders.xml File
This section explains how to configure the JavaHost loaders.xml file.

To configure the IntegrationServiceCall loader in loaders.xml:
1. Open the JavaHost loaders.xml file for editing. You can find this file at:

ORACLE_HOME\bifoundation\javahost\config

2. Find the Loader section for IntegrationServiceCall. Then, edit the section to
include the location of mapfwk jar, commons-logging-1.0.4.jar, and
DAWSystem jar files, as shown in the following example. The
commons-logging-1.0.4.jar and DAWSystem jar files are available under the DAC
install directory.

<Loader>

<Name>IntegrationServiceCall</Name>

<Class>oracle.bi.integration. javahost.ServiceCallLoader</Class>

<ConfigNodePath>ServiceCall</ConfigNodePath>

<ClassPath>
{%ORACLE_BIJH_ROOTDIR%}/lib/obisintegration/javahostservice.jar;
{%ORACLE_BIJH_ROOTDIR%}/lib/obisintegration/aw/11lg/ojdbc5.jar;
C:\INFA\mapfwk.jar;
C:\DAC\lib\commons-logging-1.0.4.jar;
C:\DAC\DAWSystem.jar

</ClassPath>

</Loader>

Important: Be sure to replace the path names in each highlighted line with the
appropriate path names for your deployment.

3. If the Java Host is running on a Linux system, you must also download
log4j-1.2.16.jar from http: //www.apache. org and specify the classpath to this
jar file in loaders.xml.

4. Save and close the file.
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Configuring the opmn.xml File
This section explains how to configure opmn.xml for the BI Extender.

1.

Open the opmn.xml file for editing. You can find this file at:

ORACLE_INSTANCE\config\OPMN\opmn

Locate the tag <ias-component id="coreapplication_obijhl"> and add a new
variable called INFA_DOMAINS_FILE under the <environment> subtag. For
example:

</ias-component><ias-component id="coreapplication_obijhn">
<environment>

<variable id="ORACLE_BI_OPMNMANAGED" value="true"/>

<variable i1d="ORACLE_BI_APPLICATION" value="coreapplication"/>

<variable id="INFA_DOMAINS_FILE" value="C:\\Informatica\\
PowerCenter\\domains.infa"/>
</environment>

Important: Be sure to replace the path name in the highlighted line with the
appropriate path name for your deployment.

If the JavaHost is running on a Linux system, follow these additional steps:

a. Add the variable INFA_HOME to the <environment> subtag of the
<ias-component id="coreapplication_obijhn"> tag in opmn.xml. For example:

<variable id="INFA_HOME" value="/u0l/APPLTOP/informatica/powercenter"/>

b. Add the INFA_HOME/server/bin directory to the LD_LIBRARY_PATH and
PATH variables in opmn.xml. For example:

<variable id="LD_LIBRARY_PATH" value="$ORACLE_HOME/common/ODBC/Merant/5.3/
1ib$: SORACLE_HOME/bifoundation/server/bin$: SORACLE_HOME/bifoundation/web/
bin$:$SORACLE_HOME/bifoundation/odbc/1ib$: SORACLE_INSTANCES : SORACLE_HOME/lib
$:/u01/APPLTOP/informatica/powercenter/server/bin$: $PATH"

append="true" />

<variable id="PATH" value="$ORACLE_HOME/common/ODBC/Merant/5.3/1ib

$: SORACLE_HOME/bifoundation/server/bin$:SORACLE_HOME/bifoundation/web/bin
$: SORACLE_HOME/bifoundation/odbc/1ib$: SORACLE_INSTANCES: SORACLE_HOME/lib
$:/u01/APPLTOP/informatica/powercenter/server/bin$: $PATH"

append="true" />

For all platforms, save and close the file.

For all platforms, use the following commands to restart OPMN and the system
components:

opmnctl stopall
opmnctl startall

Configuring the ContainerMapping.xml File

If you have customized your default Oracle BI Applications Informatica ETL
mappings, you might need to update your Informatica repository name in
ContainerMapping.xml.

To configure ContainerMapping.xml:

1.

Make a copy of the Sample.ContainerMapping.xml file and rename the copied file
ContainerMapping.xml. You can find Sample.ContainerMapping.xml in:
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ORACLE_HOME/bifoundation/javahost/lib/obisintegration/biextender/EM/RS/
infa/EC/obj

2. Open the ContainerMapping.xml file for editing. Note the following about values
in the default file:

= "Informatica861Versioned" is the default Informatica repository name. Replace
this name with the name of your Informatica repository.

= "SDE_Fusion_Adaptor," "SILOS," and "PLP" are folder names in the
repository. SDE_Fusion_Adaptor is an example; change all occurrences to the
name of the SDE folder in the repository (for example, SDE_FUSION_V1_
Adaptor).

s "OLTP" and "OLAP" are the database names for the source tables registered in
Informatica. These values do not have to match the actual database name.
Rather, they are used as a way to folder source tables in Informatica.

3. Make any needed changes to the default values, such as the Informatica repository
name and the SDE folder name.

4. Save and close the file.

Updating NQSConfig.INI

If you are using a client installation of the Administration Tool, such as when you are
running the JavaHost on a Linux system, you must also update the NQSConfig.INI file
on the Administration Tool computer to point to the location of a running JavaHost.
To do this, follow these steps:

1. Close the Administration Tool, if it is open.

2. On the same computer as the Administration Tool, open the local NQSConfig.INI
file in a text editor. You can find this file at:

ORACLE_INSTANCE/config/OracleBIServerComponent/coreapplication_obisn
3. Locate the JAVAHOST_HOSTNAME_OR_IP_ADDRESSES parameter, near the

bottom of the file. Update this parameter to point to a running JavaHost, using a
fully-qualified host name or IP address and port number. For example:

JAVAHOST_HOSTNAME_OR_IP_ADDRESSES = "myhost.example.com:9810"
Note that in a full (non-client) Oracle Business Intelligence installation, you cannot

manually edit this setting because it is managed by Oracle Enterprise Manager
Fusion Middleware Control.

4. Save and close the file.

These steps are only required for client installations of the Administration Tool.

Optionally Changing the Location of the Bl Extender Files

Optionally, you can change the location of the BI Extender files. To do this, move the
files from the default location to a new location, then create an operating system
environment variable called ORACLE_BI_ETL_EXTENDER and set its value to the
value of the new path. The default path for the BI Extender files is:

ORACLE_HOME/bifoundation/javahost/lib/obisintegration/biextender
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Running the Bl Extender in a Secured Environment

Because the BI Extender makes direct changes to a variety of sensitive targets, it is
strongly recommended to run the entire BI Extender process in a secured environment
behind a firewall.

To run the BI Extender in a secured environment:

1.

7.

Set up the Informatica server for SSL. Refer to the Informatica documentation for
more information.

Set up the Informatica repository for SSL, including setting up the trusted
certificate and exporting the certificate into the "export" file. Refer to the
Informatica documentation for more information.

Open the biextension.properties file for editing. You can find this file at:

MW_HOME/Oracle_BIl/bifoundation/javahost/lib/obisintegration/biextender

Set the following two properties to true:
infa.connection.sdk.ssl_enabled = true
db.connection.ssl_enabled = true

Save and close the file.

Add the database server root certificate to the JavaHost JVM using the keytool
utility to enable JavaHost to authenticate itself with the database server. Use a
command similar to the following:

C:\Program Files\Java\jdkl.6.0_12\bin\keytool -import -keystore
"C:\Program Files\Java\jdkl.6.0_12\jre\lib\security\cacerts" -trustcacerts
-file C:\oracle\product\10.2.0\client_l\admin\orcl\wallet3\export -alias
ssl_certificate

In this example, note that:

= C:\Program Files\Java\jdk1.6.0_12\jre\lib\security\cacerts is the path to
the JavaHost JVM's certificate file

= keytool is the program used to add the certificate

s C:\oracle\product\10.2.0\client_1\admin\orcl\wallet3\export is the
exported root certificate of the database server

= ssl_certificate is an alias given to this certificate so that it can be identified
later

When prompted, type "yes" after "Trust this certificate?"

Publishing Changes to the Data Warehouse and Propagating Changes to the

Repository

This section explains how to use the BI Extender to propagate the flex object changes
to the Informatica server, DAC, the Physical layer, and the logical model. It also
explains how to use DAC to make the required schema changes in the data warehouse
itself. You must complete the preconfiguration steps in "Performing Preconfiguration
Tasks for the BI Extender" before performing the steps in this section.

This section contains the following topics:

Running the BI Extender to Update Informatica, DAC, and the RPD
Using DAC to Propagate Flex Object Changes to the Data Warehouse Schema
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Running the Bl Extender to Update Informatica, DAC, and the RPD

This section explains how to run the BI Extender to update Informatica, DAC, and the
Oracle Bl repository for flex object changes. This section assumes that you have
already added a new attribute in your ADF application.

To run the BI Extender to update Informatica, DAC, and the RPD:

1.
2.
3.

Ensure that the JavaHost process is running.
Open your repository in the Administration Tool.

In the Physical layer, right-click the connection pool for your ADF OLTP source
and select Import Metadata.

Complete the steps in the Select Metadata Objects and Map to Logical Model
screens. See "Using Incremental Import to Propagate Flex Object Changes" and
"Automatically Mapping Flex Object Changes to the Logical Model" for more
information.

On the Publish to Warehouse screen, perform the following steps:
a. Select the warehouse database.
b. Enter a user name and password for the Informatica server.

c. Enter a user name and password for the Informatica repository database. This
user does not need to have write permission.

d. Enter a user name and password for DAC.
e. Click Connect.

Figure 6-5 shows the Publish to Warehouse screen.

Figure 6-5 Publish to Warehouse Screen of Import Metadata Wizard

Import Metadata - Publish to Warehouse m] ﬁ

1| Select Data Source

2 | Select Metadata Tupes
3 | Select Metadata Objects
4 | Map to Logical Madel

Publish to Warehouse

Help

Far Help, press F1

Data warehouse: | ADF_IT_HINTS_SOURCE_1| Select...

Informatica

User Mame: Password:

Database

User Mame: Password:

DAC

User Mame: Password:
Connect

Cancel
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Shows the Publish to Warehouse screen of the Import Metadata Wizard, with User
Name/Password fields for Informatica, Database, and DAC.
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6. Click Finish.

See "About Propagating Changes to Flex Objects to the Data Warehouse" for a
description of what happens when you click Finish in the Publish to Warehouse
screen.

Using DAC to Propagate Flex Object Changes to the Data Warehouse Schema

After the BI Extender finishes, you need to propagate the necessary schema changes to
the data warehouse. This section describes one recommended method of
accomplishing this task.

Note: In DAC, you cannot modify objects in the predefined source
system containers either through the DAC Client or directly through
SQL statements to the DAC repository. You must make a copy of a
predefined container in order to make any changes to it.

See "About Source System Containers" in Oracle Fusion Middleware
User’s Guide for Oracle Business Intelligence Data Warehouse
Administration Console for more information.

To propagate the schema changes to the data warehouse:

1. In DAC, filter the tables in DAC view to show only those tables that were
modified or created by the BI Extender. To do this:

a. Go to the Tools menu and choose UI Preferences.
b. Select Always show Last Updated.

c. Select the Tables tab. Right-click and select Flat Views, then select Table
Columns.

d. A dialog opens that shows a Table Columns list in Query mode. Scroll to the
right and then double-click the Last Update field.

e. Set the date and time when you started the BI Extender process, and then
select After, as shown in Figure 6-6.

Figure 6—6 Setting a Date Filter in DAC

Date rz|
Year: Month: Day:
] e[ ]| @ anew
Hour: Minute: Second: ) 24 Hours

2em -]

_ Before ) Equals @ After
) Null 2 Not Null
[ Including

[ ox | | Null | | cancel |
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Shows the DAC screen where you can set a Date filter.
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2. C(lick OK, then click Go. A list of tables and columns that were created and
modified after the specified date is shown.

3. Run the DAC functionality to upgrade these tables in the data warehouse using
the option Generate DW Table Scripts for Oracle. Make sure to select All records
in the list. See "Managing Data Warehouse Schemas" in Oracle Fusion Middleware
User’s Guide for Oracle Business Intelligence Data Warehouse Administration Console
for more information.

Setting Up XSL Transform Files to Customize XML Output to the Oracle Bl Extender

The biextension.properties file specifies the XSL files to be used to transform and
customize the default XML generated by the Administration Tool and sent to the BI
Extender. By default, the following XSL files are applied:

s biextension.xsl: Contains default transformations for the Extender. Contains
templates for both normal and "mapped to existing" cases.

= updatehierarchy.xsl: Specifies rules for how Hierarchy view objects should be
handled.

s LastUpdateDate.xsl: Identifies which input columns need to be filtered on the
Informatica parameter LastUpdateDate.

All XSL files are located in the same directory as biextension.properties.

In rare cases, you might need to make additional customizations the default XML that
is generated by the Administration Tool and sent to the BI Extender. To do this, you
can create other XSL files to be applied in addition to the three default XSL files. Note
the following:

= Additional XSL files need to conform to the XML schema defined in the
biextension.xsd file, located in the same directory as the biextension.properties file.

= Itis abest practice to define changes in an additional XSL file rather than updating
one of the default files.

= The replaceName.xsl file provides examples on how to do XSL transforms for
name changes.

To specify additional XSL files:
1. Open the biextension.properties file for editing. You can find this file at:

ORACLE_HOME/bifoundation/javahost/lib/obisintegration/biextender

2. Add additional XSL files to the xsl_transforms line, as follows:

xsl_transforms = updatehierarchy.xsl,LastUpdateDate.xsl,biextension.xsl,
replaceNames.xsl

3. Save and close the file.

Sample XML Output

Sample base XML output generated by the Administration Tool might look like the
following:

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<Document>
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<extension mode="KeyFlexCreationStandard" type="Dimension">
<table name="W_COST_CENTER_D">
<columns>
<column datatype="Varchar2(50)" name="COST_CENTER_NAME" type="Attribute">
<source column="COST_CENTER_NAME" table="SnowflakesalesApp.
ADF_COST_CENTER_VO" />
</column>
<column datatype="Varchar2(10)" name="COST_ CENTER_LOCATION"
type="Attribute">
<source column="COST_CENTER_LOCATION" table="SnowflakesalesApp.
ADF_COST_CENTER_VO"/>
</column>
<column datatype="Varchar2(5)" name="COST_CENTER_ID" type="Key">
<source column="COST_CENTER_ID" table="SnowflakesalesApp.
ADF_COST CENTER_VO"/>
</column>
</columns>
</table>
</extension>

</Document>

Setting Up and Using ApplCore Grants for ADF Data Security

This section explains how to implement ADF data security in the Oracle BI Server. To
implement ADF data security, you must have an application with secured View
Objects and user setup.

Perform the steps in the following sections:

Setting Up Oracle Business Intelligence to Use ApplSession
Setting Up Authentication for ApplSession Integration

Setting Up Oracle Business Intelligence to Use ApplSession

When you set up Oracle Business Intelligence to use ApplSession, the following
occurs:

Pillar-specific AOL sessions are created for data queries. A new AOL session is
created for every pillar within a BI session when a data query is fired against the
pillar. This AOL session is reused for all subsequent data queries against the same
pillar. There are, at most, as many AOL sessions as there are ADF pillars
(databases) defined in the Oracle BI repository.

For the examples used in this section, there are three or less AOL sessions ("AOL_
SESSION_ID_HCM", "AOL_SESSION_ID_CRM", "AOL_SESSION_ID_FSCM")
created within a BI Session for data queries.

AOL context variable values are propagated to the newly-created pillar-specific
AOL sessions. Presentation Services propagates the AOL context variables when it
logs in to the Oracle BI Server.

The SQL Bypass query reattaches to the previously created AOL session for that
ADF Database.

This section contains the following topics:

Setting Up Database Objects and Connection Pools for ApplSession Integration
Setting Up Initialization Blocks for ApplSession Integration

About the Client Login Process in an ApplSession Integrated Environment
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Setting Up Database Objects and Connection Pools for ApplSession Integration

To set up the Oracle BI repository to enable ApplSession integration, you must first
configure the appropriate database object and connection pools in the Physical layer.

To set up database objects and connection pools for ApplSession integration:

1. Open your repository in the Administration Tool.

2. Create database objects and connection pools in the physical layer for each pillar,
as follows:

Create a database object and connection pool for SQL bypass during data
queries (for example, Pillarl_bypass).

Use the Import Metadata Wizard to create a database object and connection
pool that correspond to the application EAR file deployed in WLS (for
example, Pillar1_http). This database object contains the physical table and
column mappings to view objects and attributes. Be sure to specify the SQL
bypass database you want to use during metadata import.

Figure 6-7 shows the pillar-specific database objects.

Figure 6—7 Pillar-Specific Database Objects

Shows two database objects: one for the SQL bypass database (Pillarl_bypass), and a
second that contains the physical table and column mappings (Pillar1_http).
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3. Open the connection pool for each SQL bypass database and click the Connection
Scripts tab. To ensure that SQL bypass queries are issued within the pillar-specific
AOL session (for example, "AOL_SESSION_ID_Pillarl_http,") you must provide
the appropriate pre-query and post-query scripts, as follows:

a.

b.

f.

g.

Expand Execute before query and click New.
Enter a pre-query script similar to the following;:

BEGIN
fnd_session_mgmt.attach_session('VALUEOF (NQ_ SESSION.AOL_SESSION_ID_

Pillarl_http)');

END;

Click OK.

Expand Execute after query and click New.

Enter the following post-query script:

BEGIN
fnd_session_mgmt.detach_session;
END;

Click OK.
Click OK in the Connection Pool dialog.

Figure 6-8 shows the Connection Scripts tab of the Connection Pool dialog.
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Figure 6—8 Pre-query and Post-query Scripts for the SQL Bypass Connection Pool
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0K I Cancel | Help |

Shows the Connection Scripts tab of the Connection Pool dialog, with scripts entered
for Execute before query and Execute after query.
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Setting Up Initialization Blocks for ApplSession Integration

Initialization blocks are used to initialize BI session variables. They contain SQL /XML
queries that are set up to return columns of values which are then mapped to BI
session variables. Initialization blocks typically execute during BI session creation.

In the Initialization Block dialog, you can choose to defer the execution of an
initialization block by selecting Allowed deferred execution. A deferred initialization
block runs when its target variable is used for the first time within a BI session.

To set up initialization blocks for ApplSession integration:
1. In the Administration Tool, select Manage, then select Variables.
2. Select Action > New > Session > Initialization Block.

3. Provide a name for the initialization block (for example, create_ AOL_SESSION_
ID_Pillarl). This initialization block creates a new AOL session when a data query
is issued against the data source (for example, Pillar1_http).

4. Click Edit Data Source.

5. Select Default initialization string, and provide an XML initialization string
similar to the following:

<?xml version="1.0" encoding="1is0-8859-1" standalone="yes"?>
<ADFQuery mode="create_applsession">
<ContextAttribute>
<Name><! [CDATA[ADDTL_CUSTOM_LEVEL] ] ></Name>
<Value><! [CDATA [VALUEOF (NQ_ SESSION.AOL_ADDTL_CUSTOM_LEVEL)]]></Value>

Working with ADF Data Sources 6-31



Setting Up and Using ApplCore Grants for ADF Data Security

</ContextAttribute>
<ContextAttribute>
<Name><! [CDATA [CLIENT_ENCODING] ]></Name>
<Value><! [CDATA [VALUEOF (NQ_SESSION.AOL_CLIENT_ ENCODING)]]></Value>
</ContextAttribute>
<ContextAttribute>
<Name><! [CDATA [CURRENCY] ] ></Name>
<Value><! [CDATA [VALUEOF (NQ_SESSION.AOL_CURRENCY) ]]></Value>
</ContextAttribute>
</ADFQuery>

This initialization string causes the OBIEE broker servlet to create a Java AOL
session.

The <ContextAttribute> elements represent the name-value pairs of context
variables that will be propagated to the newly created AOL session. If no
<ContextAttribute> elements are specified in the XML initialization string, default
values of the user are used to create the AOL session.

The values provided in the <Value> elements are mapped to the session variables
initialized by Presentation Services.

The following list shows a full mapping between AOL context attributes and
session variables initialized by Presentation Services:

ACCESSIBILITY_MODE - AOL_ACCESSIBILITY_MODE
ACTION - AOL_ACTION

ADDTL_CUSTOM_LEVEL - AOL_ADDTL_CUSTOM_LEVEL
ANIMATION_ENABLED - AOL_ANIMATION ENABLED
APPLICATION_LANGUAGE - AOL_APPLICATION_ LANGUAGE
CLIENT ENCODING - AOL_CLIENT_ENCODING
COLOR_CONTRAST - AOL_COLOR_CONTRAST

CURRENCY - AOL_CURRENCY

DATE_FORMAT - AOL_DATE_FORMAT

DECIMAL_SEPARATOR - AOL_DECIMAL_SEPARATOR
EMBEDDED_HELP_ENABLED - AOL_EMBEDDED_HELP_ENABLED
FONT_SIZE - AOL_FONT SIZE

GROUPING_SEPARATOR - AOL_GROUPING_SEPARATOR
HISTORY_OVERRIDE_USER_NAME - AOL_HISTORY OVERRIDE_USER_NAME
INDUSTRY - AOL_INDUSTRY

INDUSTRY IN_TERRITORY - AOL_INDUSTRY IN_TERRITORY
LANGUAGE - AOL_LANGUAGE

MODULE - AOL_MODULE

NLS_SORT - AOL_NLS_SORT

NUMBER_FORMAT - AOL_NUMBER_FORMAT

PRODUCT - AOL_PRODUCT

PRODUCT _FAMILY - AOL_PRODUCT FAMILY

TERRITORY - AOL_TERRITORY

TIME_FORMAT - AOL_TIME FORMAT

TIMEZONE - AOL_TIMEZONE

TRACE_LEVEL - AOL_TRACE_LEVEL

Application-specific, nonstandard variables that do not appear in the preceding
list can be propagated in the same manner.

6. Click Browse next to Connection Pool and select the connection pool for the data
source (for example, Pillarl_http_cp), then click Select.

7. Click OK in the Session Variable Initialization Block Data Source dialog.
8. Click Edit Data Target, then click New.
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9. Create a variable to be initialized by this initialization block. The name must be in

the following format:

AOL_SESSION_ID_physical_layer_database_object_for_pillar

For example:

AOL_SESSION_ID_Pillarl_http

10. Click OK in the Session Variable Initialization Variable Target dialog.

11. Select Allowed deferred execution. Selecting this option means that this
initialization block only executes when a data query is issued against Pillar1.

12. Click OK in the Session Variable Initialization Block dialog.

13. Repeat the steps in this procedure for each pillar, if you have more than one.

Figure 6-9 shows an example pillar-specific session variable initialization block.

Figure 6-9 Session Variable Initialization Block Dialog for Pillar-Specific Initialization

Block
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Shows the Session Variable Initialization Block dialog for a pillar-specific initialization
block. The initialization block name is create_ AOL_SESSION_ID_Pillar]l, and Allow
deferred execution is selected. The selected connection pool is "Pillar]l_http"."Pillarl_
http_cp," and the target variable is AOL_SESSION_ID_Pillarl_http.
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About the Client Login Process in an ApplSession Integrated Environment
The following steps provide an example of the client login process when you have
integrated Oracle Business Intelligence with ApplSession:

1. A client logs in to the Oracle BI Server with the Bl session variables that represent
AOL context.

2. The BI Session is established.

3. The client issues a Logical SQL statement that navigates to the database object (for
example, Pillar1_http).

4. The initialization block runs and initializes the session variable (for example,
create_ AOL_SESSION_ID_Pillar] initializes AOL_SESSION_ID_Pillarl_http).

5. The session variable (for example, AOL_SESSION_ID_Pillarl_http) is attached
within the OBIEE broker servlet before querying Composite view object SQL from
the database object (for example, Pillar1l_http).

6. The Oracle BI Server replans the query with Composite view object SQL.

7. The session variable (for example, AOL_SESSION_ID_Pillarl_http) is attached
using the pre-query script in the connection pool before querying data directly
from the SQL bypass database object (for example, Pillarl_bypass).

Setting Up Authentication for ApplSession Integration

Oracle Business Intelligence provides a custom identity assertion provider that must
be installed in Oracle WebLogic Server. This custom asserter is used to extract a token
from the HTTP request from Oracle Business Intelligence. The super user name and
password provided in the repository connection pool object, as well as the session user
name provided in the BI user session, are extracted from the token.

Authentication is performed in the custom asserter using the super user name and
password. After the super user's credentials are authenticated, the custom asserter
performs identity assertion using the session's user name. One-way SSL is required to
secure the communication channel between Oracle Business Intelligence and Oracle
WebLogic Server.

Note that the custom identity assertion provider only allows a user with the user name
FUSION_APPS_BI_APPID to perform identity assertion. In other words, the user
specified in the connection pool (the ADF HTTP connection pool, not the SQL bypass
connection pool) must be FUSION_APPS_BI_APPID.

This section describes the configuration tasks you need to perform in the application
before deploying to Oracle WebLogic Server for Oracle Business Intelligence
consumption.

Ensure that you have completed the tasks described in "Setting Up ADF Data Sources"
before you perform the steps in the following sections.

This section contains the following topics:

= Setting Up Security Constraints and Security-Related Servlet Filters in web.xml
= Configuring Role-to-Principal Mapping in weblogic-application.xml

s Configuring the Custom Identity Assertion Provider in Oracle WebLogic Server

= Configuring One-Way SSL in Oracle WebLogic Server

6-34 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



Setting Up and Using ApplCore Grants for ADF Data Security

Setting Up Security Constraints and Security-Related Servlet Filters in web.xml

You must set up the CLIENT-CERT authentication method in web.xml to trigger the
custom identity assertion provider during log-on. In addition, you need to set up the
JPS servlet filter in web.xml for data security to work properly.

To set up the CLIENT-CERT authentication method and servlet filters in web.xml:
1. In]JDeveloper, expand the Web Project for OBIEEBroker and open web.xml.
2. Go to the source view of the file.

3. To set up the CLIENT-CERT authentication method, include the following
elements under the <web-app> element:

<security-constraint>
<web-resource-collection>
<web-resource-name>restricted</web-resource-name>
<url-pattern>/obieebroker</url-pattern>
</web-resource-collection>
<auth-constraint>
<role-name>EndUsers</role-name>
</auth-constraint>
</security-constraint>
<login-config>
<auth-method>CLIENT-CERT</auth-method>
<realm-name>myrealm</realm-name>
</login-config>
<security-role>
<role-name>EndUsers</role-name>
</security-role>

Note that the value for <role-name> can be anything. This value will eventually be
mapped to principals that exist in the security realm; see "Configuring
Role-to-Principal Mapping in weblogic-application.xml" for more information.

4. To set up the JPS servlet filter, include the following <filter> elements before the
<filter> element for ServletADFFilter:

<filter>
<filter-name>JpsFilter</filter-name>
<filter-class>oracle.security.jps.ee.http.JpsFilter</filter-class>
</filter>

Then, include the following <filter-mapping> elements before the
<filter-mapping> element for ServletADFFilter:

<filter-mapping>
<filter-name>JpsFilter</filter-name>
<servlet-name>OBIEEBroker</servlet-name>
<dispatcher>FORWARD</dispatcher>
<dispatcher>REQUEST</dispatcher>
<dispatcher>INCLUDE</dispatcher>
</filter-mapping>

Configuring Role-to-Principal Mapping in weblogic-application.xml
You must map the value you provided for <role-name> in web.xml to principals that
exist in the security realm. This mapping is defined in weblogic-application.xml.

To configure role-to-principal mapping in weblogic-application.xml:

1. In]JDeveloper, under Application Resources, open Descriptors > META-INF >
weblogic-application.xml.
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3.

Include the following <security> element under the <weblogic-application>
element:

<security>
<realm-name>myrealm</realm-name>
<security-role-assignment>
<role-name>your role_name</role-name>
<principal-name>your_principal_name</principal-name>
</security-role-assignment>
</security>

Note the following:

= Replace your_role_name with the actual value you provided for <role-name> in
web.xml.

= Replace your_principal_name with the name of either a BI session end user (for
example, joeUser), or an Oracle WebLogic Server group (for example,
testUsers).

Redeploy the application.

Configuring the Custom Identity Assertion Provider in Oracle WebLogic Server
This section explains how to configure the custom identity assertion provider.

To configure the custom identity assertion provider in Oracle WebLogic Server:

1.

10.
11.
12.

Locate the custom identity assertion provider jar file, located in your Oracle
Business Intelligence installation directory at:

ORACLE_HOME/bifoundation/javahost/lib/obisintegration/adf/
biadfidentityasserter.jar

Copy the jar file to the following Oracle WebLogic Server location:

MW_HOME/wlserver_10.3/server/lib/mbeantypes

Restart the Oracle WebLogic Server.

Open the WebLogic Server Administration Console. For example, if your Oracle
WebLogic Server is running locally on port 7001, go to
http://localhost:7001/console.

Log in to the WebLogic Server Administration Console with the credentials you
created when you set up your WebLogic domain.

In the Change Center, click Lock & Edit.

In the left pane, select Security Realms, and then click the security realm that you
want to configure.

Click the Providers tab, then click New.

Enter a name (for example, BI-ADF Identity Asserter) and select
BIADFIdentityAsserter for Type.

Click OK.
In the Change Center, click Activate Changes.
Restart the Oracle WebLogic Server.
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Configuring One-Way SSL in Oracle WebLogic Server

One-way SSL is required to properly secure the communication between Oracle
Business Intelligence and Oracle WebLogic Server.

To configure one-way SSL in Oracle WebLogic Server:

1.

From the WebLogic Server Administration Console home page, click Servers
under the Environment heading.

In the Servers table, the name of the server you want to manage. Then, on the
General subtab of the Configuration tab, select SSL Listen Port Enabled.

Use the Administration Tool to update the appropriate connection pool object in
the Physical layer so that the URL uses https:// instead of http://. Also, update
the port number to use the SSL port (7002 by default).

Configuring Two-Way SSL in Oracle WebLogic Server

Optionally, you can set up two-way SSL to secure the communication between Oracle
Business Intelligence and the Oracle WebLogic Server.

To set up and test two-way SSL:

1.

Create client certificates in the Oracle BI Server, if they do not already exist. See
"Creating Certificates and Keys in Oracle Business Intelligence" in Oracle Fusion
Middleware Security Guide for Oracle Business Intelligence Enterprise Edition for more
information.

Modify the ADF Oracle WebLogic Server to accept SSL connections and to
perform mutual SSL. To do this, perform the following steps in the Oracle
WebLogic Server Administration Console:

a. Login to the Administration Console and click Servers under the
Environment heading, then click the server name (for example, AdminServer).

b. In the Change Center, click Lock & Edit to enable configuration changes.

c. Inthe General tab, select SSL Listen Port Enabled and record the SSL Listen
Port number. Then, click Save.

d. Select the SSL tab, then select Advanced. For Two Way Client Cert Behavior,
select Client Certs Requested and Enforced. Then, click Save.

e. Select the Keystores tab and record the Trust Keystore that is being used. For
example, if the Demo Trust keystore is used, record its location and file name.

f. Click Activate Changes.

Ensure that the Certificate Authority (CA) for the Oracle Bl Server client certificate
is trusted by the ADF Oracle WebLogic Server. To do this, follow these steps:

a. On the Oracle Bl Server computer, find the CA file for the client certificate. If
the file was generated using the instructions referenced in Step 1, the file will
be "cacert.pem" in:

ORACLE_HOME/user_projects/domains/bifoundation_domain/config/fmwconfig
/biinstances/coreapplication/ssl

Copy this file to a known location.

b. On the ADF Oracle WebLogic Server computer, open a command window
and go to the location of the trust keystore. You recorded this value in Step 2.
For example:

/scratch/user_name/view_storage/user name_fmw/fmwtools/mw_home/wlserver_
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Copy the client CA file (for example, cacert.pem), stored in the previous step,
to this location.

c. Use the JDK keytool utility to import the client CA into the trust keystore for
the ADF server, making it a trusted CA. Use the following command:

keytool -import -file client_CA_file -keystore keystore file -keystorepass
keystore password
For example:

/scratch/my_name/view_storage/my_name_fmw/jdk6/bin/keytool -import -file
~/Downloads/SSL/cacert.pem -keystore DemoTrust.jks -keystorepass
DemoTrustKeyStorePassPhrase

d. Restart the ADF Oracle WebLogic Server.
4. Update the Physical layer of the Oracle Bl repository, as follows:

a. Inthe Administration Tool, in the Physical layer, open the first ADF
connection pool object and select the Miscellaneous tab.

b. Update the URL field to use the https protocol and the SSL port noted in Step
2, and then click OK.

c. Repeat the previous two steps for each additional ADF connection pool object.
d. Save the repository and restart the Oracle BI Server.

5. Configure the Oracle Bl Server ODBC DSN to use SSL. For example, on Windows:
a. Open the ODBC Data Source Administrator and select the System DSN tab.

b. Double-click the DSN for the Oracle BI Server. The DSN should start with
"coreapplication_OH."

c. Select Use SSL.
d. Click Next, click Next again, and then click Finish.

6. Perform queries against ADF using your Oracle BI Server client of choice (such as
ngcmd). The Oracle BI Server should now be communicating with the ADF Oracle
WebLogic Server using mutual SSL / client certs.

Enabling the Ability to Pass Custom Parameters to the ADF Application

Some ADF applications have custom properties defined on the ApplicationModule,
such as EFFECTIVE_DATE or TREE_VERSION. You can include these custom
properties in your application queries, and the Oracle BI Server will pass them to the
ADF application. To enable this feature, you must register the custom properties as a
static repository variable using the Administration Tool.

You cannot use this feature to pass any custom property to your ADF application.
Only certain custom properties, like EFFECTIVE_DATE and TREE_VERSION, are
supported.

To register custom properties:

1. Open your repository in the Administration Tool.
2. Select Manage, then select Variables.

3. Select Action > New > Repository > Variable.
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4. For Name, enter ADF_PARAM_LIST. Do not enter the name of the custom
property as the name of the variable.

5. Ensure that the Type is Static.

6. For Default Initializer, enter the name or names of the custom properties as a
character string. If you have multiple custom properties, include them as a
comma-delimited list. For example:

'PARAM_EFFECTIVE_DATE'

'PARAM_EFFECTIVE_DATE, ApplicationldBind, KeyFlexfieldCodeBind'
7. Click OK.
8. Save and close the repository.

After you register the custom properties as a repository variable, you can include these
variables in queries. For example:

set variable PARAM_EFFECTIVE_DATE=2001-01-01 : SELECT cl FROM tl1;

or

set variable ApplicationIdBind = '0', KeyFlexfieldCodeBind = 'KFF1' :
select_physical ApplicationID, KeyFlexfieldCode, DataSecurityObjectName,
SegmentLabelCode from adfdb..."AppModule.KFFHierFilterVol";

Note that when you are including a custom property of type PARAM_EFFECTIVE_
DATE, the date format for the property value must be in the format yyyy-mm-dd.

Propagating Labels and Tooltips from ADF Data Sources

You can propagate user interface hints, such as labels and tooltips, from ADF data
sources to display when users work with analyses. When translated labels and tooltips
(based on user locale) are maintained within an ADF data source, you can query the
data source to access this translated data. You use the Administration Tool to
configure presentation columns to use when creating analyses.

This section contains the following topics:

= What are Labels and Tooltips?

= About the Session Variable Naming Scheme for Ul Hints

= About Determining the Physical Column for a Presentation Column
» Initializing Session Variables Automatically for Propagating Ul Hints

»  Example of Using Ul Hints From an Oracle ADF Data Source When Creating
Analyses

s Using XML Code in Initialization Blocks to Query UI Hints

What are Labels and Tooltips?

A label is the text that is used in prompts or table headers that precedes the value of a
data item. A tooltip is the text that is displayed when a user hovers the mouse pointer
over the item. Each attribute of a view object has an associated label and tooltip. A
view object is the Oracle Application Development Framework component that
enables a developer to work easily with SQL query results. The propagation of Ul
hints enables a presentation column in the Administration Tool to use a label and
tooltip as its Custom display name and Description respectively.
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Figure 6-10 shows the Label Text and Tooltip Text options in the Edit Attribute dialog
in Oracle JDeveloper.

Figure 6—10 Edit Attribute Dialog in JDeveloper for Label and Tooltip Options
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About the Session Variable Naming Scheme for Ul Hints

Session variable names are generated by the Oracle BI Enterprise Edition broker
servlet in Oracle WebLogic Server in the following format:

ADF_UI Hint Type_Database Name_View Object Name_Attribute Name
Where:

Ul Hint Type is either LABEL or TOOLTIP, depending on the Ul hint type that the
session variable represents.

Database Name is the value of the "database" attribute of the ADFQuery element in the
XML query. Special characters such single quotes ('), double quotes ("), and spaces are
replaced by the underscore character.

View Object Name is the name of the view object to which the attribute belongs. Oracle
ADF prohibits special characters and spaces in the name.

Attribute Name is the name of the attribute that the session variable represents. Oracle
ADF prohibits special characters and spaces in the name.

Every character in the session variable name is uppercase. For example, the XML
query in Example 6-3 generates four session variables with the following names:

ADF_LABEL_MY_ORCLADF_EMPLOYEESVIEW_FIRSTNAME
ADF_TOOLTIP_MY_ORCLADF_EMPLOYEESVIEW_FIRSTNAME
ADF_LABEL_MY_ORCLADF_EMPLOYEESVIEW_LASTNAME
ADF_TOOLTIP_MY_ORCLADF_EMPLOYEESVIEW_LASTNAME
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About Determining the Physical Column for a Presentation Column

As required by the naming scheme for session variables, each presentation column
must map to a physical column. When you select Externalize Display Names >
Generate ADF Label or Externalize Descriptions > Generate ADF Tooltip for a
presentation layer object, then the physical column is located using the following
rules:

1. Examine the presentation column and determine its logical column. If the logical
column is derived from an existing logical column, then the physical column
cannot be found.

2. If the default aggregation rule for the logical column is not None or Sum, then the
physical column cannot be found. It does not make sense semantically to use the
ADF Ul hints for aggregation rules other than Sum.

3. Alogical column can be mapped to physical columns by multiple logical table
sources. Only logical table sources that are not disabled are searched.

4. Do not search logical table sources that map the logical column using non-trivial
expressions (that is, anything more than a physical column name). If no logical
table sources are searched, then the physical column cannot be found.

5. From the remaining ordered list of logical table sources, examine the physical
column that is mapped by the first logical table source. The physical column must
be mapped to a view object attribute. In other words, the physical column must be
part of a physical database of type OracleADF11g.

s If this condition is satisfied, then the physical column for obtaining UI hints is
found.

= If this condition is not satisfied, then continue to examine the physical column
that is mapped by the next logical table source until the physical column that
is mapped to a view object attribute is found.

If all logical table source are searched without satisfying the condition, then
the physical column cannot be found.

If the physical column for obtaining Ul hints is found using these rules, then the
custom display name or description is populated with a session variable that has a
name based on a predetermined naming scheme. See "About the Session Variable
Naming Scheme for UI Hints" for more information.

If the physical column for obtaining UT hints is not found using these rules, then the
Generate ADF Label and Generate ADF Tooltip options are shown as disabled in the
right-click menu.

As an alternative to using the physical column found using these rules, you can use
XML code in an initialization block to initialize your own session variables with ADF
UI hints. You must then enter these session variable names in the Custom display
name and Custom description fields manually. See "Using XML Code in Initialization
Blocks to Query UI Hints" for more information.

Initializing Session Variables Automatically for Propagating Ul Hints

If the Externalize Display Names > Generate ADF Label and Externalize
Descriptions > Generate ADF Tooltip options were used to successfully generate the
session variable names for Ul hints from Oracle ADF, then the session variables are
created and initialized when Oracle BI Presentation Services queries them during the
session. The variables are not created and initialized during the session logon stage for
performance reasons. Instead, the variables are created and initialized when they are
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needed by a specific query within a session, using the Allow deferred execution
feature.

When Presentation Services queries the custom display names and custom
descriptions through ODBC, the Oracle BI Server checks if the associated session
variables have been created. If they have not been created, then the Oracle BI Server
dynamically generates the appropriate XML query (as described in "Using XML Code
in Initialization Blocks to Query UI Hints") to query the UI hints from the Oracle ADF
data source. The Oracle BI Server uses the UI hints to create and initialize the session
variables. As an optimization, the Oracle BI Server queries UI hints for each view
object; that is, if the Oracle BI Server needs the UI hints of a view object's attributes,
then the UI hints for all the attributes under the view object are queried and
propagated through session variables.

Example of Using Ul Hints From an Oracle ADF Data Source When Creating Analyses

The following example shows how you can use Ul hints from an Oracle ADF data
source when creating analyses.

The following prerequisites must be met:
s Ul hints must have been configured in the Oracle ADF data source.

= A working repository must have been configured for the Oracle ADF data source
in the Administration Tool.

To use Ul hints from an Oracle ADF data source when creating analyses:

1. Suppose that the repository contains a presentation column named "LastName."
On the General tab of the Presentation Column dialog, the Custom display name
and Custom description fields are not selected.

Right-click the column in the Presentation layer and select first Externalize
Display Names > Generate ADF Label, then Externalize Descriptions >
Generate ADF Tooltip to generate the strings that populate the Custom display
name and Custom description fields.

You can also use these options from the right-click menu of a presentation table to
generate the strings for all the columns in that table.

2. View the Ul hints:
a. Sign in to Oracle Business Intelligence.
b. Create a new analysis using the subject area for which you obtained UI hints.

c. In the Subject Areas pane, expand the Employee folder to see the Ul hints that
have been propagated from the Oracle ADF data source.

The LastName column displays as "Last Name" (the label value from the
Oracle ADF data source). When you hover the mouse pointer over the
column, the tip displays as "This is the employee's last name" (the tooltip
value from the Oracle ADF data source).

For information about creating analyses, see Oracle Fusion Middleware User’s Guide
for Oracle Business Intelligence Enterprise Edition (Oracle Fusion Applications Edition).

Using XML Code in Initialization Blocks to Query Ul Hints

As an alternative to using the automated system described in the previous section, you
can use specialized XML code in place of SQL statements in initialization blocks to
query the data source for Ul hints, within a single repository and subject area. You use
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the ADFQuery element, which has three attributes that are named mode, database,
and locale. The element requires zero or more child elements. The syntax of the
element is as follows:

<?xml version="1.0" encoding="is0-8859-1" standalone="vyes"?>

<ADFQuery mode="mode" database="database_name"

locale="VALUEOF (NQ_SESSION.WEBLANGUAGE) ">
<ViewObject><! [CDATA[view object_name]]></ViewObject>
<Attribute>
<ViewObject><! [CDATA[attribute view object_name}]]></ViewObject>
<Name><! [CDATA[attribute name]]></Name>
</Attribute>

</ADFQuery>

Where:

mode specifies what you want to query:

= label for querying attributes' label

= tooltip for querying attributes' tooltip

= ui_hints for querying attributes' label and tooltip

database_name specifies the name of the physical database object in the
Administration Tool, which contains the physical columns that correspond to the
attributes in the Oracle ADF data source.

view_object_name specifies the name of the view object to obtain the Ul hints of all
attributes in it.

attribute_view_object_name specifies the name of the view object that contains the
attribute.

attribute_name specifies the name of the attribute that belongs to the associated view
object to obtain the Ul hints of this attribute.

Example 6-1 Querying Labels for All View Objects

No child elements must be included in the ADFQuery element, if the UI hints of all
attributes in all view objects are queried. For example, to query the labels of all
attributes in all view objects under the My_orclADF physical database object, use the
following XML code:

<?xml version="1.0" encoding="is0-8859-1" standalone="yes"?>
<ADFQuery mode="label" database="My_orclADF"

locale="VALUEOF (NQ_SESSION.WEBLANGUAGE) ">

</ADFQuery>

Example 6-2 Querying Tooltips for Specific View Objects

The ADFQuery element can contain zero or more child elements named ViewObject if
UI hints of all attributes in specific view objects are queried. Each ViewObject element
has a text content that contains the View Object's name. The ViewObject element is
used to specify the View Objects from which the UI hints of all attributes are queried.
For example, to query the tooltips of all attributes in the View Object that is named
EmployeesView and CustomersView under the My_orclADF physical database object,
use the following XML code:

<?xml version="1.0" encoding="is0-8859-1" standalone="yes"?>

<ADFQuery mode="tooltip" database="My_orclADF"

locale="VALUEOF (NQ_SESSION.WEBLANGUAGE) ">
<ViewObject><! [CDATA [EmployeesView] ] ></ViewObject>
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<ViewObject><! [CDATA[CustomersView] ] ></ViewObject>
</ADFQuery>

Example 6-3 Querying Ul Hints for Specific Attributes

The ADFQuery element can contain zero or more child elements named Attribute.
Each Attribute element has two required child elements named ViewObject and
Name. The Attribute element is used to specify the attributes from which the UI hints
are queried. The ViewObject child element has a text content that contains the View
Object's name. This element specifies the View Object that the attribute belongs to. The
Name child element has a text content which contains the attribute's name. For
example, to query the labels and tooltips of the attributes named Firstname and
Lastname in the EmployeesView View Object under the My_orclADF physical
database object, use the following XML code:

<?xml version="1.0" encoding="is0-8859-1" standalone="yes"?>
<ADFQuery mode="ui_hints" database="My_orclADF"
locale="VALUEOF (NQ_SESSION.WEBLANGUAGE) ">
<Attribute>
<ViewObject><! [CDATA[EmployeesView] ] ></ViewObject>
<Name><! [CDATA [Firstname] ] ></Name>
</Attribute>
<Attribute>
<ViewObject><! [CDATA [EmployeesView] ]></ViewObject>
<Name><! [CDATA [Lastname] ] ></Name>
</Attribute>
</ADFQuery>

After configuring the initialization blocks, you must manually enter the session
variable names in the Custom display name and Custom description text fields for
the appropriate presentation column.

Follow the procedure in the example in "Example of Using UI Hints From an Oracle
ADF Data Source When Creating Analyses", but replace the first step with the
following ones:

1. Create session initialization blocks in the Administration Tool.

a. In the Session Variable Initialization Block Data Source dialog, enter the
Initialization string.

In this example, the initialization block queries both the label and tooltip of all
attributes in a View Object named EmployeesView. Figure 6-11 shows the
setup of a session variable initialization block with an appropriate Oracle ADF
Ul hint query. "My_orclADF"."Connection Pool" is a connection pool for an
Oracle ADF data source.
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Figure 6-11 Setting Up a Session Variable Initialization Block Data Source with an
Oracle ADF Ul Hints Query
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2.

b.

In the Session Variable Initialization Block dialog, select Row-wise
initialization as the Variable Target.

Click Test to test the query against the Oracle ADF data source.

In the results window, the first column contains the session variable names
that are generated using the naming scheme. The second column contains the
label and tooltip values from the Oracle ADF data source.

See "About the Session Variable Naming Scheme for UI Hints" for a
description of the naming scheme.

Configure a custom display name and a description in presentation columns.

To find the presentation tables that can use the UI hints from the EmployeesView
View Object, this example uses the Query Repository feature in the Administration
Tool.

a.

Right-click a physical table (for example, EmployeesView), then select Query
Related Objects > Presentation > Presentation Table from the menu.

The Query Related Objects dialog displays all the related presentation tables.

This example sets up a custom display name and custom description for
columns in the Employee presentation table.
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Figure 6-12 Using the Query Related Objects Feature to Find the Related Presentation

Tables
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b. Select the required presentation table and click Go To.

This displays the selected presentation table.

c. Expand the presentation table to view the presentation columns.

d. Double-click the LastName presentation column to display the Presentation

Column dialog.

e. Select Custom display name and enter a value such as the following one:

VALUEOF (NQ_SESSION.ADF_LABEL_MY_ ORCLADF_EMPLOYEESVIEW_LASTNAME)

f.  Select Custom description and enter a value such as the following one:

VALUEOF (NQ_SESSION.ADF_TOOLTIP_MY_ ORCLADF_EMPLOYEESVIEW_LASTNAME)

Click OK.

Save the changes in the repository and restart the Oracle BI Server.
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Setting Up Database Objects and
Connection Pools

This chapter describes the properties of the database and connection pool objects in
the Physical layer.

Properties for database objects and connection pools are typically set automatically
when you import metadata from your data sources. However, in some cases you may
want to adjust database or connection pool settings, or create a database object or
connection pool manually.

This chapter contains the following sections:
»  Setting Up Database Objects

= About Connection Pools

s Creating or Changing Connection Pools

s Setting Up Persist Connection Pools

Setting Up Database Objects

Importing metadata from a data source automatically creates a database object for the
schema, but you may need to adjust or view the database properties. In addition, you
sometimes need to manually create a database object and connection pool for certain
situations like configuring usage tracking, setting up Oracle Scorecard and Strategy
Management, or configuring aggregate persistence targets.

See "System Requirements and Certification" for information about supported data
sources.

The following sections provide information about how to create, edit, or view
properties for database objects in the Physical layer:

= About Database Types in the Physical Layer
»  Creating a Database Object Manually in the Physical Layer
= Specifying SQL Features Supported by a Data Source

= Viewing Database Properties for Oracle ADF Data Sources

About Database Types in the Physical Layer

If you import the physical schema into the Physical layer, the database type is usually
assigned automatically. The following list contains additional information about
automatic assignment of database types:
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= Relational data sources. During the import process, some ODBC drivers provide
the Oracle BI Server with the database type. However, if the server cannot
determine the database type, an approximate ODBC type is assigned to the
database object. Replace the ODBC type with the closest matching entry from the
Database list.

= Multidimensional data sources. Microsoft Analysis Services and SAP/BW are the
only supported XMLA-compliant data sources currently available. After you
import metadata from a multidimensional data source, check the database object
and update the appropriate database type and version if necessary.

Creating a Database Object Manually in the Physical Layer

If you create a database object manually, you also need to manually set up an
associated connection pool.

For multidimensional data sources, if you create the physical schema in the Physical
layer of the repository, you need to create one database in the physical layer for each
cube, or set of cubes, that belong to the same catalog (database) in the data source. A
physical database can have more than one cube. However, all of these cubes must be
in the same catalog in the data source.

Caution: It is strongly recommended that you import your physical
schema.

To create a database object:

1. In the Administration Tool, in the Physical layer, right-click and select New
Database.

Make sure that no object is selected when you right-click.

2. In the Database dialog, in the General tab, complete the fields using Table 7-1 as a
guide.

Table 7-1 Options in the General Tab of the Database Dialog

Option Description
Data source definition: The database type for your database.
Database

See "Specifying SQL Features Supported by a Data Source" for
more information about using the Features tab to examine the
SQL features supported by the specified database type.

Data source definition: This property is only available for relational data sources and is
CRM metadata tables for legacy Siebel Systems sources only.

When selected, indicates that the definition of physical tables
and columns for Siebel CRM tables was derived from the Siebel
metadata dictionary.
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Table 7-1 (Cont.) Options in the General Tab of the Database Dialog

Option Description
Data source definition: Identifies the physical database source as a virtual private
Virtual Private Database database (VPD). When a VPD is used, returned data results are

contingent on the user's authorization credentials. Therefore, it
is important to identify these sources. These data results affect
the validity of the query result set that is used with caching. See
"Managing Performance Tuning and Query Caching" in Oracle
Fusion Middleware System Administrator’s Guide for Oracle
Business Intelligence Enterprise Edition.

Always select this option for Essbase or Hyperion Financial
Management data sources that are configured for SSO using
CSS Token in the corresponding connection pool.

Note: If you select this option, you also should select the
Security Sensitive option in the Session Variable dialog. See
"Creating Session Variables" for more information.

Persist connection pool To use a persistent connection pool, you must set up a
temporary table first. See "Setting Up Persist Connection Pools"
for more information.

Allow populate queries by | When selected, allows everyone to execute POPULATE SQL. If you
default want most, but not all, users to be able to execute POPULATE SQL,
select this option and then limit queries for specific users or
groups. See "Setting Query Limits" for more information.

Allow direct database When selected, allows all users to execute physical queries. The
requests by default Oracle BI Server sends unprocessed, user-entered, physical SQL
directly to an underlying database. The returned results set can
be rendered in Oracle BI Presentation Services, and then
charted, rendered in a dashboard, and treated as an Oracle BI
request.

If you want most, but not all, users to be able to execute
physical queries, select this option and then limit queries for
specific users or groups. See "Setting Query Limits" for more
information.

Caution: If configured incorrectly, this option can expose
sensitive data to an unintended audience. See "When to Allow
Direct Database Requests by Default” for more information.

For more information about executing physical SQL, see
"Working with Direct Database Requests" in Oracle Fusion
Middleware User’s Guide for Oracle Business Intelligence Enterprise
Edition (Oracle Fusion Applications Edition).

When to Allow Direct Database Requests by Default

The property Allow direct database requests by default lets all users execute physical
queries. If configured incorrectly, it can expose sensitive data to an unintended
audience. Use the following recommended guidelines when setting this database
property:

»  The Oracle BI Server should be configured to accept connection requests only from
a computer on which the Oracle Bl Server, Oracle Bl Presentation Services, or
Oracle BI Scheduler are running. This restriction should be established at the
TCP/IP level using the Oracle BI Presentation Services IP address. This allows
only a TCP/IP connection from the IP address of Oracle BI Presentation Services.

= To prevent users from running nqemd (a utility that executes SQL scripts) by
logging in remotely to this computer, you should disallow access by the following
to the computer on which you installed Oracle BI Presentation Services:
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— TELNET

— Remote shells

— Remote desktops

— Teleconferencing software (such as Windows NetMeeting)

If necessary, you might want to make an exception for users with administrator
permissions.

s Only users with administrator permissions should be allowed to perform the
following tasks:

— TELNET into the Oracle Bl Server and Oracle BI Presentation Services
computers to perform tasks such as running nqcmd for cache seeding.

—  Access the advanced SQL page of Answers to create requests. For more
information, see Oracle Fusion Middleware User’s Guide for Oracle Business
Intelligence Enterprise Edition (Oracle Fusion Applications Edition).

= Set up group/user-based permissions on Oracle BI Presentation Services to control
access to editing (preconfigured to allow access by Oracle BI Presentation Services
administrators) and executing (preconfigured to not allow access by anyone)
direct database requests. For more information, see Oracle Fusion Middleware
Security Guide for Oracle Business Intelligence Enterprise Edition.

Specifying SQL Features Supported by a Data Source

When you import metadata or specify a database type in the General tab of the
Database dialog, the set of features for that database object is automatically populated
with default values appropriate for the database type. These are the SQL features that
the Oracle BI Server uses with this data source.

When a feature is marked as supported (checked) in the Features tab of the Database
dialog, the Oracle BI Server typically pushes the function or calculation down to the
data source for improved performance. When a function or feature is not supported in
the data source, the calculation or processing is performed in the Oracle BI Server.

The supported features list in the Features tab uses the feature defaults defined in the
DBFeatures.INI file, located in ORACLE_
INSTANCE\config\OracleBIServerComponent\coreapplication_obisn. Although you
should not moditfy this file directly, it can be useful to look at this file to compare the
features supported by different data source types.

You can tailor the query features for a data source. For example, a new version of a
data source may be released with updated feature support that is not reflected in the
Oracle BI Server defaults. In this case, you can update the settings in the Features tab
to reflect the actual features supported by the new version of the data source. Or, if a
data source supports a particular feature (such as left outer join queries) but you want
to prohibit the Oracle BI Server from sending such queries to a particular data source,
you can change this default setting in the Features tab. A third situation is when you
have federated data sources that execute functions differently. To ensure query results
are consistent, you can disable the appropriate functions so that the calculations are
performed in a consistent manner in the Oracle BI Server.
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Caution: Be very careful when modifying the set of supported
features in the Features tab. If you enable SQL features that the data
source does not support, your query may return errors and
unexpected results. If you disable supported SQL features, the server
could issue less efficient SQL to the data source.

In most cases, you should keep the default values. If you do change
the defaults to mark a feature as supported in the Features tab, make
sure that the feature is actually supported by the data source.

To specify SQL features supported by a data source:

1. In the Administration Tool, in the Physical layer, double-click the database for
which you want to specify SQL features.

2. In the Database dialog, click the Features tab.

3. In the Features tab, use the information in Table 7-2 to help you specify properties
for each SQL feature.

Table 7-2 Options in the Features Tab of the Database Dialog

Option Description

Feature The name of the database feature, such as COUNT_DISTINCT
SUPPORTED.

Value Shows the current value for the given feature. Selected indicates

that the feature is supported in the data source, and that the
function or feature should be performed in the data source
rather than in the Oracle BI Server.

Some features show a default value in the Value column rather
than selected /not selected, such as 10 for MAX_ENTRIES_PER_IN_
LIST.

It is strongly recommended that you keep the default selections
and default values.

Default Shows the default value for the given feature. The defaults
listed in this column are specified in the file DBFeatures.INIL

Find Lets you type a string to help you locate a feature in the list.

Find Again This option becomes available after you click Find. It lets you

perform multiple searches for the same string.

Query DBMS This button is only used if you are installing and querying a
data source that has no set of feature defaults in the Oracle BI
Server. It lets you query this type of data source for Feature
table entries so that you can find out which SQL features it
supports. You can then change the entries that appear in the
Features tab based on your query results.

This button is not available if you are using an XML or a
multidimensional data source.

Caution: Be very careful when using the Query DBMS feature.
The results of the features query are not always an accurate
reflection of the SQL features actually supported by the data
source. When using this feature, you should verify that the list
of supported features in the Features tab matches the actual
features supported by your data source. Refer to the
documentation for your data source for details.

Reset to defaults This button restores the default values for this data source type
from the file DBFeatures.INI.
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Note: Do not change the OPTIMIZE_MDX_FILTER_QUALIFICATION
feature. This parameter is reserved for a future release.

Viewing Database Properties for Oracle ADF Data Sources

For Oracle ADF data sources, you can view custom database properties that are passed
to the Administration Tool from Oracle ADF BI view objects. Click the Database
Properties tab to view the custom properties. You do not typically need to create or
edit these properties.

Table 7-3 shows examples of custom properties.

Table 7-3 Examples of Custom Properties in the Database Properties Tab

Category Key Name Value Description
FscmTopModelAM. | BIObject_FLEX_TREE_ Dim - Cost Center FLEX_TREE_VS_COST_
AccountBIAM VS_COST_CENTER_ CENTER_LABEL_VI view object
LABEL_VI needs to map to the Dim - Cost
Center logical dimension
FscmTopModelAM. | BIFlexfieldViewUsage FLEX_BI_AcctKff_VI FLEX_BI_AcctKff_VIis the CCID
AccountBIAM view object for
FscmTopModel AM.AccountBIA
M
FscmTopModelAM. | EnforceCustomDataType_ | "Segment For
AccountBIAM FscmTopModelAM.Accou | 1":"VARCHAR"; FscmTopModel AM.AccountBIA
ntBIAM "Segment ID":"DOUBLE" | M view objects, the data type of
some physical columns needs to
be overridden with the values
passed in the property

About Connection Pools

The connection pool is an object in the Physical layer that describes access to the data
source. It contains information about the connection between the Oracle BI Server and
that data source.

The Physical layer in the Administration Tool contains at least one connection pool for
each database. When you create the Physical layer by importing a schema for a data
source, the connection pool is created automatically. You can configure multiple
connection pools for a database. Connection pools allow multiple concurrent data
source requests (queries) to share a single database connection, reducing the overhead
of connecting to a database.

Note: Itis recommended that you create a dedicated connection pool
for initialization blocks. See "About Connection Pools for Initialization
Blocks" for more information.

For each connection pool, you must specify the maximum number of concurrent
connections allowed. After this limit is reached, the connection request waits until a
connection becomes available.

Increasing the allowed number of concurrent connections can potentially increase the
load on the underlying database accessed by the connection pool. Test and consult
with your DBA to make sure the data source can handle the number of connections
specified in the connection pool. Also, if the data sources have a charge back system
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based on the number of connections, you might want to limit the number of
concurrent connections to keep the charge-back costs down.

In addition to the potential load and costs associated with the database resources, the
Oracle BI Server allocates shared memory for each connection upon server startup.
This raises the number of connections and increases Oracle Bl Server memory usage.

About Connection Pools for Initialization Blocks

It is recommended that you create a dedicated connection pool for initialization
blocks. This connection pool should not be used for queries.

Additionally, it is recommended that you isolate the connections pools for different
types of initialization blocks. This also makes sure that authentication and
login-specific initialization blocks do not slow down the login process. The following
types should have separate connection pools:

= All authentication and login-specific initialization blocks such as language,
externalized strings, and group assignments.

s All initialization blocks that set session variables.

= Allinitialization blocks that set repository variables. These initialization blocks
should always be run using credentials with administrator privileges.

Be aware of the number of these initialization blocks, their scheduled refresh rate,
and when they are scheduled to run. Typically, it would take an extreme case for
this scenario to affect resources. For example, refresh rates set in minutes, greater
than 15 initialization blocks that refresh concurrently, and a situation in which
either of these scenarios could occur during prime user access time frames.

Initialization blocks should be designed so that the maximum number of Oracle BI
Server variables may be assigned by each block. For example, if you have five
variables, it is more efficient and less resource intensive to construct a single
initialization block containing all five variables. When using one initialization block,
the values are resolved with one call to the back end tables using the initialization
string. Constructing five initialization blocks, one for each variable, would result in
five calls to the back end tables for assignment.

If an initialization block fails for a particular connection pool during Oracle BI Server
start-up, no more initialization blocks using that connection pool are processed.
Instead, the connection pool is blacklisted and subsequent initialization blocks for that
connection pool are skipped. This behavior ensures that the Oracle BI Server starts in a
timely manner, even when a connection pool has a large number of associated
initialization blocks or variables.

If this occurs, a message similar to the following appears in the server log:

[OracleBIServerComponent] [ERROR:1] [43143] Blacklisted connection pool
name_of_connection_pool

If you see this error, check the initialization blocks for the given connection pool to
ensure they are correct.

See "Working with Initialization Blocks" for more information about these objects.

Creating or Changing Connection Pools

Typically, database objects and connection pools are created automatically when you
import physical schemas, for both relational and multidimensional data sources. If you
did not import physical schemas, you must create a database object before you create a
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connection pool. You create or change a connection pool in the Physical layer of the
Administration Tool.

If you have already defined an existing database and connection pool, you can
right-click the connection pool in the Physical layer and select Import Metadata to
import metadata for this data source. The Import Metadata Wizard appears with the
information on the Select Data Source screen pre-filled. See Chapter 5, "Importing
Metadata and Working with Data Sources" for information about the Import Wizard.

To automate connection pool changes for use in a process such as production
migration, consider using the Oracle BI Server XML APL. See "About the Oracle BI
Server XML API" in Oracle Fusion Middleware XML Schema Reference for Oracle Business
Intelligence Enterprise Edition for more information.

To create or change a connection pool:

1. In the Physical layer of the Administration Tool, right-click a database and select
New Object, then select Connection Pool. Or, double-click an existing connection
pool.

2. Specify or adjust the properties as needed, then click OK.

The following sections describe how to set properties in the various tabs of the
Connection Pool dialog:

= Setting Connection Pool Properties in the General Tab

»  Setting Connection Pool Properties in the Connection Scripts Tab
s Setting Connection Pool Properties in the XML Tab

s Setting Connection Pool Properties in the Write Back Tab

= Setting Connection Pool Properties in the Miscellaneous Tab

Setting Connection Pool Properties in the General Tab

This section describes the properties in the General tab of the Connection Pool dialog.
The General tab is available for all data sources.

To set general properties for connection pools:

s In the Connection Pool dialog, click the General tab, and then complete the fields
using the information in Table 7—4 and Table 7-5.

The properties listed in the General tab vary according to the data source type. For
example, XMLA data sources have a connection pool property for URL, while
relational and XML data sources have the option Require fully qualified table names.

This section contains the following topics:
s Common Connection Pool Properties in the General Tab

»  Multidimensional Connection Pool Properties in the General Tab

Common Connection Pool Properties in the General Tab

This section describes connection pool properties in the General tab that are common
among most data source types.

Figure 7-1 shows the General tab of the Connection Pool dialog, for an OCI data
source.
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Figure 7-1 General Tab of the Connection Pool Dialog: OCI Data Source

Connection Pool - Sample Relational Connection =]

General | Connection Scriptsl L | white Backl Miscellaneous |

Mame: S ample R elational Connection Permizzions... |
Lall interface: IDefauIt [OCI 10g/11g) j

M aximunn connections: I 1 03:

[T Bequire fully qualified table names

D ata source name: |[DESEHIF'TIDN=[ADDHESS_LIST:[ADDHESS:[F'HDTD
¥ Shared logan

User name: IVALU EOF[DE_USERMAL  Password: quo T

W Enable cormection poaling
Timeaut: I I Infinite j

[V Use multithreaded connections

¥ Parameters supported

lzolation level: IDefauIt j
Descriptian:
Connection pool for Sample relational db zource. ;I

Instead of editing connectivity parameters in each connection pool, update the
RPFD and Sesgion variables that hold that information [Manage > Variables)

|

Ok, I Cancel | Help I

Shows the General tab of the Connection Pool dialog, for an OCI data source.

B R R R R R R S S

Table 7—4 describes the properties in the General tab of the Connection Pool dialog that
are common for different data source types.

Table 7-4 Connection Pool Properties in the General Tab: Common Properties

Property Description

Name The name for the connection pool. A name is assigned
automatically for connection pools created upon import.

Permissions Use this option to assign permissions for individual users or

application roles to access the connection pool. For example,
you can set up a privileged group of users to have its own
connection pool.

This feature is not intended to be used for data access security.
For example, connection pool permissions do not protect cache
entries.

Refer to Chapter 14 for complete information on data access
security in Oracle Business Intelligence.

Call interface

Identifies the application programming interface (API) with
which to access the data source. Some databases can be accessed
using native APIs, some use ODBC, and some work both ways.
If the call interface is XML, the XML tab is available but options
that do not apply to XML data sources are not available.
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Table 7-4 (Cont.) Connection Pool Properties in the General Tab: Common Properties

Property

Description

Maximum connections

The maximum number of connections allowed for this
connection pool. The default is 10. This value should be
determined by the database make and model and the
configuration of the hardware for the computer on which the
database runs, as well as the number of concurrent users who
require access.

For Microsoft Analysis Services data sources, you might
encounter 503 Service Not Available errors if the Max
Connections setting in the connection pool (default 10) is greater
than the XMLA MaxThreadsPerClient setting configured in
Analysis Services (default 4). To avoid these errors, increase the
MaxThreadsPerClient setting in the msmdpump.ini file, or
reduce the Max Connections setting in the repository
connection pool.

See also "Improving Use of System Memory Resources with
TimesTen Data Sources" for related information.

Note: For deployments with Oracle BI Interactive Dashboards
pages, consider estimating this value at 10% to 20% of the
number of simultaneous users multiplied by the number of
requests on a dashboard. This number can be adjusted based on
usage. The total number of all connections in the repository
should be less than 800. To estimate the maximum connections
needed for a connection pool dedicated to an initialization
block, you might use the number of users concurrently logged
on during initialization block execution.
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Table 7-4 (Cont.) Connection Pool Properties in the General Tab: Common Properties

Property

Description

Require fully qualified table

names

Select this option if the database or database configuration
requires fully qualified table names. This option is not available
for some data source types.

When this option is selected, all requests sent from the
connection pool use fully qualified names to query the
underlying database. The fully qualified names are based on the
physical object names in the repository. If you are querying the
same tables from which the Physical layer metadata was
imported, you can safely select this option. If you have migrated
your repository from one physical database to another physical
database that has different database and schema names, the
fully qualified names would be invalid in the newly migrated
database. In this case, if you do not select this option, the
queries will succeed against the new database objects.

For some data sources, fully qualified names might be safer
because they guarantee that the queries are directed to the
desired tables in the desired database. For example, if the
RDBMS supports a master database concept, a query against a
table named Customer first looks for that table in the master
database, and then looks for it in the specified database. If the
table named Customer exists in the master database, that table
is queried, not the table named Customer in the specified
database.

It is sometimes necessary to select this option when you are
using an Oracle Database, and you are accessing the database
with a user that is not the owner of the schema containing the
tables. When the Oracle Database interprets table names in SQL,
it assumes that the user that made the query is the owner if the
table name is not fully qualified in the query. This can result in
an incorrect qualified name.

For example, if the user SAMPLE creates a table called
CUSTOMER, the fully qualified table name is
SAMPLE.CUSTOMER. When the SAMPLE user references the
CUSTOMER table in a query, the Oracle Database assumes the
fully qualified table name is SAMPLE.CUSTOMER, and the
access is successful. However, if the JANEDOE user references
the CUSTOMER table in a query, the Oracle Database assumes
the fully qualified table name is JANEDOE.CUSTOMER, and a
"Table or view not found" error can result. To enable access for
JANEDOE, you must select Require fully qualified table
names in the connection pool so that the Oracle BI Server
specifies SAMPLE.CUSTOMER in all queries.

Data source name

The name of the data source to which you want this connection
pool to connect and send physical queries. The value you enter
in this field depends on the selected call interface:

»  If the call interface is OCI, enter a full connect string or a
net service name from the tnsnames.ora file you set up
within the Oracle Business Intelligence environment, in
ORACLE_HOME /network/admin.

= If you are using a native interface for a different database,
enter the name of the database for that system.

= If the call interface is ODBC, the data source name field
displays a list containing all the User and System DSN’s
defined for ODBC on the local computer. Select the correct
one for the data source to which you want connect.
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Table 7-4 (Cont.) Connection Pool Properties in the General Tab: Common Properties

Property

Description

Shared logon

Select this option if you want all users whose queries use the
connection pool to access the underlying database using the
same user name and password.

If this option is selected, then all connections to the database
that use the connection pool use the user name and password
specified in the connection pool, even if the user has specified a
database user name and password in the DSN (or in user
configuration).

If this option is not selected, connections through the connection
pool use the database user ID and password specified in the
DSN or in the user profile.

Enable connection pooling

When selected, allows a single database connection to remain
open for the specified time for use by future query requests.
Connection pooling saves the overhead of opening and closing
a new connection for every query. If you do not select this
option, each query sent to the database opens a new connection.

Timeout

Specify the amount of time and in what increment (such as
minutes) that a connection to the data source remains open after
a request completes. During this time, new requests use this
connection rather than open a new one (up to the number
specified for the maximum connections). The time is reset after
each completed connection request.

Use multithreaded
connections

When this option is selected, the Oracle BI Server terminates
idle physical queries (threads). When not selected, one thread is
tied to one database connection (number of threads = maximum
connections). Even if threads are idle, they consume memory.

The parameter DB_GATEWAY_THREAD_RANGE in the Server section
of NQSConfig.ini establishes when the Oracle BI Server
terminates idle threads. The lower number in the range is the
number of threads that are kept open before the Oracle BI
Server takes action. If the number of open threads exceeds the
low point in the range, the Oracle BI Server terminates idle
threads. For example, if DB_GATEWAY_THREAD_RANGE is set to
40-200 and 75 threads are open, the Oracle BI Server terminates
any idle threads.

Parameters supported

If this option is not selected, and the database features table
supports parameters, special code executes that allows the
Oracle BI Server to push filters (or calculations) with parameters
to the database. The Oracle BI Server does this by simulating
parameter support within the gateway/adapter layer by
sending extra SQLPrepare calls to the database.
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Table 7-4 (Cont.) Connection Pool Properties in the General Tab: Common Properties

Property Description

Isolation level For ODBC and DB2 gateways only. The value sets the
transaction isolation level on each connection to the back-end
database. The isolation level setting controls the default
transaction locking behavior for all statements issued by a
connection. Only one option can be set at a time. It remains set
for that connection until it is explicitly changed.

The following options are available:

Dirty read. Implements dirty read (isolation level 0 locking).
This is the least restrictive isolation level. When this option is
set, it is possible to read uncommitted or dirty data, change
values in the data, and have rows appear or disappear in the
data set before the end of the transaction.

Dirty data is data that needs to be cleaned before being queried
to obtain correct results (for example, duplicate records, records
with inconsistent naming conventions, or records with
incompatible data types).

Committed read. Specifies that shared locks are held while the
data is read to avoid dirty reads. However, the data can be
changed before the end of the transaction, resulting in non
repeatable reads or phantom data.

Repeatable read. Places locks on all data that is used in a query,
preventing other users from updating the data. However, new
phantom rows can be inserted into the data set by another user
and are included in later reads in the current transaction.

Serializable. Places a range lock on the data set, preventing
other users from updating or inserting rows into the data set
until the transaction is complete. This is the most restrictive of
the four isolation levels. Because concurrency is lower, use this
option only if necessary.

Multidimensional Connection Pool Properties in the General Tab

This section describes connection pool properties in the General tab that are specific to
multidimensional data sources.

Figure 7-2 shows the General tab of the Connection Pool dialog, for an Essbase data
source.
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Figure 7-2 General Tab of the Connection Pool Dialog: Essbase Data Source
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Table 7-5 describes the properties in the General tab of the Connection Pool dialog that
are specific to multidimensional data sources. Note that some properties only appear
for certain types of multidimensional data sources.

Table 7-5 Connection Pool Properties in the General Tab: Multidimensional Data Source

Properties
Property Description
URL This property is only displayed for XMLA data sources. Specify

the URL to connect to the XMLA provider. This URL points to
the XMLA virtual directory of the computer hosting the cube.
This virtual directory must be associated with msxisapi.dll (part
of the Microsoft XML for Analysis SDK installation). For
example, the URL might look like the following:

http:/ /SDCDL360i101 /xmla/msxisap.dll

Essbase Server

This property is only displayed for Essbase data sources.
Specify the name of the Essbase server.
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Table 7-5 (Cont.) Connection Pool Properties in the General Tab: Multidimensional Data

Source Properties

Property

Description

SSO using CSS Token

This property is only displayed for Essbase and Hyperion
Financial Management data sources.

Select this option if you want to authenticate against Essbase or
Hyperion Financial Management using a shared token, rather
than using a set of shared credentials in the connection pool.

Make sure to select either the SSO using CSS Token or Shared
logon options when creating a connection pool for Essbase or

Hyperion Financial Management. Do not leave both options
blank.

If you select this option, you should also select Virtual Private
Database in the corresponding database object to protect cache
entries. See Table 7-1 for more information.

Data Source Information:

Data Source

Specify the vendor-specific information used to connect to the
multidimensional data source. Consult your multidimensional
data source administrator for setup instructions because
specifications can change. For example, if you use v1.0 of the
XML for Analysis SDK, then the value should be
Provider-MSOLAP;Data Source-local.If you use v1.1, then it
should be Local Analysis Server.

Data Source Information:

Catalog

Specify the list of catalogs available, if you imported data from
your data source. The cube tables correspond to the catalog you
use in the connection pool.

System IP or Hostname

This property is only displayed for SAP/BW data sources.
Provide the host name or IP address of the SAP data server.
This field corresponds to the parameter ashost in the SAP/BW
connect string.

System Number

This property is only displayed for SAP/BW data sources.
Provide the SAP system number. This is a two-digit number
assigned to an SAP instance, also called Web Application
Server, or WAS. This field corresponds to the parameter sysnr
in the SAP/BW connect string.

Client Number

This property is only displayed for SAP/BW data sources.
Provide the SAP client number. This is a three-digit number
assigned to the self-contained unit called Client in SAP. A Client
can be a training, development, testing, or production client, or
it can represent different divisions in a large company. This
field corresponds to the parameter client in the SAP/BW
connect string.

Language

This property is only displayed for SAP/BW data sources.
Provide the SAP language code used when logging in to the
data source (for example, EN for English or DE for German).
This field corresponds to the parameter lang in the SAP/BW
connect string.

Additional Parameters

This property is only displayed for SAP/BW data sources.
Optionally, provide additional connection string parameters in
the format param=value. Delimit multiple parameters with a
colon.

Use session

An option that controls whether queries go through a common
session. Consult your multidimensional data source
administrator to determine whether this option should be
enabled. Default is Off (not selected).
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Setting Connection Pool Properties in the Connection Scripts Tab

This section describes the properties in the Connection Scripts tab of the Connection
Pool dialog. The Connection Scripts tab is available for ODBC, OCI, Oracle OLAP,
ADEF, and DB2 data sources.

You can create connection scripts and set them to be run before the connection is
established, before a query is run, after a query is run, or after the connection is
disconnected. For example, you can create a connection script that, on connect, inserts
the name of the user and the connection time into a table.

Connection scripts can contain any commands accepted by the database, such as a
command to turn on quoted identifiers. In a mainframe environment, a script could be
used to set the secondary authorization ID when connecting to DB2 to force a security
exit to a mainframe security package such as RACF. This enables mainframe
environments to maintain security in one central location.

Because the connection script is sent directly to the data source, the script should use
native SQL or another language understood by the data source, not Oracle BI Server
Logical SQL.

To create connection scripts for data sources:

s In the Connection Pool dialog, click the Connection Scripts tab, and then complete
the fields using the information in Table 7-6.

To enter a new connection script, click New next to the appropriate script type.
Then, enter or paste the SQL statements for the script and click OK.

You can edit existing scripts by clicking the ellipsis button to launch the Physical
SQL window. Use the Up Arrow and Down Arrow buttons to reorder existing
scripts.

Click Delete to remove a script.

Figure 7-3 shows the Connection Scripts tab of the Connection Pool dialog.
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Figure 7-3 Connection Scripts Tab of the Connection Pool Dialog
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Table 7-6 describes the properties in the Connection Script